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About this manual

Outline

This manual describes the System 300S SPEED7 CPU 315-4NE12 from
VIPA. Here you may find every information for commissioning and
operation.

Chapter 1: Principles

This Basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA.

General information about the System 300S like dimensions and
environment conditions will also be found.

Chapter 2: Assembly and installation guidelines

In this chapter you will find all information, required for the installation and
the cabling of a process control with the components of the System 300S
with a CPU 315-4NE12.

Chapter 3: Hardware description

Here the hardware components of the CPU 315-4NE12 are described.
The technical data are at the end of the chapter.

Chapter 4: Deployment CPU 315-4NE12

This chapter describes the employment of a CPU 315-4NE12 with SPEED7
technology in the System 300S. The description refers directly to the CPU
and to the employment in connection with peripheral modules that are
mounted on a profile rail together with the CPU at the standard bus.

Chapter 5: Deployment PtP communication

Content of this chapter is the employment of the RS485 slot for serial PtP
communication. Here you'll find all information about the protocols, the
activation and project engineering of the interface which are necessary for
the serial communication using the RS485 interface.

Chapter 6: Deployment PROFIBUS communication

Content of this chapter is the deployment of the CPU 315-4NE12 with
PROFIBUS. After a short overview the project engineering and
parameterization of a CPU 315-4NE12 with integrated PROFIBUS-Part
from VIPA is shown. Further you get information about usage as DP
master and DP slave of the PROFIBUS part. The chapter is ending with
notes to Commissioning and Start-up behavior.

Chapter 7: Deployment Ethernet communication

In this chapter the communication via Ethernet is described. Please regard
the chapter "Fast introduction" where you find all information compressed
required for the project engineering of the CPU 315-4NE12 with CP 343.
After the fast introduction, the mentioned steps are described in detail.
Chapter 8: WinPLC7

In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC7.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 1
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Objective and

This manual describes the System 300S SPEED7 CPU 315-4NE12 from

contents VIPA. It contains a description of the construction, project implementation
and usage.
This manual is part of the documentation package with order number
HB140E_CPU and relevant for:

Product Order number as of state:

CPU-HW CPU-FW DPM-FW CP-FW

CPU 315SN/NET

VIPA 315-4NE12 | 01 V343 V312 V217

Target audience

Structure of the
manual

The manual is targeted at users who have a background in automation
technology.

The manual consists of chapters. Every chapter provides a self-contained
description of a specific topic.

Guide to the The following guides are available in the manual:
document  an overall table of contents at the beginning of the manual
» an overview of the topics for every chapter
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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Safety information

Applications The SPEED7 CPU is constructed and produced for:

conforming with .
specifications .

all VIPA System 300S components
communication and process control
general control and automation applications
industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Hardware modifications to the process control system should only be
carried out when the system has been disconnected from power!

Installation and hardware modifications only by properly trained
personnel.

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 3
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Chapter 1

Overview

Content

Basics

These basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA.

General information about the System 300S like dimensions and
environment conditions will also be found.

Topic Page
(O F= 1o} (T N = ¥ 1 Y of = U 1-1
Safety Information for USers...........cooooviiiiiiiiiiice e, 1-2
Operating structure of @ CPU ... 1-3
CPU B15-ANET2. ... 1-6
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Safety Information for Users

Handling of
electrostatic
sensitive modules

Shipping of
electrostatic
sensitive modules

Measurements and
alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.
It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges can fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive modules
you should take the following precautions:

» Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2

HB140E - CPU - RE_315-4NE12 - Rev. 12/06



Manual VIPA System 300S SPEED7 Chapter 1 Basics

Operating structure of a CPU

General

Cyclic processing

Timer processing

Alarm controlled
processing

Priority based
processing

The CPU contains a standard processor with internal program memory. In
combination with the integrated SPEED7 technology the unit provides a
powerful solution for process automation applications within the System
300S family.

A CPU supports the following modes of operation:

» cyclic operation

» timer processing

» alarm controlled operation
 priority based processing

Cyclic processing represents the major portion of all the processes that are
executed in the CPU. Identical sequences of operations are repeated in a
never-ending cycle.

Where a process requires control signals at constant intervals you can
initiate certain operations based upon a timer, e.g. not critical monitoring
functions at one-second intervals.

If a process signal requires a quick response you would allocate this signal
to an alarm controlled procedure. An alarm can activate a procedure in
your program.

The above processes are handled by the CPU in accordance with their
priority. Since a timer or an alarm event requires a quick reaction, the CPU
will interrupt the cyclic processing when these high-priority events occur to
react to the event. Cyclic processing will resume, once the reaction has
been processed. This means that cyclic processing has the lowest priority.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 1-3
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Applications

System routine

User application

Operands

Process image
and periphery

The program that is present in every CPU is divided as follows:
» System routine
» User application

The system routine organizes all those functions and procedures of the
CPU that are not related to a specific control application.

This consists of all the functions that are required for the processing of a
specific control application. The operating modules provide the interfaces to
the system routines.

The following series of operands is available for programming the CPU:
* Process image and periphery

» Bit memory

» Timers and counters

» Data blocks

The user application can quickly access the process image of the inputs
and outputs PAA/PAE. You may manipulate the following types of data:

 individual Bits
* Bytes

« Words

* Double words

You may also gain direct access to peripheral modules via the bus from
user application. The following types of data are available:

* Bytes
« Words
* Blocks

1-4
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Bit Memory The bit memory is an area of memory that is accessible by means of
certain operations. Bit memory is intended to store frequently used working
data.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

Timers and In your program you may load cells of the timer with a value between 10ms

counters and 9990s. As soon as the user application executes a start-operation, the
value of this timer is decremented by the interval that you have specified
until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment
or decrement these when required.

Data Blocks A data block contains constants or variables in the form of bytes, words or
double words. You may always access the current data block by means of
operands.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 1-5
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CPU 315-4NE12

Overview

Access

The CPU 315-4NE12 bases upon the SPEED7 technology. This supports
the CPU at programming and communication by means of co-processors
that causes a power improvement for highest needs.

The SPEED7 CPUs from VIPA are instruction compatible to the
programming language STEP®7 from Siemens and may be programmed
via WIinPLC7 from VIPA or via the Siemens SIMATIC Manager. Here the
instruction set of the S7-400 from Siemens is used.

Modules and CPUs of the System 300S from VIPA and Siemens may be
used at the bus as a mixed configuration.

The user application is stored in the battery buffered RAM or on an
additionally pluggable MMC storage module.

The CPU is configured as CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0) from

Ij MPI Adapter » mP
PC | RS232

bt

[

Siemens.
DP Adapter W
CPU

DP master CP 343

Proj. Firmw.

Web [NCS

(@)
0
=8
—
P
z

WinPLC7 from VIPA
SIMATIC Manager

from Siemens

|
Proj. Proj. Firmw.

| =
— Proj. Firmw.
| Proj./Firmw. | RAM | Flash
_’ o | Overall reset Tip
@T @ lSSee, @ l
MR
PG/OP

—‘ RJ45

| MMC

(

Ethernet

Note!

Please do always use the CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0) from
Siemens of the hardware catalog to project this CPU from VIPA.

For the project engineering, a thorough knowledge of the Siemens
SIMATIC Manager and the hardware configurator from Siemens is
required!

1-6
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Memory
management

Integrated
PROFIBUS
DP master

Integrated
CP 343

Integrated
Ethernet PG/OP
channel

Operation Security

Environmental
conditions

Dimensions/
Weight

Integrated
power supply

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:
* Load memory 2Mbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has1Mbyte. There is the possibility to extend the work
memory to its maximum printed capacity 2Mbyte by means of a MCC
memory extension card.

The CPU has an integrated PROFIBUS DP master, which also may be
used as PROFIBUS DP salve.

The project engineering takes place or in the hardware configurator from
Siemens in WinPLC7 from VIPA.

The integrated CP 343 offers you a communication processor. This serves
32 PG/OP channels and 8 configurable productive connections.

The CPU has an Ethernet interface for PG/OP communication. Via the
"PLC" functions you may directly access the Ethernet PG/OP channel and
program res. remote control your CPU. A max. of 4 PG/OP connections is
available.

You may also access the CPU with a visualization software via these
connections.

» Wiring by means of spring pressure connections (CageClamps) at the
front connector

« Core cross-section 0.08...2.5mm?

» Total isolation of the wiring at module change

» Potential separation of all modules to the backplane bus

» ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)

» Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

» Operating temperature: 0 ... +60°C

» Storage temperature: -25 ... +70°C

* Relative humidity: 5 ... 95% without condensation
» Ventilation by means of a fan is not required

» Dimensions of the basic enclosure:
2tier width: (WxHxD) in mm: 80x125x120

The CPU comes with an integrated power supply. The power supply is to
be supplied with DC 24V. By means of the supply voltage, the internal
electronic is supplied as well as the connected modules via backplane bus.
The power supply is protected against inverse polarity and overcurrent.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 1-7
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Chapter 2 Assembly and installation guidelines

Overview In this chapter you will find every information, required for the installation
and the cabling of a process control with the components of the System
300S with a CPU 315-4NE12.

Content Topic Page
Chapter 2 Assembly and installation guidelines..........cccccccceeee.. 2-1

Installation diMeNSIONS ... ..cooi i 2-2

Assembly standard bus ..o 2-3

CabliNG . 2-5

Installation guUIdelingS .........ccooiiiiiiiice e 2-6
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Installation dimensions

Dimensions 2tier width (WxHxD) in mm: 80 x 125 x 120
Basic enclosure

Dimensions [
€
S
Q@
£
£
S
€
S
S

Installation “ 125mm

dimensions e 120mm

Q

175mm

T 125mm
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Assembly standard bus

General

Profile rail

Bus connector

The single modules are directly installed on a profile rail and connected via
the backplane bus connector. Before installing the modules you have to
clip the backplane bus connector to the module from the backside.

The backplane bus connector is delivered together with the peripheral
modules.

Order number A B C
VIPA 390-1AB60 160 140 10
VIPA 390-1AE80 482 466 8.3
VIPA 390-1AF30 530 500 15
VIPA 390-1AJ30 830 800 15
VIPA 390-9BC00* 2000 Drillings only left 15

* Unit pack: 10 pieces
Measures in mm

A
< >
325 [/ E
° 14
57.2| | g™° 10| B 122
O %27
/// |
/ | ,i
5 »15
—» C < >

For the communication between the modules the System 300S uses a
backplane bus connector. Backplane bus connectors are included in the
delivering of the peripheral modules and are clipped at the module from the
backside before installing it to the profile rail.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 2-3
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Assembly
possibilities
waagrechter Aufbau

o [ o

© O

o o

liegender Aufbau

=

senkrechter
Aufbau

Danger!

Please regard the allowed environment temperatures:

* horizontal assembly: from 0 to 60°C
* vertical assembly: from 0 to 40°C
» lying assembly: from 0 to 40°C
Approach

Bolt the profile rail with the background (screw size: M6),
so that you still have minimum 65mm space above and
40mm below the profile rail.

If the background is a grounded metal or device plate,
please look for a low-impedance connection between
profile rail and background.

Connect the profile rail with the protected earth conductor.
For this purpose there is a bolt with M6-thread.

The minimum cross-section of the cable to the protected
earth conductor has to be 10mm?.

Stick the power supply to the profile rail and pull it to the
left side to the grounding bolt of the profile rail.

Fix the power supply by screwing.

Take a backplane bus connector and click it at the CPU
from the backside like shown in the picture.

Stick the CPU to the profile rail right from the power supply
and pull it to the power supply.

Click the CPU downwards and bolt it like shown.

Repeat this procedure with the peripheral modules, by
clicking a backplane bus connector, stick the module right
from the modules you've already fixed, click it downwards
and connect it with the backplane bus connector of the last
module and bolt it.

The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

Installation and modifications only by properly trained personnel!

2-4
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Cabling

CageClamp
technology (green)

<

Danger!

» The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

» Installation and modifications only by properly trained personnel!

For the cabling of power supply of a CPU, a green plug with CageClamp
technology is deployed.

The connection clamp is realized as plug that may be clipped off carefully if
it is still cabled.

Here wires with a cross-section of 0.08mm? to 2.5mm? may be connected.
You can use flexible wires without end case as well as stiff wires.

..E 6 [1]  Test point for 2mm test tip
‘ u_ 57 1 [2] Locking (orange) for screwdriver
L > [3] Round opening for wires
3

The picture on the left side shows the cabling step by step from top view.

¢ For cabling you push the locking vertical to the inside with a suiting
screwdriver and hold the screwdriver in this position.

* Insert the de-isolated wire into the round opening. You may use wires
with a cross-section from 0.08mm? to 2.5mm?>.

« By removing the screwdriver the wire is connected safely with the plug
connector via a spring.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 2-5
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Installation guidelines

General

What means
EMC?

Possible
interference
causes

The installation guidelines contain information about the interference free
deployment of System 300S systems. There is the description of the ways,
interference may occur in your control, how you can make sure the
electromagnetic digestibility (EMC), and how you manage the isolation.

Electromagnetic digestibility (EMC) means the ability of an electrical
device, to function error free in an electromagnetic environment without
being interferenced res. without interferencing the environment.

All System 300S components are developed for the deployment in hard
industrial environments and fulfill high demands on the EMC. Nevertheless
you should project an EMC planning before installing the components and
take conceivable interference causes into account.

Electromagnetic interferences may interfere your control via different ways:
* Fields

* |/O signal conductors

* Bus system

» Current supply

* Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the
distance to the interference cause, interferences to your control occur by
means of different coupling mechanisms.

One differs:

» galvanic coupling

» capacitive coupling
* inductive coupling
 radiant coupling

2-6
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Basic rules for In the most times it is enough to take care of some elementary rules to
EMC guarantee the EMC. Please regard the following basic rules when installing
your PLC.

Take care of a correct area-wide grounding of the inactive metal parts
when installing your components.

- Install a central connection between the ground and the protected
earth conductor system.

- Connect all inactive metal extensive and impedance-low.

- Please try not to use aluminum parts. Aluminum is easily oxidizing
and is therefore less suitable for grounding.

When cabling, take care of the correct line routing.

- Organize your cabling in line groups (high voltage, current supply,
signal and data lines).

- Always lay your high voltage lines and signal res. data lines in
separate channels or bundles.

- Route the signal and data lines as near as possible beside ground
areas (e.g. suspension bars, metal rails, tin cabinet).

Proof the correct fixing of the lead isolation.
Data lines must be laid isolated.

Analog lines must be laid isolated. When transmitting signals with
small amplitudes the one sided laying of the isolation may be
favorable.

Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with
cable clamps.

- Make sure that the isolation/protected earth conductor rail is
connected impedance-low with the cabinet.

- Use metallic or metalized plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.

- Wire all inductivities with erase links.

- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical
operating supplies when possible.

- Please take care for the targeted employment of the grounding
actions. The grounding of the PLC is a protection and functionality
activity.

- Connect installation parts and cabinets with the System 300S in star
topology with the isolation/protected earth conductor system. So you
avoid ground loops.

- If potential differences between installation parts and cabinets occur,
lay sufficiently dimensioned potential compensation lines.
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Isolation of
conductors

Electrical, magnetically and electromagnetic interference fields are
weakened by means of an isolation, one talks of absorption.

Via the isolation rail, that is connected conductive with the rack,
interference currents are shunt via cable isolation to the ground. Hereby
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may
appear as interference cause.

When isolating cables you have to regard the following:
» If possible, use only cables with isolation tangle.
» The hiding power of the isolation should be higher than 80%.

* Normally you should always lay the isolation of cables on both sides.
Only by means of the both-sided connection of the isolation you achieve
high quality interference suppression in the higher frequency area.

Only as exception you may also lay the isolation one-sided. Then you
only achieve the absorption of the lower frequencies. A one-sided
isolation connection may be convenient, if:

- the conduction of a potential compensating line is not possible
- analog signals (some mV res. pyA) are transferred
- foil isolations (static isolations) are used.

* With data lines always use metallic or metalized plugs for serial
couplings. Fix the isolation of the data line at the plug rack. Do not lay
the isolation on the PIN 1 of the plug bar!

* At stationary operation it is convenient to strip the insulated cable
interruption free and lay it on the isolation/protected earth conductor line.

» To fix the isolation tangles use cable clamps out of metal. The clamps
must clasp the isolation extensively and have well contact.

» Lay the isolation on an isolation rail directly after the entry of the cable in
the cabinet. Lead the isolation further on to the System 300S module
and don't lay it on there again!

Please regard at installation!

At potential differences between the grounding points, there may be a
compensation current via the isolation connected at both sides.

Remedy: Potential compensation line

2-8
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Chapter 3 Hardware description

Overview Here the hardware components of the CPU 315-4NE12 are described.
The technical data are at the end of the chapter.
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Properties

CPU 315SN/NET » SPEED?Y technology integrated

» 1Mbyte work memory integrated (512kbyte code, 512kbyte data)
* Memory expandable to max. 2Mbyte (1Mbyte code, 1Mbyte data)
* Load memory 2Mbyte

» PROFIBUS DP master integrated (DP-V0O, DP-V1)

* MPI interface

» MCC slot for external memory cards and memory extension

» Status LEDs for operating state and diagnosis

» Real-time clock battery buffered

» Ethernet PG/OP interface integrated

» RS485 interface configurable for PROFIBUS DP master respectively
PtP communication

» CP 343 integrated
8 configurable productive connections by Siemens NetPro and
8 configurable productive connections by user program and
32 PG/OP connections

* |/O address range digital/analog 8191byte
* 512 timer

* 512 counter

» 8192 flag byte

315-4NE12

VIPA  cPusissh  pic  peM

PWR RUN
[RUN ERR
STOP DE
SF IF
FRCI

MMC

MCC
A

S

RUN
(B
MRES

VIPA 315-4NE12 —j|f—
;
4
7
Ordering data
Type Order number | Description
315SN/NET | VIPA 315-4NE12 | MPI interface, card slot, real time clock, Ethernet interface for

PG/OP, PROFIBUS DP master, CP 343

3-2
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Structure

CPU 315SN/NET
315-4NE12

VIPA CPU3ISSN  PLC PB-M
CIPwR RUN
| |RUN ERR | 1
| |sToP DE
| _IsF IF
|_|FRCE _—t 2
|_|mcc MCC
A
— 3
s

RUN
|-
MRES

VIPA 315-4NE12 _><|2_
3[4

v
X8
X5
o %o 6
X1 E 7
O [+ o
O [} - 20 ___X30
DC 24V TP MPl__PB-DP
9
Interfaces X1
© [I]|+® +pC24v
O Tl @ oV
@ n.c.
@ M24V
@ RxD/TXD-P (line B)
@ RTS
& M5V
® P5V
@ P24V
® RxD/TXD-N (line A)
® n.c.

X3

PtP/PB-DP
shield

M24V
RXD/TxD-P (line B)
RTS

M5V

P5V

P24V

RXD/TxD-N (line A)
n.c

E@EAP@EO®E

AveEoaN®

[1]

[2]
[3]
[4]

LEDs of the integrated
PROFIBUS DP master

Storage media slot
LEDs of the CPU part
Operating mode switch CPU

The following components
are under the front flap

[5]
[6]
[7]
[8]

[9]

X5

12345678

Twisted pair interface

for Ethernet PG/OP channel
MPI interface

PROFIBUS DP/PtP interface
Twisted pair interface

for CP 343

Slot for DC 24V power supply

Transmit +
Transmit -
Receive +
n.c.

n.c.
Receive -
n.c.

n.c.

@EEOEEEE

Transmit +
Transmit -
Receive +
n.c.

n.c.
Receive -
n.c.

n.c.

PEEEEEEO
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Power supply
X1

MPI interface
X2

Ethernet PG/OP
channel
X5

PROFIBUS/PtP
interface with
configurable
functionality
X3

PROFIBUS
functionality

PtP functionality

The CPU has an integrated power supply. The power supply has to be
provided with DC 24V. For this serves the double DC 24V slot, that is
underneath the flap.

Via the power supply not only the internal electronic is provided with
voltage, but by means of the backplane bus also the connected modules.
The power supply is protected against polarity inversion and overcurrent.
The internal electronic is galvanically connected with the supply voltage.

9-pin SubD jack:

The MPI interface serves for the connection between programming unit and
CPU. By means of this the project engineering and programming happens.
In addition MPI serves for communication between several CPUs or
between HMIs and CPU.

Standard setting is MPI Address 2.

8pin RJ45 jack:

The RJ45 jack serves the interface to the Ethernet PG/OP channel. This
interface allows you to program res. remote control your CPU, to access
the internal website or to connect a visualization. Configurable connections
are not possible.

For online access to the CPU via Ethernet PG/OP channel valid IP address
parameters have to be assigned to this. More may be found at chapter
"Deployment CPU ..." at "Initialization Ethernet PG/OP channel".

The CPU has a PROFIBUS/PtP interface with a fix pinout. After an overall
reset the interface is deactivated.

By appropriate configuration, the following functionalities for this interface
may be enabled:

* PROFIBUS DP master operation

 PROFIBUS DP slave operation

» PtP functionality

The PROFIBUS master/slave functionality of this interface is activated by
configuring the sub module X1 (MPI/DP) of the CPU in the hardware
configuration.

Using the PtP functionality the RS485 interface is allowed to connect via
serial point-to-point connection to different source res. target systems. Here
the following protocols are supported: ASCII, STX/ETX, 3964R, USS and
Modbus-Master (ASCII, RTU) .

The activation of the PtP functionality happens by embedding the
SPEEDBUS.GSD from VIPA in the hardware catalog. After the installation
the CPU may be configured in a PROFIBUS master system and here the
interface may be switched to PtP communication.

3-4
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Communication
processor CP 343
X8

Memory
management

Operating mode
switch

RUN
(B)swr
MRES

Storage
media slot

8pin RJ45 jack:

The CP 343 offers you a communication processor.

This serves the following possibilities for connections:

» 32 PG/OP channels (each 1 connection is reserved for PG and OP)

» 8 productive connections configurable with Siemens NetPro respectively
by user program

The project engineering happens as CP 343-1EX11.

Via the RJ45 jack you may connect the CP 343 to Twisted-Pair-Ethernet.

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:

* Load memory 2Mbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has1Mbyte. There is the possibility to extend the work

memory to its maximum printed capacity 2Mbyte by means of a MCC
memory extension card.

With the operating mode switch you may switch the CPU between STOP
and RUN.

During the transition from STOP to RUN the operating mode START-UP is
driven by the CPU.

Placing the switch to MRES (Memory Reset), you request an overall reset
with following load from MMC, if a project there exists.

As external storage medium for applications and firmware you may use a
MMC storage module (Multimedia card) or a MCC memory extension card.
The MCC can additionally be used as an external storage medium.

Both VIPA storage media are pre-formatted with the PC format FAT16 and
can be accessed via a card reader. An access to the storage media always
happens after an overall reset and PowerON.

After PowerON respectively an overall reset the CPU checks, if there is a
storage medium with data valid for the CPU.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 3-5



Chapter 3 Hardware description

Manual VIPA System 300S SPEED7

LEDs The CPU has got LEDs on its front side. In the following the usage and the
according colors of the LEDs is described.
LEDs CPU As soon as the CPU is supplied with 5V, the green PWR-LED is on.
RUN | STOP SF FRCE | MCC |Meaning
green | yellow red yellow | yellow
Boot-up after PowerON
o | It*| e ° ® |* Blinking with 10Hz: Firmware is loaded.
() () () () () Initialization: Phase 1
[ [ ) ) () ®) Initialization: Phase 2
[ [ ) ) @) ®) Initialization: Phase 3
@) () () @) @) Initialization: Phase 4
Operation
O [ ) X X X CPU is in STOP state.
ij} o CPU is in start-up state, the RUN LED blinks during operating
X X X 0OB100 at least for 3s.
® @) @) X X CPU is in state RUN without error.
There is a system fault. More information may be found in the
X X e X X diagnostics buffer of the CPU.
X X X [ ) X | Variables are forced.
X X X X o Access to the memory card.
Overall reset
O {:E X X X Overall reset is requested.
@) {t%* X X X * Blinking with 5Hz: Overall reset is executed.
Factory reset
[ )  J @) @) @) Factory reset is executed.
O [ o ) ) Factory reset finished without error.

Firmware update

The alternate blinking indicates that there is new firmware on

© o ij} ij} o the memory card.
The alternate blinking indicates that a firmware update is
© © ij} ij} o executed.
®) ) ) ) Firmware update finished without error.
o % | Y | Y | X% |* Blinking with 10Hz: Error during Firmware update.
on: ® off: O blinking (2Hz): ij} not relevant: X

LEDs Ethernet
PG/OP channel

A 'S

The green A-LED (Activity) indicates the physical connection of the
Ethernet PG/OP channel to Ethernet. Irregular flashing of the A-LED
indicates communication of the Ethernet PG/OP channel via Ethernet.

If the green S-LED (Speed) is on, the Ethernet PG/OP has a
communication speed of 100MBit/s otherwise with 10MBit/s.

3-6
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LEDs

PROFIBUS/PtP

interface X3

Master operation

Dependent on the mode of operation the LEDs show information about the
state of operation of the PROFIBUS part according to the following pattern:

RUN |ERR | DE IF | Meaning
green | red | green | red
o o o o Master has no project, this means the interface is deactivated respectively
PtP is active.
® e) @) O | Master has bus parameters and is in RUN without slaves.
° o o Master is in "clear" state (safety state). The inputs of the slaves may be read.
%j} The outputs are disabled.
° o ° o Master is in "operate" state, this means data exchange between master and
slaves. The outputs may be accessed.
() () Y O |CPUis in RUN, at least 1 slave is missing.
° ° {:g O |CPUisin STOP, at least 1 slave is missing.
e) e) @) ® |Initialization error at faulty parameterization.
e) ) @) ® | Waiting state for start command from CPU.
Slave operation
RUN |ERR | DE IF | Meaning
green | red | green | red
e) e) @) O | Slave has no project respectively PtP is active.
{i} @) O O | Slave is without master.
{i}* o} gj}* O | * Alternate flashing at configuration faults.
° @) ® O | Slave exchanges data between master.
on: ® off: O blinking (2HZz): i:l} not relevant: X
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Technical Data

Order number 315-4NE12

Type CPU 315SN/NET

SPEED-Bus -

Technical data power supply

Power supply (rated value) DC 24V

Power supply (permitted range) DC 20.4...28.8V

Reverse polarity protection v

Current consumption (no-load operation) 270 mA

Current consumption (rated value) 1A

Inrush current 5A

Max. current drain at backplane bus 25A

Load and working memory

Load memory, integrated 2 MB

Load memory, maximum 2 MB

Work memory, integrated 1MB

Work memory, maximal 2 MB

Memory divided in 50% program / 50% data v

Memory card slot MMC-Card with max. 1 GB

Hardware configuration

Racks, max. 4

Modules per rack, max. 8 in multiple-, 32 in a single-
rack configuration

Number of integrated DP master 1

Number of DP master via CP 4

Operable function modules 8

Operable communication modules PtP 8

Operable communication modules LAN 8

Status information, alarms, diagnhostics

Status display yes

Interrupts no

Process alarm no

Diagnostic interrupt no

Command processing times

Bit instructions, min. 0.01 us

Word instruction, min. 0.01 us

Double integer arithmetic, min. 0.01 us

Floating-point arithmetic, min. 0.06 ps

Timers/Counters and their retentive

characteristics

Number of S7 counters 512

Number of S7 times 512

Data range and retentive characteristic

Number of flags 8192 Byte

Number of data blocks 4095

Max. data blocks size 64 KB

Max. local data size per execution level 510 Byte

Blocks

Number of OBs 24

Number of FBs 2048

Number of FCs 2048

Maximum nesting depth per priority class 8

Maximum nesting depth additional within an error |4

OB
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Order number 315-4NE12
Time

Real-time clock buffered v

Clock buffered period (min.) 6 W
Accuracy (max. deviation per day) 10s
Number of operating hours counter 8

Clock synchronization v
Synchronization via MPI Master/Slave
Synchronization via Ethernet (NTP) Slave
Address areas (I/0O)

Input I/0 address area 8192 Byte
Output I/0 address area 8192 Byte
Input process image maximal 2048 Byte
Output process image maximal 2048 Byte
Digital inputs 65536
Digital outputs 65536
Digital inputs central 1024
Digital outputs central 1024

Integrated digital inputs -
Integrated digital outputs -
Analog inputs 4096

Analog outputs 4096
Analog inputs, central 256
Analog outputs, central 256

Integrated analog inputs -
Integrated analog outputs -
Communication functions

PG/OP channel

Global data communication

Number of GD circuits, max.

Size of GD packets, max.

S7 basic communication

S7 basic communication, user data per job
S7 communication

S7 communication as server

S7 communication as client -

NENERRNERR
°Y) °Y)
<=
[¢) [¢)

S7 communication, user data per job 160 Byte
Number of connections, max. 32
Functionality Sub-D interfaces

Type X2

Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated v

MPI v

MP2l (MPI/RS232) -

DP master -

DP slave -

Point-to-point interface -

Type X3
Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated v

MPI -
MP2l (MPI/RS232)

DP master

DP slave
Point-to-point interface

ANBRNENE
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Order number 315-4NE12
CAN -
Functionality PROFIBUS master

PG/OP channel 4
Routing v

S7 basic communication v

S7 communication v

S7 communication as server v

S7 communication as client -
Equidistance support -
Isochronous mode -
SYNC/FREEZE v
Activation/deactivation of DP slaves v

Direct data exchange (slave-to-slave -
communication)

DPV1 -
Transmission speed, min. 9.6 kbit/s
Transmission speed, max. 12 Mbit/s
Number of DP slaves, max. 124
Address range inputs, max. 8 KB
Address range outputs, max. 8 KB
User data inputs per slave, max. 244 Byte
User data outputs per slave, max. 244 Byte
Functionality PROFIBUS slave

PG/OP channel v
Routing v

S7 communication v

S7 communication as server v

S7 communication as client -

Direct data exchange (slave-to-slave -
communication)

DPV1 -
Transmission speed, min. 9.6 kbit/s
Transmission speed, max. 12 Mbit/s
Automatic detection of transmission speed -
Transfer memory inputs, max. 244 Byte
Transfer memory outputs, max. 244 Byte
Address areas, max. 32

User data per address area, max. 32 Byte
Point-to-point communication

PtP communication v
Interface isolated v
RS232 interface -

RS422 interface -

RS485 interface v

Connector

Sub-D, 9-pin, female

Transmission speed, min.

150 bit/s

Transmission speed, max. 115.5 kbit/s
Cable length, max. 500 m
Point-to-point protocol
ASCII protocol v
STX/ETX protocol v
3964(R) protocol v
RK512 protocol -
USS master protocol v

v

Modbus master protocol

Modbus slave protocol

Special protocols
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Order number 315-4NE12
Functionality RJ45 interfaces

Type X5

Type of interface Ethernet 10/100 MBit
Connector RJ45
Electrically isolated v

PG/OP channel 4
Productive connections -

Type X8

Type of interface Ethernet 10/100 MBit
Connector RJ45
Electrically isolated v

PG/OP channel v
Productive connections -

Ethernet communication CP

Number of productive connections, max. 8

Number of productive connections by Siemens 8

NetPro, max.

User data per S7 connection, max. 32 KB
User data per TCP connection, max. 64 KB
User data per ISO connection, max. 8 KB

User data per ISO on TCP connection, max. 32 KB
User data per UDP connection, max. 2 KB
Ethernet open communication

Number of connections, max. 8

User data per ISO on TCP connection, max. 8 KB

User data per native TCP connection, max. 8 KB

User data per ad hoc TCP connection, max. 1460 Byte
User data per UDP connection, max. 1472 Byte

Mechanical data

Dimensions (WxHxD)

80 x 125 x 120 mm

Weight

430 g

Environmental conditions

Operating temperature

0°Cto60°C

Storage temperature

-25°Cto 70 °C

Certifications

UL508 certification

yes

HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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Chapter 4

Overview

Content

Deployment CPU 315-4NE12

This chapter describes the deployment of a CPU 315-4NE12 with SPEED7
technology in the System 300. The description refers directly to the CPU
and to the deployment in connection with peripheral modules, mounted on
a profile rail together with the CPU at the standard bus.
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Assembly

Note!

Information about assembly and cabling may be found at chapter
"Assembly and installation guidelines”.

Start-up behavior

Turn on power
supply

Default boot
procedure, as
delivered

Boot procedure with
valid data in the
CPU

Boot procedure
with empty battery

After the power supply has been switched on, the CPU changes to the
operating mode the operating mode lever shows.

When the CPU is delivered it has been reset.
After a STOP - RUN transition the CPU switches to RUN without program.

The CPU switches to RUN with the program stored in the battery buffered
RAM.

The accumulator/battery is automatically loaded via the integrated power
supply and guarantees a buffer for max. 30 days. If this time is exceeded,
the battery may be totally discharged. This means that the battery buffered
RAM is deleted.

In this state, the CPU executes an overall reset. If a MMC is plugged,
program code and data blocks are transferred from the MMC into the work
memory of the CPU.

If no MMC is plugged, the CPU transfers permanent stored "protected"
blocks into the work memory if available.

Information about storing protected blocks in the CPU is to find in this
chapter at "Extended Know-how protection".

Depending on the position of the operating mode switch, the CPU switches
to RUN res. remains in STOP.

This event is stored in the diagnostic buffer as: "Start overall reset
automatically (unbuffered PowerON)".

4-2
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Addressing

Overview

Addressing
Backplane bus
I/O devices

Max. number of
pluggable
modules

Define addresses
by hardware
configuration

To provide specific addressing of the installed peripheral modules, certain
addresses must be allocated in the CPU.

At the start-up of the CPU, this assigns automatically peripheral addresses
for digital in-/output modules starting with 0 and ascending depending on the
slot location.

If no hardware project engineering is available, the CPU stores at the
addressing analog modules to even addresses starting with 256.

The CPU 315-4NE12 provides an I/O area (address O ... 8191) and a
process image of the in- and outputs (each address 0 ... 255).

The process image stores the signal states of the lower address (0 ... 255)
additionally in a separate memory area.

The process image this divided into two parts:
» process image to the inputs (PIl)
» process image to the outputs (PIQ)

I/O area Process image
0 0
— : Inputs
: Pl
. 255
255 0
: Outputs
, . PIQ
8191 255

The process image is updated automatically when a cycle has been
completed.

Maximally 8 modules per row may be configured by the CPU 315-4NE12.

For the project engineering of more than 8 modules you may use line
interface connections. For this you set in the hardware configurator the
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail.
Now you may extend your system with up to 3 profile rails by starting each
with an IM 361 from Siemens at slot 3. Considering the max total current
with the CPU 315-4NE12 from VIPA up to 32 modules may be arranged in
a row. Here the installation of the line connections IM 360/361 from
Siemens is not required.

You may access the modules with read res. write accesses to the
peripheral bytes or the process image.

To define addresses a hardware configuration may be used. For this, click
on the properties of the according module and set the wanted address.
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Automatic If you do not like to use a hardware configuration, an automatic addressing
addressing comes into force.
At the automatic address allocation DIOs occupy depending on the slot
location always 4byte and AlOs, FMs, CPs always 16byte at the bus.
Depending on the slot location the start address from where on the
according module is stored in the address range is calculated with the
following formulas:
DIOs: Start address = 4[(slot -1)
AlOs, FMs, CPs: Start address = 16I[{slot -1)+256
Slot number 1,2, .. —>
4 5 6 7
Start
address
digital: 0 4 8 12
analog: CPU 256 272 288 304
Example for The following sample shows the functionality of the automatic address
automatic address allocation:
allocation
gotnumber: 4 5 6 7 8
> >
E . § § - Bus
A< - = =
3 ~— © © 1%
2 Sl | 5] =2
S 5 || 8| 3| %2
A A
Pl Address Periphery area Periphery area Address PIQ
0 Input Byte 0
1 Input Byte il T Output Byte 8
< — Output Byte 9 —>
; Input B :
i — ] owueye | 1
up to max. 255 l:3 Input Byte Output Byte 13 up to max. 255
TS 255 : ST
3 %5 2
i o 5]
© 2;2 Output Byte 3éo ©

2048

8191

Input Byte

i
i

Input Byte ’ Output Byte 335

2048

8191
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Hardware configuration - CPU

Requirements

The hardware configuration of the VIPA CPU takes place at the Siemens
hardware configurator.

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules, which may be configured
here are listed in the hardware catalog. If necessary you have to update the
hardware catalog with Options > Update Catalog.

For project engineering a thorough knowledge of the Siemens SIMATIC
manager and the Siemens hardware configurator are required!

Note!

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic
operation (+l, -1, *I, /l, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2.

This may cause conflicts in applications that presume an unmodified
ACCU2.

For more information may be found in the manual "VIPA Operation list
SPEED7" at "Differences between SPEED7 and 300V programming".

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

» Start the Siemens hardware configurator with a new project.

« Insert a profile rail from the hardware catalog.

« Place at slot 2 the following CPU from Siemens:

CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0).

Proceeding
Slot | Module
1
2 CPU 318-2
X2 | DP
X1 | MPI/DP
3

¢ The integrated PROFIBUS DP master (X3) is to be configured and

connected via the sub module X2 (DP). In the operation mode
PROFIBUS the CPU may further more be accessed via the MPI
interface (X2) with address 2 und 187.5kbit/s.
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Hardware configuration - /O modules

Hardware
configuration of
the modules

Parameterization

Parameterization
during runtime

Bus extension
with IM 360 and
IM 361

After the hardware configuration place the System 300 modules in the
plugged sequence starting with slot 4.

H H Slot | Module |
D) ; Parameter DIO
X... CPU Param Param : .
Param : ....... Param : .
Param Param : .
oI ) Do Al A0 Param Param : .
cPu 3
4 DI ,_
6 | DIO”
7 Al
8 AO
9
10
11

For parameterization double-click during the project engineering at the slot
overview on the module you want to parameterize In the appearing dialog
window you may set the wanted parameters.

By using the SFCs 55, 56 and 57 you may alter and transfer parameters for
wanted modules during runtime.

For this you have to store the module specific parameters in so called
"record sets".

More detailed information about the structure of the record sets is to find in
the according module description.

For the project engineering of more than 8 modules you may use line
interface connections. For this you set in the hardware configurator the
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail.

Now you may extend your system with up to 3 profile rails by starting each
with an IM 361 from Siemens at slot 3. Considering the max total current
with the VIPA SPEED7 CPUs up to 32 modules may be arranged in a row.

Here the installation of the line connections IM 360/361 from Siemens is not
required.

4-6
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Hardware configuration - Ethernet PG/OP channel

Overview The CPU 315-4NE12 has an integrated Ethernet PG/OP channel. This
channel allows you to program and remote control your CPU.

The PG/OP channel also gives you access to the internal web page that
contains information about firmware version, connected 1/O devices, current
cycle times etc.

With the first start-up respectively after an overall reset the Ethernet PG/OP
channel does not have any IP address.

For online access to the CPU via Ethernet PG/OP channel valid IP address

parameters have to be assigned to this by means of the Siemens SIMATIC
manager. This is called "initialization".

Assembly and * Install your System 300S with your CPU.

commissioning « Wire the system by connecting cables for voltage supply and signals.

» Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet

» Switch on the power supply.
- After a short boot time the CP is ready for communication.
He possibly has no IP address data and requires an initialization.

"Initialization" via ~ The initialization via PLC functions takes place with the following
PLC functions proceeding:

» Determine the current Ethernet (MAC) address of your Ethernet PG/OP
channel. This always may be found as 1. address under the front flap of
the CPU on a sticker on the left side.

Ethernet-Address PG/OP channel
1. Ethernet-PG/OP
2. CP343
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Assign IP address
parameters

Take IP address
parameters in
project

You get valid IP address parameters from your system administrator. The
assignment of the IP address data happens online in the Siemens SIMATIC
manager starting with version V 5.3 & SP3 with the following proceeding:

Start the Siemens SIMATIC manager and set via Options > Set PG/PC

interface the access path to "TCP/IP -> Network card .... ".

Open with PLC > Edit Ethernet Node the dialog window with the same
name.

To get the stations and their MAC address, use the [Browse] button or
type in the MAC Address. The Mac address may be found at the 1. label
beneath the front flap of the CPU.

Choose if necessary the known MAC address of the list of found
stations.

Either type in the IP configuration like IP address, subnet mask and
gateway. Or your station is automatically provided with IP parameters by
means of a DHCP server. Depending of the chosen option the DHCP
server is to be supplied with MAC address, equipment name or client ID.
The client ID is a numerical order of max. 63 characters. The following
characters are allowed: "hyphen”, 0-9, a-z, A-Z

Confirm with [Assign IP configuration].

Note!

Direct after the assignment the Ethernet PG/OP channel may be reached
online by these address data.

The value remains as long as it is reassigned, it is overwritten by a
hardware configuration or an factory reset is executed.

Open the Siemens hardware configurator und configure the Siemens
CPU 318-2 (318-2AJ00-0AB00 V3.0).

Configure the modules at the standard bus.

For the Ethernet PG/OP channel you have to configure a Siemens
CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7
343-1EX11 0XEOQ) always below the really plugged modules.

Open the property window via double-click on the CP 343-1EX11 and
enter for the CP at "Properties" the IP address data, which you have
assigned before.

Transfer your project.

Standard bus (serial) — Standard bus

Slot | Module
1
2 CPU
X...

Ethernet-PG/OP

DI

DO

DIO

Al

AO
343-1EX11

DI DO DIo Al AO

o
T
c

Ethernet-PG/OP channel

2B lom N (o] |w
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Setting standard CPU parameters

Parameterization
via Siemens
CPU 318-2AJ00

Supported
parameters

General
Short description

Order No. /
Firmware

Name

Plant designation

Comment

Since the CPU from VIPA is to be configured as Siemens CPU 318-2 (CPU
318-2AJ00 V3.0) in the Siemens hardware configurator, the standard
parameters of the VIPA CPU may be set with "Object properties" of the
CPU 318-2 during hardware configuration.

Via a double-click on the CPU 318-2 the parameter window of the CPU
may be accessed.

Using the registers you get access to every standard parameter of the
CPU.

Parameter CPU
SIOt MOdU|e Param: ......... Param: .........
1 ” Param : ......... Param : .........
Param: ......... Param: .........
2 CPU ... b Param: ......... Param: .........
X2 DP
X1 MPI/DP
3
4

The CPU does not evaluate each parameter, which may be set at the
hardware configuration.

The following parameters are supported by the CPU at this time:

The short description of the Siemens CPU 318-2AJ00 is CPU 318-2.

Order number and firmware are identical to the details in the "hardware
catalog" window.

The Name field provides the short description of the CPU. If you change
the name the new name appears in the Siemens SIMATIC manager.

Here is the possibility to specify a plant designation for the CPU. This plant
designation identifies parts of the plant according to their function. This has
a hierarchical structure and confirms to IEC 1346-1.

In this field information about the module may be entered.
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Startup

Startup when
expected/actual
configuration differs

Monitoring time for
ready message by
modules [100ms]

Monitoring time for
transfer of
parameters to
modules [100ms]

Cycle/Clock
memory

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

Scan cycle load
from Communi-
cation

Size of the process
image input/output
area

If the checkbox for "Startup when expected/actual configuration differ" is
deselected and at least one module is not located at its configured slot or if
another type of module is inserted there instead, then the CPU does not
switch to RUN mode and remains in STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is
selected, then the CPU starts even if there are modules not located in their
configured slots of if another type of module is inserted there instead, such
as during an initial system start-up.

This operation specifies the maximum time for the ready message of every
configured module after PowerON. Here connected PROFIBUS DP slaves
are also considered until they are parameterized. If the modules do not
send a ready message to the CPU by the time the monitoring time has
expired, the actual configuration becomes unequal to the preset
configuration.

The maximum time for the transfer of parameters to parameterizable
modules. If not every module has been assigned parameters by the time
this monitoring time has expired; the actual configuration becomes unequal
to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan
cycle time exceeds the scan cycle monitoring time, the CPU enters the
STOP mode. Possible reasons for exceeding the time are:

» Communication processes
» a series of interrupt events
e an error in the CPU program

This parameter is not relevant.

Using this parameter you can control the duration of communication
processes, which always extend the scan cycle time so it does not exceed
a specified length.

If the cycle load from communication is set to 50%, the scan cycle time of
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still
being influenced by asynchronous events (e.g. hardware interrupts) as well.

Here the size of the process image max. 2048 for the input/output periphery
may be fixed.

4-10
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0B85 call up at I/0
access error

Clock memory

Retentive Memory

Number of Memory
Bytes from MBO

Number of S7
Timers from TO

Number of S7
Counters from CO

Areas

Interrupts

Priority

The preset reaction of the CPU may be changed to an I/O access error that
occurs during the update of the process image by the system.

The VIPA CPU is preset such that OB 85 is not called if an I/O access error
occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the
number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.

Enter the number of retentive memory bytes from memory byte 0 onwards.

Enter the number of retentive S7 timers from TO onwards. Each S7 timer
occupies 2bytes.

Enter the number of retentive S7 counter from CO onwards.

These parameters are not relevant.

Here the priorities are displayed, according to which the hardware interrupt

OBs are processed (hardware interrupt, time-delay interrupt, async. error
interrupts).
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Time-of-day
interrupts

Priority

Active

Execution

Start date / time

Process image
partition

Cyclic interrupts

Priority

Execution

Phase offset

Process image
partition

Here the priorities may be specified according to which the time-of-day
interrupt is processed.

With priority "0" the corresponding OB is deactivated.

Activate the check box of the time-of-day interrupt OBs if these are to be
automatically started on complete restart.

Select how often the interrupts are to be triggered. Intervals ranging from
every minute to yearly are available. The intervals apply to the settings
made for start date and time.

Enter date and time of the first execution of the time-of-day interrupt.

This parameter is not supported.

Here the priorities may be specified according to which the corresponding
cyclic interrupt is processed. With priority "0" the corresponding interrupt is
deactivated.

Enter the time intervals in ms, in which the watchdog interrupt OBs should
be processed. The start time for the clock is when the operating mode
switch is moved from STOP to RUN.

Enter the delay time in ms for current execution for the watch dog interrupt.
This should be performed if several watchdog interrupts are enabled.
Phase offset allows to distribute processing time for watchdog interrupts
across the cycle.

This parameter is not supported.

4-12
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Diagnostics/Clock

Report cause of
STOP

Number of
messages in the
diagnostics buffer

Synchronization
type

Time interval

Correction factor

Protection

Level of protection

Activate this parameter, if the CPU should report the cause of STOP to PG
respectively OP on transition to STOP.

Here the number of diagnostics are displayed, which may be stored in the
diagnostics buffer (circular buffer).

You can specify whether the CPU clock should be used to synchronize
other clocks or not.

- as slave: The clock is synchronized by another clock.
- as master: The clock synchronizes other clocks as master.
- none: There is no synchronization

Time intervals within which the synchronization is to be carried out.

Lose or gain in the clock time may be compensated within a 24 hour period
by means of the correction factor in ms. If the clock is 1s slow after 24
hours, you have to specify a correction factor of "+1000" ms.

Here 1 of 3 protection levels may be set to protect the CPU from
unauthorized access.

Protection level 1 (default setting):

* No password adjustable, no restrictions
Protection level 2 with password:

» Authorized users: read and write access

* Unauthorized user: read access only
Protection level 3:

» Authorized users: read and write access

» Unauthorized user: no read and write access
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Parameter for DP

General
Short description
Order no.

Name

Interface

Properties

Comment
Addresses

Diagnostics

Operating mode

Configuration

Clock

The properties dialog of the PROFIBUS part is opened via a double click to
the sub module DP.

Here the short description "DP" for PROFIBUS DP is specified.
Nothing is shown here.

Here "DP" is shown. If you change the name, the new name appears in the
Siemens SIMATIC manager.

The PROFIBUS address is shown here.

With this button the properties of the PROFIBUS DP interface may be
preset.

You can enter the purpose of the DP master in this box.

A diagnostics address for PROFIBUS DP is to be preset here. In the case
of an error the CPU is informed via this address.

Here the operating mode of the PROFIBUS part may be preset. More may
be found at chapter "Deployment PROFIBUS Communication".

Within the operating mode "DP-Slave" you may configure your slave
system. More may be found at chapter "Deployment PROFIBUS
communication".

These parameters are not supported.
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Parameter for
MPI/DP

General

Short description

Order no.

Name

Type

Interface

Properties

Comment

Addresses

Diagnostics

Operating mode,
Configuration, Clock

The properties dialog of the MPI interface is opened via a double click to
the sub module MPI/DP.

Here the short description "MPI/DP" for the MPI interface is specified.
Nothing is shown here.

At Name "MPI/DP" for the MPI interface is shown. If you change the name,
the new name appears in the Siemens SIMATIC manager.

Please regard only the type "MPI" is supported by the VIPA CPU.
Here the MPI address is shown.
With this button the properties of the MPI interface may be preset.

You can enter the purpose of the MPI interface in this box.

A diagnostics address for the MPI interface is to be preset here. In the case
of an error the CPU is informed via this address.

These parameters are not supported.
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Setting VIPA specific CPU parameters

Overview

Requirements

Installation of the

Except of the VIPA specific CPU parameters the CPU parameterization
takes place in the parameter dialog of the CPU 318-2AJ00.

With installing of the SPEEDBUS.GSD the VIPA specific parameters may
be set during hardware configuration.

Here the following parameters may be accessed:

» Function RS485 (PtP, Synchronization DP master and CPU)
» Token Watch

* Number remanence flag, timer, counter

» Priority OB 28, OB 29, OB 33, OB 34

» Execution OB 33, OB 34

* Phase offset OB 33, OB 34

Since the VIPA specific CPU parameters may be set, the installation of the
SPEEDBUS.GSD from VIPA in the hardware catalog is necessary.

The CPU may be configured in a PROFIBUS master system and the
appropriate parameters may be set after installation.

The GSD (Gerate-Stamm-Datei) is online available in the following

SPEEDBUS.GSD language versions. Further language versions are available on inquires.
Name Language
SPEEDBUS.GSD german (default)
SPEEDBUS.GSG german
SPEEDBUS.GSE english
The GSD files may be found at www.vipa.de at the "Service" part.
The integration of the SPEEDBUS.GSD takes place with the following
proceeding:
« Browse to www.vipa.de.
» Click to Service > Download > GSD- and EDS-Files > PROFIBUS.
* Download the file Cx000023_VxxX.
» Extract the file to your work directory. The SPEEDBUS.GSD is stored in

the directory VIPA_System_300S.
+ Start the hardware configurator from Siemens.
» Close every project.
» Select Options > Install new GSD-file.
* Navigate to the directory VIPA_System_300S and select
SPEEDBUS.GSD.

The SPEED7 CPUs and modules of the System 300S from VIPA may now
be found in the hardware catalog at PROFIBUS-DP / Additional field
devices / /0 / VIPA_SPEEDBUS.
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Proceeding The embedding of the CPU 315-4NE12 happens by means of a virtual
PROFIBUS master system with the following approach:

Slot | Module
1
2 CPU ...
X2
X1
3

Modules at the bus

343-1EX11
Ethernet-PG/OP

343-1EX11

(interner CP)

always as last module
342-5DA02 V5.0

virtual DP-Master for CPU

(100 VIPA | ~p| J-

w TAddr.:100
v

VIPA_SPEEDbus

[Slot  [Order No. |
[0 |315-4NE12 315SN/NE

\

Object properties

» Perform a hardware configuration for the CPU (see
"Hardware configuration - CPU".

» Configure always as last module a Siemens DP master
CP 342-5 (342-5DA02 V5.0). Connect and parameterize
it at operation mode "DP-Master".

 Connect the slave system "VIPA SPEEDbus". After
installing the SPEEDBUS.GSD this may be found in the
hardware catalog at PROFIBUS-DP / Additional field
devices / 1/0 / VIPA / VIPA_SPEEDBUS.

» For the slave system set the PROFIBUS address 100.

» Configure at slot 0 the VIPA CPU 315-4NE12 of the
hardware catalog from VIPA_SPEEDbus.

By double clicking the placed CPU 315-4NE12 the
properties dialog of the CPU may be opened.

As soon as the project is transferred together with the PLC
user program to the CPU, the parameters will be taken after
start-up.
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VIPA specific
parameters

Function RS485

Synchronization
between master
system and CPU

The following parameters may be accessed by means of the properties
dialog of the VIPA-CPU.

Per default the RS485 interface is used for the PROFIBUS DP master.
Using this parameter the RS485 interface may be switched to PtP
communication (point to point) respectively the synchronization between
DP master system and CPU may be set:

Deactivated Deactivates the RS485 interface

PtP With this operating mode the PROFIBUS DP
master is deactivated and the RS485 interface
acts as an interface for serial point-to-point
communication.
Here data may be exchanged between two
stations by means of protocols.
More about this may be found at chapter
"Deployment RS485 for PtP communication”
in this manual.

PROFIBUS DP async PROFIBUS DP master operation
asynchronous to CPU cycle
The RS485 interface is preset at default to
PROFIBUS DP async. Here CPU cycle and
cycles of every VIPA PROFIBUS DP master
run independently.

PROFIBUS DP syncin The CPU is waiting for DP master input data.

PROFIBUS DP syncOut The DP master system is waiting for CPU
output data.

PROFIBUS DP syncinOut CPU and DP master system are waiting on
each other and form thereby a cycle.

Default: PROFIBUS DP async

Normally the cycles of CPU and DP master run independently. The cycle
time of the CPU is the time needed for one OB1 cycle and for reading
respectively writing the inputs respectively outputs. The cycle time of a DP
master depends among others on the number of connected slaves and the
baud rate, thus every plugged DP master has its own cycle time.

Due to the asynchronism of CPU and DP master the whole system gets
relatively high response times.

The synchronization behavior between every VIPA PROFIBUS DP master
and the CPU may be configured by means of a hardware configuration as
shown above.

The different modes for the synchronization are in the following described.

4-18
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PROFIBUS DP

SyncInOut

PROFIBUS DP

SyncOut

DP master system

In PROFIBUS DP SyncinOut mode CPU and DP-Master-System are
waiting on each other and form thereby a cycle. Here the whole cycle is the
sum of the longest DP master cycle and CPU cycle.

By this synchronization mode you receive global consistent in-/ output data,
since within the total cycle the same input and output data are handled
successively by CPU and DP master system.

If necessary the time of the Watchdog of the bus parameters should be
increased at this mode.

SPEED7 CPU ‘ ‘ Cycle ‘ ‘ ‘

VIPA Cycle

|
\—’_1

whole cycle

‘ ‘ ‘ ‘ Cycle

In this operating mode the cycle time of the VIPA DP master system
depends on the CPU cycle time. After CPU start-up the DP master gets
synchronized.

As soon as their cycle is passed they wait for the next synchronization
impulse with output data of the CPU. So the response time of your system
can be improved because output data were directly transmitted to the DP
master system. If necessary the time of the Watchdog of the bus para-
meters should be increased at this mode.

RUN

Cycle CPU > DPM
"1-tier CPU cycle" VIPA ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘

SPEED7 CPU ‘ Cycle ‘ ‘ ‘ ‘

DP master system

Cycle CPU < DPM
"n-tier CPU cycle" VIPA ‘ ‘

SPEED7 CPU ‘ Cycle

DP master system

PROFIBUS DP

Syncin

In the operating mode PROFIBUS DP Syncin the CPU cycle is
synchronized to the cycle of the VIPA PROFIBUS DP master system.

Here the CPU cycle depends on the VIPA DP master with the longest cycle
time. If the CPU gets into RUN it is synchronized with each PROFIBUS DP
master. As soon as the CPU cycle is passed, it waits for the next
synchronization impulse with input data of the DP master system.

If necessary the Scan Cycle Monitoring Time of the CPU should be in-
creased.

RUN
SPEED7 CPU ‘ Cycle ‘ ‘ ‘ ‘
Cycle CPU > DPM
"n-tier longest DP master cycle” VIPA ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘
Cycle
DP master system
RUN
SPEED7 CPU ‘ ‘ Cycle ‘ ‘ ‘
Cycle CPU < DPM
"1-tier longest DP master cycle" VIPA

DP master system Cyele ‘ ‘ ‘ ‘ ‘ ‘
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Token Watch

Number
remanence flag

Phase offset and
execution of OB33
and OB34

Priority of OB28,
0OB29, OB33 and
OB34

By presetting the PROFIBUS bus parameters within the hardware
configuration a token time for the PROFIBUS results. The token time
defines the duration until the token reaches the DP master again.

Per default this time is supervised. Due to this monitoring disturbances on
the bus can affect a reboot of the DP master. Here with the parameter
Token Watch the monitoring of the token time can be switched off
respectively on.

Default: On

Here the number of flag bytes may be set. With 0 the value Retentive
memory > Number of memory bytes starting with MBO set at the
parameters of the Siemens CPU is used. Otherwise the adjusted value
(1...8192) is used.

Default: 0

The CPU offers additional cyclic interrupts, which interrupt the cyclic
processing in certain distances. Point of start of the time interval is the
change of operating mode from STOP to RUN.

To avoid that the cyclic interrupts of different cyclic interrupt OBs receive a
start request at the same time and so a time out may occur, there is the
possibility to set a phase offset respectively a time of execution.

The phase offset (0 ... 60000ms) serves for distribution processing times for
cyclic interrupts across the cycle.

The time intervals, in which the cyclic interrupt OB should be processed
may be entered with execution (1 ... 60000ms).

Default: Phase offset: 0
Execution: OB33: 500ms
OB34: 200ms

The priority fixes the order of interrupts of the corresponding interrupt OB.
Here the following priorities are supported:

0 (Interrupt-OB is deactivated), 2, 3, 4, 9, 12, 16, 17, 24

Default: 24
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Project transfer

Overview

Transfer via
MPI/PROFIBUS

Net structure

MPI programming
cable

Terminating resistor

STEP7
from Siemens

-

MPI programming cable

There are the following possibilities for project transfer into the CPU:
» Transfer via MPI/PROFIBUS

» Transfer via Ethernet

» Transfer via MMC

For transfer via MPI/PROFIBUS there are the following 2 interfaces:
* X2: MPI interface
» X3: PROFIBUS interface

The structure of a MPI net is electrically identical with the structure of a
PROFIBUS net. This means the same rules are valid and you use the
same components for the build-up. The single participants are connected
with each other via bus interface plugs and PROFIBUS cables. Per default
the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI
address 2.

The MPI programming cables are available at VIPA in different variants.
The cables provide a RS232 res. USB plug for the PC and a bus enabled
RS485 plug for the CPU.

Due to the RS485 connection you may plug the MPI programming cables
directly to an already plugged plug on the RS485 jack. Every bus
participant identifies itself at the bus with an unique address, in the course
of the address 0 is reserved for programming devices.

A cable has to be terminated with its surge impedance. For this you switch
on the terminating resistor at the first and the last participant of a network or
a segment.

Please make sure that the participants with the activated terminating

resistors are always power supplied. Otherwise it may cause interferences
on the bus.

Terminating MPI/PROFIBUS net Terminating

fhEees s
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Approach transfer
via MPI interface

Approach transfer

Connect your PC to the MPI jack of your CPU via a MPI programming
cable.

Load your project in the SIMATIC Manager from Siemens.
Choose in the menu Options > Set PG/PC interface

Select in the according list the "PC Adapter (MPI)"; if appropriate you
have to add it first, then click on [Properties].

Set in the register MPI the transfer parameters of your MPI net and type
a valid address.

Switch to the register Local connection

Set the COM port of the PC and the transfer rate 38400Baud for the MPI
programming cable from VIPA.

Via PLC > Load to module you may transfer your project via MPI to the
CPU and save it on a MMC via PLC > Copy RAM to ROM if one is

plugged.

Connect your PC to the DP-PB/PtP jack of your CPU via a MPI

yia PROFIBUS programming cable.
interface « Load your project in the Siemens SIMATIC Manager.

» Choose in the menu Options > Set PG/PC interface

» Select in the according list the "PC Adapter (PROFIBUS)"; if appropriate
you have to add it first, then click on [Properties].

+ Set in the register PROFIBUS the transfer parameters of your
PROFIBUS net and type a valid PROFIBUS address. The PROFIBUS
address must be assigned to the DP master by a project before.

» Switch to the register Local connection

» Set the COM port of the PCs and the transfer rate 38400Baud for the
MPI programming cable from VIPA.

* Via PLC > Load to module you may transfer your project via PROFIBUS
to the CPU and save it on a MMC via PLC > Copy RAM to ROM if one is
plugged.

Note!

Transfer via PROFIBUS is available by DP master, if projected as master

and assigned with a PROFIBUS address before.

Within selecting the slave mode you have additionally to select the option

"Test, commissioning, routing".
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Transfer via
Ethernet

Initialization

Transfer

For transfer via Ethernet the CPU has the following interface:
» X5: Ethernet PG/OP channel

So that you may access the Ethernet PG/OP channel you have to assign IP
address parameters by means of the ‘"initialization"(see "hardware
configuration - Ethernet PG/OP channel".

Information about the initialization of the Ethernet PG/OP channel may be
found at "Initialization of Ethernet PG/OP channel".

» For the transfer, connect, if not already done, the appropriate Ethernet
port to your Ethernet.

* Open your project with the Siemens SIMATIC Manager.
» Set via Options > Set PG/PC Interface the access path to "TCP/IP ->

Network card .... ".

» Click to PLC > Download — the dialog "Select target module" is opened.
Select your target module and enter the IP address parameters of the
Ethernet PG/OP channel for connection. Provided that no new hardware
configuration is transferred to the CPU, the entered Ethernet connection
is permanently stored in the project as transfer channel.

» With [OK] the transfer is started.

Note!

System dependent you get a message that the projected system differs
from target system. This message may be accepted by [OK].

— your project is transferred and may be executed in the CPU after
transfer.
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Transfer via
MMC

Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The MMC (Memory Card) serves as external transfer and storage medium.
There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project is stored in the root
directory and has one of the following file names:

» S7PROG.WLD
* AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC Manager a
new wld file may be created. After the creation copy the blocks from the
project blocks folder and the System data into the wid file.

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after an overall reset or PowerON.

« S7PROG.WLD is read from the MMC after overall reset.
e AUTOLOAD.WLD is read after PowerON from the MMC.

The blinking of the LED "MCC" of the CPU marks the active transfer.
Please regard that your user memory serves for enough space, otherwise
your user program is not completely loaded and the SF LED gets on.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as STPROG.WLD on the MMC.

The write command is controlled by means of the block area of the
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write
process the "MCC"-LED of the CPU is blinking. When the LED expires the
write process is finished.

If this project is to be loaded automatically from the MMC with PowerON,
you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU.
To monitor the diagnosis entries, you select PLC > Module Information in
the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you
reach the diagnosis window.

When accessing a MMC, the following events may occur:
Event-ID Meaning
OxE100 MMC access error

O0xE101 MMC error file system
OxE102 MMC error FAT

OxE104 MMC-error with storing

0xE200 MMC writing finished successful

0xE210 MMC reading finished (reload after overall reset)
OxE21F Error during reload, read error, out of memory
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Access to the internal Web page

The Ethernet PG/OP channel provides a web page that you may access via
an Internet browser by its IP address. The web page contains information
about firmware versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd -
Auto commands".

Access to the
web page

A PG/OP channel connection should be established between PC with
Internet browser and CPU 315-4NE12. This may be tested by Ping to the
IP address of the PG/OP channel.

Requirements

Web page The access takes place via the IP address of the Ethernet PG/OP channel.
«- = -@ @3 ala The web page only serves for information output. The monitored values are
Addr: | 1. e 2T not alterable.
IP PG/OP

CPU W TH ETHERNET PG OP
Sl ot 100
VI PA 315-4NE12 V.. ..
SERI ALNUVMBER 05439
SUPPORTDATA :
PRODUCT V3420, HARDWARE V0111, 5679L- V10,
Hx000029. 100, Bx000227 V6420, Ax000086 V1200,
Ax000056 V0000, fx000007.w d V1120,
Fl ashFi |l eSystem : V102
Menorysi zes (Bytes): LoadMem :

Px000079. pkg, Order no., firmware vers., package,
serial no.

Information for support

1048576, Information about memory

Sl

Wor kMenCode : 524288, WorkMenData : 524288 configuration, load memory, work
memory (code/data)

OnBoar dEt her net MacAddress : 0020D577153F, Ethernet PG/OP: Addresses

| P-Address : , SubnetMask : , Gateway :

Cpu state : Stop CPU status

Functi onRS485 X2/ COML: MPI

Functi onRS485 X3/ COMR2: DPM async

Cycletine [nicroseconds] m n=0 cur=0 ave=0
max=0

MCC-Trial -Time: 70:23

ArnLoad [ percent] curll, max=35

ot 201

VI PA 342- 1DA70 V3. 1.9 Px000062. pkg,
SUPPORTDATA :

PRODUCT V3190, BB000218 V5190,

V4160, Modul eType CB2C0010,
[ mi croseconds] m n=65535000
max=0 cnt =0

AB000068
Cycletine
cur=0 ave=0

Operating mode RS485

(MPI: MPI operation, DPM: DP master)
CPU cycle time:

min= minimal

cur= current

max= maximal

Remaining time in hh:mm for deacti-
vation of the expansion memory if
MCC is removed.

Information for support

Additional CPU components:
Slot 201 (DP master):

Name, firmware version, package
Information for support

continued ...
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... continue

Sl ot 206
VI PA 343- 1EX71 V2.2.7 Px000058. pkg,
SUPPORTDATA :
Bb000165 V2270, AB000060 V0320

PRODUCT V2270, Hx000003 V1400
Modul eType ACDB0000

Address I nput 1024...1039
Address Qutput 1024...1039

St andard Bus
BaudRat e Read Mbdel, BaudRate Wite Mdel

Line 1: Modul eType 94F9: | M36x
Rack 0 /Slot 4

Modul eType: 9FC3: Digital |nput 32
Baseaddress I nput O

Rack 0 /Slot 5 ...
Li ne 2: Modul eType A4AFE: | M36x

Rack 1 /Slot 4

Modul eType: 9FC3: Digital |nput 32
Baseaddress I nput O

Rack 1 /Slot 5 ...

Slot 206 (CP 343):
Name, firmware version, package
Information for support

Modules at the standard bus
Information for the support

IM interface if exists
Rack no. / Slot no.

Type of module

Configured base address

if exists firmware no. and package
Rack no. / slot no.

IM interface if exists

Type of module

Configured base address

if exists firmware no. and package
Rack no. / slot no.

4-26 HB140E - CPU - RE_315-4NE12 - Rev. 12/06



Manual VIPA System 300S SPEED7 Chapter 4 Deployment CPU 315-4NE12

Operating modes

Overview

Operating mode
STOP

Operating mode
START-UP

Operating mode
RUN

The CPU can be in one of 4 operating modes:
» Operating mode STOP

» Operating mode START-UP

» Operating mode RUN

» Operating mode HOLD

Certain conditions in the operating modes START-UP and RUN require a
specific reaction from the system program. In this case the application
interface is often provided by a call to an organization block that was
included specifically for this event.

» The application program is not processed.

» If there has been a processing before, the values of counters, timers,
flags and the process image are retained during the transition to the
STOP mode.

» Outputs are inhibited, i.e. all digital outputs are disabled.
* RUN-LED off
« STOP-LED on

* During the transition from STOP to RUN a call is issued to the start-up
organization block OB 100. The processing time for this OB is not
monitored. The START-UP OB may issue calls to other blocks.

» All digital outputs are disabled during the START-UP, i.e. outputs are
inhibited.
* RUN-LED blinks as soon as the OB 100 is operated and for at least

3s, even if the start-up time is shorter or the CPU gets to
STOP due to an error. This indicates the start-up.

« STOP-LED off

When the CPU has completed the START-UP OB, it assumes the
operating mode RUN.

» The application program in OB 1 is processed in a cycle. Under the
control of alarms other program sections can be included in the cycle.

» All timers and counters being started by the program are active and the
process image is updated with every cycle.

» The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs
are enabled.

* RUN-LED on
« STOP-LED off
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Operating mode
HOLD

Precondition

Approach for
working with
breakpoints

Behavior in
operating state
HOLD

The CPU offers up to 3 breakpoints to be defined for program diagnosis.
Setting and deletion of breakpoints happens in your programming
environment. As soon as a breakpoint is reached, you may process your
program step by step.

For the usage of breakpoints, the following preconditions have to be
fulfilled:

» Testing in single step mode is only possible with STL. If necessary
switch the view via View > STL to STL.

* The block must be opened online and must not be protected.
» The open block must not be altered in the editor.

» Activate View > Breakpoint Bar.

» Set the cursor to the command line where you want to insert a
breakpoint.

o Set the breakpoint with Debug > Set Breakpoint. The according
command line is marked with a circle.

» To activate the breakpoint click on Debug > Breakpoints Active. The
circle is changed to a filled circle.

* Bring your CPU into RUN. When the program reaches the breakpoint,
your CPU switches to the state HOLD, the breakpoint is marked with an
arrow and the register contents are monitored.

« Now you may execute the program code step by step via Debug >
Execute Next Statement or run the program until the next breakpoint via
Debug > Resume.

» Delete (all) breakpoints with the option Debug > Delete All Breakpoints.

* The LED RUN blinks and the LED STOP is on.

» The execution of the code is stopped. No level is further executed.
» All times are frozen.

» The real-time clock runs is just running.

» The outputs were disabled (BASP is activated).

» Configured CP connections remain exist.

Note!

The usage of breakpoints is always possible. Switching to the operating
mode test operation is not necessary.

With more than 2 breakpoints, a single step execution is not possible.
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Function The CPUs include security mechanisms like a Watchdog (100ms) and a
security parameterizable cycle time surveillance (parameterizable min. 1ms) that
stop res. execute a RESET at the CPU in case of an error and set it into a
defined STOP state.
The VIPA CPUs are developed function secure and have the following
system properties:
Event concerns Effect
RUN - STOP |general BASP (Befehls-Ausgabe-Sperre, i.e. command
output lock) is set.
central digital outputs The outputs are disabled.
central analog outputs The Outputs are disabled.
- Voltage outputs issue 0V
- Current outputs 0...20mA issue OmA
- Current outputs 4...20mA issue 4mA
If configured also substitute values may be
issued.
decentral outputs Same behavior as the central digital/analog
outputs.
decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.
STOP - RUN |general First the Pll is deleted, then OB 100 is called. After

res. PowerON

the execution of the OB, the BASP is reset and the
cycle starts with:
Delete PIO - Read PIl - OB 1.

central analog outputs

The behavior of the outputs at restart can be
preset.

decentral inputs

The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.

RUN

general

The program execution happens cyclically and can
therefore be foreseen:
Read PIl -~ OB 1 - Write PIO.

Pll = Process image inputs
PI1O = Process image outputs

HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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Overall reset

Overview

Overall reset by
means of the
function selector

During the overall reset the entire user memory (RAM) is erased. Data
located in the memory card is not affected.

You have 2 options to initiate an overall reset:
* initiate the overall reset by means of the function selector switch
* initiate the overall reset by means of the Siemens SIMATIC Manager

Note!

You should always issue an overall reset to your CPU before loading an
application program into your CPU to ensure that all blocks have been
cleared from the CPU.

Condition

The operating mode of the CPU is STOP. Place the function selector on the
CPU in position "STOP" - the STOP-LED is on.

Overall reset

» Place the function selector in the position MRES and hold it in this
position for app. 3 seconds. - The STOP-LED changes from blinking to
permanently on.

» Place the function selector in the position STOP and switch it to MRES
and quickly back to STOP within a period of less than 3 seconds.

- The STOP-LED blinks (overall reset procedure).

 The overall reset has been completed when the STOP-LED is on

permanently. -~ The STOP-LED is on.

The following figure illustrates the above procedure:

@ ©) ®

®

PWR PWR PWR PWR
RUN RUN RUN RUN
N / N /
—J |stoP STOP —J |sFoP sToP
/ SN ~ 77T\ ~
SF SF SF SF
FRCE FRCE FRCE FRCE
N N N N
RUN RUN RUN RUN
o} o @ Yo (@
MRES MRES MRES MRES

3 Sec. |
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Automatic reload

Overall reset by
means of the
Siemens SIMATIC
Manager

Automatic reload

Set back to factory
setting

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

Condition

The operating mode of the CPU must be STOP.
You may place the CPU in STOP mode by the menu command
PLC > Operating mode.

Overall reset

You may request the overall reset by means of the menu command PLC >
Clean/Reset.

In the dialog window you may place your CPU in STOP mode and start the
overall reset if this has not been done as yet.

The STOP-LED blinks during the overall reset procedure.

When the STOP-LED is on permanently the overall reset procedure has
been completed.

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed, the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

The following approach deletes the internal RAM of the CPU completely
and sets it back to the delivery state.

Please regard that the MPI address is also set back to default 2!
More information may be found at the part "Factory reset" further below.
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Firmware update

Overview

Latest Firmware at
www.vipa.de

There is the opportunity to execute a firmware update for the CPU and its
components via MMC. For this an accordingly prepared MMC must be in
the CPU during the startup.

So a firmware files can be recognized and assigned with startup, a pkg file
name is reserved for each updateable component an hardware release,
which begins with "px" and differs in a number with six digits.

The pkg file name of every updateable component may be found at a label
right down the front flap of the module.

As soon as with startup a pkg file is on the MMC and the firmware is more
current than in the components, all the pkg file assigned components within
the CPU get the new firmware.

Firmware package
and version

The latest firmware versions are to be found in the service area at
www.vipa.de.

For example the following files are necessary for the firmware update of the
CPU 315-4NE12 and its components with hardware release 1:

* 315-4NE12, Hardware release 1: Px000079.pkg
* PROFIBUS DP master: Px000062.pkg
» Ethernet-CP 343: Px000058.pkg
Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the CPU, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different
from the existing firmware otherwise no update is executed.
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Display the
Firmware version of
the SPEED7 system
via Web Site

Load firmware and
transfer it to MMC

The CPU has an integrated website that monitors information about
firmware version of the SPEED7 components. The Ethernet PG/OP
channel provides the access to this web site.

To activate the PG/OP channel you have to enter according IP parameters.
This can be made in Siemens SIMATIC manager either by a hardware

configuration, loaded by MMC respectively MPI or via Ethernet by means of
the MAC address with PLC > Assign Ethernet Address.

After that you may access the PG/OP channel with a web browser via the
IP address of the project engineering. More detailed information is to find in
the manual at "Access to Ethernet PG/OP channel and website".

* Go to www.vipa.de.
» Click on Service > Download > Firmware.

» Navigate via System 300S > CPU to your CPU and download the zip file
to your PC.

» Extract the zip file and copy the extracted pkg files to your MMC.

Attention!

With a firmware update an overall reset is automatically executed. If your
program is only available in the load memory of the CPU it is deleted! Save
your program before executing a firmware update! After the firmware
update you should execute a "Set back to factory settings" (see following

page).
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Transfer firmware
from MMC into

CPU

S

Preparation
l RUN
STOP
MRES
Insert MMC

Power OFF/ON

NI/

mm!um

2)

Firmware
recognized

at
PL

MMC
c
PWR
RUN
STOP

<
SN\
FRCE -
/
MCC

£ nY)
CILILITITIT I8 2

SF

7
FRCE
N

mcc

Switch the operating mode switch of your CPU in position STOP.
Turn off the voltage supply. Plug the MMC with the firmware files
into the CPU. Please take care of the correct plug-in direction of the
MMC. Turn on the voltage supply.

After a short boot-up time, the alternate blinking of the LEDs SF and
FRCE shows that at least a more current firmware file was found on
the MMC.

You start the transfer of the firmware as soon as you tip the
operating mode switch lever downwards to MRES within 10s.

During the update process, the LEDs SF and FRCE are alternately
blinking and MCC LED is on. This may last several minutes.

The update is successful finished when the LEDs PWR, STOP, SF,
FRCE and MCC are on. If they are blinking fast, an error occurred.

Turn Power OFF and ON. Now it is checked by the CPU, whether
further current firmware versions are available at the MMC. If so,
again the LEDs SF and FRCE flash after a short start-up period.
Continue with point 3.

If the LEDs do not flash, the firmware update is ready.

Now a factory reset should be executed (see next page). After that
the CPU is ready for duty.

© OEENORN IO

Start update Update runs Update Error
terminates
error free

PLC PLC
PWR EPWR PWR

RUN RUN RUN

STOP STOP SToP
N

SF SF

>/
FRCE FRCE
McC

PWR

RUN

STOP
v

7\

N
/7 AN
FRCE —
MCC

= /3

(@)

O/ﬁ\
NININTZ L/
78\ /N
%

Power
OFF/ON

o
CILILITITIT I8 2
o

(T T T 2
N
T

(2]
m
HENENE EREN

i RUN RUN
l — STOP STOP
MRES

MRES
| 10 Sec. |
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Factory reset

Proceeding

)

CPUin
STOP

PWR
RUN
STOP

[72]
4

FRCE
MCC

LILITITITIT IR
o

2)

Wit

h the following proceeding the internal RAM of the CPU is completely

deleted and the CPU is reset to delivery state. Please note that here also

the

IP address of the Ethernet PG/OP channel is set to 0.0.0.0 and the MPI

address is reset to the address 2!

A factory reset may also be executed by the MMC-Cmd FACTORY_
RESET. More information may be found at "MMC-Cmd - Auto commands".

Switch the CPU to STOP.

Push the operating mode switch down to position MRES for 30s. Here
the STOP-LED flashes. After a few seconds the stop LED changes to
static light. Now the STOP LED changes between static light and
flashing. Starting here count the static light states.

After the 6. static light release the operating mode switch and tip it
downwards to MRES. Now the RUN LED lights up once. This means
that the RAM was deleted completely.

For the confirmation of the resetting procedure the LEDs PWR, STOP,
SF, FRCE and MCC get ON. If not, the factory reset has failed and only
an overall reset was executed. In this case you can repeat the
procedure. A factory reset can only be executed if the stop LED has
static light for exactly 6 times.

The end of factory reset is shown by static light of the LEDs STOP, SF,
FRCE and MCC. Switch the power supply off and on.

The proceeding is shown in the following lllustration:

5 ONNINNC

Request factory reset Start factory reset Factory reset  Error: Only
executed overall reset
executed

PLC PLC c PLC PLC
EPwRr EPwr PWR [EPWR EPwr

N :RL}N [ |RUN RUN | |RUN [ |RUN

\:§T-OP [_|stoP STOP [ |sToP [ |sToP

L™\ L] L]
| |SF ( |6X >7SF SF sk | |SF
|_|[FRCE [ FRCE | |FRCE |_|FRCE

T|p
MRES

RUN

FRCE Tip

MGG — STOP l — STOP
MRES MRES

— LI ITTIEER

Mcc Mmcc Mcc Mmcc Power
u OFF/ON
30 Sec. | | 1 Sec.
Note!
After the firmware update you always should execute a Factory reset.
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Slot for storage media

Overview

Accessing the
storage medium

After overall reset

After PowerON

At the front of the CPU there is a slot for storage media.
As external storage medium for applications and firmware you may use a
multimedia card (MMC) or a VIPA MCC memory extension card. The MCC
can additionally be used as an external storage medium.

It has the PC compatible FAT16 file format.

You can cause the CPU to load a project automatically respectively to
execute a command file by means of pre-defined file names.

To the following times an access takes place on a storage medium:

» The CPU checks if there is a project STPROG.WLD. If exists the project
is automatically loaded.

» The CPU checks if there is a project PROTECT.WLD with protected
blocks. If exists the project is automatically loaded. These blocks are
stored in the CPU until the CPU is reset to factory setting or an empty
PROTECT.WLD is loaded.

 The CPU checks if a MCC memory extension card is put. If exists the
memory extension is enabled, otherwise a memory expansion, which
was activated before, is de-activated.

» The CPU checks if there is a project AUTOLOAD.WLD. If exists an
overall reset is established and the project is automatically loaded.

» The CPU checks if there is a command file with VIPA_CMD.MMC. If
exists the command file is loaded and the containing instructions are
executed.

» After PowerON and CPU STOP the CPU checks if there is a *.pkg file
(firmware file). If exists this is indicated by blinking of the LEDs and the
firmware may be installed by an update request (see "Firmware update).

Once in STOP  If a storage medium is put, which contains a command file
VIPA_CMD.MMC, the command file is loaded and the containing
instructions are executed.

4-36 HB140E - CPU - RE_315-4NE12 - Rev. 12/06



Manual VIPA System 300S SPEED7 Chapter 4 Deployment CPU 315-4NE12

Memory extension with MCC

Overview

VIPA

& ViPAg531LPoo

Approach

Behavior

There is the possibility to extend the work memory of the CPU.

For this, a MCC memory extension card is available from VIPA. The MCC
is a specially prepared MMC (Multimedia Card). By plugging the MCC into
the MCC slot and then an overall reset the according memory expansion is
released. There may only one memory expansion be activated at the time.

On the MCC there is the file memory.key. This file may not be altered or
deleted. You may use the MCC also as "normal" MMC for storing your
project.

To extend the memory, plug the MCC into the card slot at the CPU labeled
with "MCC" and execute an overall reset.

CPU Overall reset

| @@ @i

RN
O
VR p memory is extended for the MCC memory
configuration (diagnostic entry 0xE400)

e,

If the memory expansion on the MCC exceeds the maximum extendable
memory range of the CPU, the maximum possible memory of the CPU is
automatically used.

You may determine the recent memory extension via the integrated web
page or with the Siemens SIMATIC Manager at Module Information -
"Memory".

Attention!

Please regard that the MCC must remain plugged when you’ve executed
the memory expansion at the CPU. Otherwise the CPU switches to STOP
after 72 hours. The MCC cannot be exchanged with a MCC of the same
memory configuration.

When the MCC memory configuration has been taken over you may find
the diagnosis entry O0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry OxE401 appears in the diagnostic buffer,
the SF-LED is on and after 72 hours the CPU switches to STOP. A reboot
is only possible after plugging-in the MCC again or after an overall reset.

The remaining time after pulling the MCC is always been shown with the
parameter MCC-Trial-Time on the web page.

After re-plugging the MCC, the SF-LED extinguishes and 0xE400 is
entered into the diagnostic buffer.

You may reset the memory configuration of your CPU to the initial status at
any time by executing an overall reset without MCC.
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Extended know-how protection

Overview

Standard protection

Extended protection

PC

Blocks

wid file | e

Protect blocks
with protect.wld

Besides the "standard" Know-how protection the SPEED7-CPUs from VIPA
provide an "extended" know-how protection that serves a secure block
protection for accesses of 3. persons.

The standard protection from Siemens transfers also protected blocks to
the PG but their content is not displayed. But with according manipulation
the Know-how protection is not guaranteed.

The "extended" know-how protection developed by VIPA offers the
opportunity to store blocks permanently in the CPU.

At the "extended" protection you transfer the protected blocks into a WLD-
file named protect.wld. By plugging the MMC and following overall reset,
the blocks in the protect.wld are permanently stored in the CPU.

You may protect OBs, FBs and FCs.

When back-reading the protected blocks into the PG, exclusively the block
header are loaded. The block code that is to be protected remains in the
CPU and cannot be read.

CPU OVERALL_RESET
Tip
ﬂ @k ® @l
RN
(=5
MR
e | MMC | ey _ ™ protected Blocks
are located in the CPU
protect.wld

Create a new wild-file in your project engineering tool with File > Memory
Card file > New and rename it to "protect.wld".

Transfer the according blocks into the file by dragging them with the mouse
from the project to the file window of protect.wid.
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Transfer

protect.wld to CPU

with overall reset

Protection
behavior

Change respectively
delete protected
blocks

Usage of
protected blocks

Transfer the file protect.wld to a MMC storage module, plug the MMC into
the CPU and execute an overall reset with the following approach:

@ ©) @

©

[ ]JPWR [ ]PWR [ ]JPWR [ [PWR
| |RUN | |RUN | |RUN | |RUN
N7 ] N7 —
—J [sToP 3 §ToP —J |sToP 3 sToP
71 T 71 T
| |SF | |SF | |SF | |SF
|_|FRCE |_|FRCE | |FRCE |_|FRCE
IRV a¥al Inaece [V Ta¥al IV Ta¥al
RUN RUN RUN RUN
sd foe  Bw JFow (B
MRES MRES MRES MRES
| 3 Sec. |

The overall reset stores the blocks in protect.wld permanently in the CPU
protected from accesses of 3. persons.

Protected blocks are overwritten by a new protect.wid.

Using a PG 3. persons may access protected blocks but only the block
header is transferred to the PG. The block code that is to be protected
remains in the CPU and cannot be read.

Protected blocks in the RAM of the CPU may be substituted at any time by
blocks with the same name. This change remains up to next overall reset.
Protected blocks may permanently be overwritten only if these are deleted
at the protect.wld before.

By transferring an empty protect.wld from the MMC you may delete all
protected blocks in the CPU.

Due to the fact that reading of a "protected" block from the CPU monitors
no symbol labels it is convenient to provide the "block covers" for the end
user.

For this, create a project out of all protected blocks. Delete all networks in
the blocks so that these only contain the variable definitions in the
according symbolism.
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MMC-Cmd - Auto commands

Overview

Command file

A command file at a MMC is automatically executed under the following
conditions:

e CPUisin STOP and MMC is stuck
» After each PowerON

The command file is a text file, which consists of a command sequence to
be stored as vipa_cmd.mmc in the root directory of the MMC.

The file has to be started by CMD_START as 1. command, followed by the
desired commands (no other text) and must be finished by CMD_END as
last command.

Text after the last command CMD_END e.g. comments is permissible,
because this is ignored. As soon as the command file is recognized and
executed each action is stored at the MMC in the log file lodfile.txt. In
addition for each executed command a diagnostics entry may be found in
the diagnostics buffer.

Commands Please regard the command sequence is to be started with CMD_START
and ended with CMD_END.
Command Description Diagnostics entry
CMD_START In the first line CMD_START is to be located. 0xE801
There is a diagnostic entry if CMD_START is missing OxE8BFE
WAIT1SECOND Waits ca. 1 second. 0xE803
WEBPAGE The current web page of the CPU is stored at the MMC 0xE804
as "webpage.htm".
LOAD PROJECT The function "Overall reset and reload from MMC" is 0xE805
executed. The wld file located after the command is
loaded else "s7prog.wld" is loaded.
SAVE_PROJECT The recent project (blocks and hardware configuration) 0xE806
is stored as "s7prog.wld" at the MMC.
If the file just exists it is renamed to "s7prog.old".
If your CPU is password protected so you have to add
this as parameter. Otherwise there is no project written.
Example: SAVE_PROJECT password
FACTORY RESET |Executes "factory reset". 0xE807
DIAGBUF The current diagnostics buffer of the CPU is stored as OxE80B
"diagbuff.txt" at the MMC.
SET_NETWORK IP parameters for Ethernet PG/OP channel may be set OxE8OE
by means of this command.
The IP parameters are to be given in the order IP
address, subnet mask and gateway in the format
XXX.XXX.XXX.XXX each separated by a comma.
Enter the IP address if there is no gateway used.
CMD_END In the last line CMD_END is to be located. 0xE802
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Examples

The structure of a command file is shown in the following. The

corresponding diagnostics entry is put in parenthesizes.

Example 1

CVD_START

LOAD PRQJIECT proj.w d
VWAl T1SECOND

VEBPAGE

DI AGBUF

CVD_END

arbitrary text

Example 2

CMD_START
LOAD_PRQJECT proj 2. W d
WAl T1SECOND

WAl T1SECOND

SET_NETWORK 172. 16. 129. 210, 255. 255. 224. 0, 172. 16. 129. 210

WAl T1SECOND
WAl T1SECOND
WEBPAGE
DI AGBUF
CMVD_END

arbitrary text

Note!

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj.wld" (OXE805)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (OXE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj2.wld" (OXE805)

Wait ca. 1s (OXE803)

Wait ca. 1s (OxE803)

IP parameter
(OXE8OE)
Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

The parameters IP address, subnet mask and gateway may be received
from the system administrator.

Enter the IP address if there is no gateway used.
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VIPA specific diagnostic entries

Entries in the
diagnostic buffer

Monitoring the
diagnostic entries

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC
Manager. Besides of the standard entries in the diagnostic buffer, the VIPA
CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored on MMC by means of
the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd -
Auto commands".

Note!

Every register of the module information is supported by the VIPA CPUs.
More information may be found at the online help of the Siemens SIMATIC
manager.

To monitor the diagnostic entries you choose the option PLC > Module
Information in the Siemens SIMATIC Manager. Via the register "Diagnostic
Buffer" you reach the diagnostic window:

D/Iodule information j

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Q Diagnostic Buff4r | ‘

Nr. Time of day Date Event
10 13:18:11:370 19.12.2011 Event-ID: 16# EOCC
1 ..

a e - - VIPA-ID

Details:

The diagnosis is independent from the operating mode of the CPU. You
may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
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Overview of the
Event-IDs

Event-ID | Description

OxE003 Error at access to I/O devices
Zinfo1: 1/O address
Zinfo2: Slot

0xEO004 | Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot

OxE005 Internal error - Please contact the VIPA-Hotline!

0OxEO006 Internal error - Please contact the VIPA-Hotline!

0xE007 | Configured in-/output bytes do not fit into I/O area

0OxEO008 Internal error - Please contact the VIPA-Hotline!

0xE009 | Error at access to standard back plane bus

0xEO010 | Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration

0xEOQ12 | Error at parameterization

O0xE013 | Error at shift register access to standard bus digital modules

0xEO014 | Error at Check Sys

0xEO015 | Error at access to the master
Zinfo2: Slot of the master (32=page frame master)

OxEO16 Maximum block size at master transfer exceeded
Zinfo1: 1/O address
Zinfo2: Slot

0xEQ17 | Error at access to integrated slave

0xE018 | Error at mapping of the master periphery

0xEO019 | Error at standard back plane bus system recognition

OXEOQ1A | Error at recognition of the operating mode (8 / 9 Bit)

0xEQ1B | Error - maximum number of plug-in modules exceeded

0xEQ20 | Error - interrupt information is not defined

0OxEO030 Error of the standard bus

0OxE033 Internal error - Please contact the VIPA-Hotline!

0xEOBO | SPEED?Y is not stoppable (probably undefined BCD value at timer)

0xEOCO | Not enough space in work memory for storing code block (block size exceeded)

OxEOCC | Communication error MPI / Serial
Zinfo1: Code

1: Wrong Priority

2: Buffer overflow

3: Frame format error

7: Incorrect value

8: Incorrect RetVal

9: Incorrect SAP

10: Incorrect connection type

11: Incorrect sequence number

12: Faulty block number in the telegram
13: Faulty block type in the telegram
14: Inactive function

15: Incorrect size in the telegram
20: Error writing to MMC

90: Incorrect Buffer size

98: Unknown error

99: Internal error
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Event-ID | Description
OxEQOCD | Error at DPV1 job management
OxEOQOCE | Error: Timeout at sending of the i-slave diagnostics
0xE100 | MMC access error
0xE101 MMC error file system
0xE102 | MMC error FAT
0xE104 | MMC error at saving
0xE200 | MMC writing finished (Copy Ram2Rom)
0xE210 | MMC reading finished (reload after overall reset)
0xE21F | MMC reading: error at reload (after overall reset), read error, out of memory
0xE300 | Internal flash writing finished (Copy Ram2Rom)
0xE310 |Internal flash writing finished (reload after battery failure)
0xE400 | Memory expansion MCC has been plugged
0xE401 Memory expansion MCC has been removed
0xE801 MMC-Cmd: CMD_START recognized and successfully executed
0xE802 | MMC-Cmd: CMD_END recognized and successfully executed
0xE803 | MMC-Cmd: WAIT1SECOND recognized and successfully executed
0xE804 | MMC-Cmd: WEBPAGE recognized and successfully executed
0xE805 |MMC-Cmd: LOAD PROJECT recognized and successfully executed
0xE806 | MMC-Cmd: SAVE_PROJECT recognized and successfully executed
0xE807 |MMC-Cmd: FACTORY_RESET recognized and successfully executed
0xE80B | MMC-Cmd: DIAGBUF recognized and successfully executed
OxE8O0E |MMC-Cmd: SET _NETWORK recognized and successfully executed
OxE8FB | MMC-Cmd: Error: Initialization error of the Ethernet-PG/OP channel by means of
SET_NETWORK.
OxE8FC | MMC-Cmd: Error: Some IP parameters are missing in SET NETWORK.
OxE8FE | MMC-Cmd: Error: CMD_START is missing
OXE8FF | MMC-Cmd: Error: Error while reading CMD file (MMC error)
0xE901 Check sum error
OxEAQQ |Internal error - Please contact the VIPA-Hotline!
OxEAO01 Internal error - Please contact the VIPA-Hotline!
OxEAO02 | SBUS: Internal error (internal plugged sub module not recognized)
Zinfo1: Internal slot
OxEAO03 | SBUS: Communication error CPU - PROFINET-IO-Controller
Zinfo1: Slot
Zinfo2: Status (0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN)
OxEAO04 | SBUS: Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OXEAO05 |Internal error - Please contact the VIPA-Hotline!
OxEAQ7 |Internal error - Please contact the VIPA-Hotline!
OxEA08 | SBUS: Parameterized input data width unequal to plugged input data width
Zinfo1: Parameterized input data width
Zinfo2: Slot
Zinfo3: Input data width of the plugged module
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Event-ID | Description
OxEAQ9 |SBUS: Parameterized output data width unequal to plugged output data width
Zinfo1: Parameterized output data width
Zinfo2: Slot
Zinfo3: Output data width of the plugged module
OxEA10 | SBUS: Input address outside input area
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA11 | SBUS: Output address outside output area
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA12 | SBUS: Error at writing record set
Zinfo1: Slot
Zinfo2: Record set number
Zinfo3: Record set length
OxEA14 | SBUS: Multiple parameterization of a I/O address (Diagnostic address)
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA15 |Internal error - Please contact the VIPA-Hotline!
OxEA18 | SBUS: Error at mapping of the master I/O devices
Zinfo2: Master slot
OxEA19 |Internal error - Please contact the VIPA-Hotline!
OXEA20 |Error - RS485 interface is not set to PROFIBUS DP master but there is a
PROFIBUS DP master configured.
OxEA21 | Error - Project engineering RS485 interface X2/X3:
PROFIBUS DP master is configured but missing
Zinfo2: Interface x
OxEA22 | Error - RS485 interface X2 - value is out of range
Zinfo: Configured value X2
OxEA23 |Error - RS485 interface X3 - value is out of range
Zinfo: Configured value X3
OxEA24 | Error - Project engineering RS485 interface X2/X3:
Interface/Protocol is missing, the default settings are used.
Zinfo2: Configured value X2
Zinfo3: Configured value X3
OxEA30 |Internal error - Please contact the VIPA-Hotline!
OxEA40 |Internal error - Please contact the VIPA-Hotline!
OxEA41 Internal error - Please contact the VIPA-Hotline!
OxEA50 |Error - PROFINET configuration
Zinfo1: User slot of the PROFINET IO controller
Zinfo2: 10 device number
Zinfo3: 10 device slot
OXEAS51 | Error - there is no PROFINET 10 controller at the configured slot
Zinfo1: User slot of the PROFINET IO controller
Zinfo2: Recognized ID at the configured slot
OxEA54 |Error - PROFINET IO controller reports multiple configuration at one peripheral addr.

Zinfo1: Peripheral address
Zinfo2: User slot of the PROFINET IO controller
Zinfo3: Data width
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Event-ID | Description

OxEA64 |PROFINET configuration error:
Zinfo1: error word

Bit 0: too many IO devices

Bit 1: too many 10 devices per ms

Bit 2: too many input bytes per ms

Bit 3: too many output bytes per ms

Bit 4: too many input bytes per device

Bit 5: too many output bytes per device

Bit 6: too many productive connections

Bit 7: too many input bytes in the process image
Bit 8: too many output bytes in the process image
Bit 9: Configuration not available

Bit 10: Configuration not valid

OxEA65 | Communication error CPU - PROFINET-IO-Controller
Pk : CPU or PROFINET-IO-Controller

Zinfo1: Service ID, with which the error arose

Zinfo2: Command, with which the error arose

OxEA66 Internal error - Please contact the VIPA-Hotline!

OxEA67 |Error - PROFINET-IO-Controller - reading record set
Pk: Error type

0: DATA_ RECORD _ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_ RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA68 |Error - PROFINET-IO-Controller - writing record set
Pk: Error type

0: DATA_ RECORD_ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_ RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA97 | Storage error SBUS service channel
Zinfo3 = Slot

OxEA98 | Timeout at waiting for reboot of a SBUS module (Server)

OxEA99 |Error at file reading via SBUS

OxEEOO |Additional information at UNDEF_OPCODE

OxEEEE | CPU was completely overall reset, since after PowerON the start-up could not be
finished.

OxEFFF Internal error - Please contact the VIPA-Hotline!
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Using test functions for control and monitoring of variables

Overview

Debug > Monitor

For troubleshooting purposes and to display the status of certain variables
you can access certain test functions via the menu item Debug of the
Siemens SIMATIC Manager.

The status of the operands and the VKE can be displayed by means of the
test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test
function PLC > Monitor/Modify Variables.

This test function displays the current status and the VKE of the different
operands while the program is being executed.

It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump
commands or by timer and process-related alarms. At the breakpoint the
CPU stops collecting data for the status display and instead of the required
data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value
displayed during program execution remaining at 0 for the items below:

+ the result of the logical operation VKE

» Status / AKKU 1

+ AKKU 2

» Condition byte

* absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the
execution of the program. It only shows that the data displayed is no longer.
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PLC >
Monitor/Modify
Variables

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program-
execution.

This information is obtained from the process image of the selected
operands. During the "processing check" or in operating mode STOP the
periphery is read directly from the inputs. Otherwise only the process image
of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules.

You can set outputs to any desired status with or without a control program.
The process image is not modified but outputs are no longer inhibited.

Control of variables
The following variables may be modified:
,Q, M, T,CandD.

The process image of binary and digital operands is modified independently
of the operating mode of the CPU.
When the operating mode is RUN the program is executed with the

modified process variable. When the program continues they may,
however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence
of the program.
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Chapter 5

Overview

Content

Deployment PtP communication

Content of this chapter is the deployment of the RS485 interface for serial
PtP communication.

Here you'll find every information about the protocols, the activation and
project engineering of the interface, which are necessary for the serial
communication using the RS485 interface.

Topic Page
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Fast introduction...........ooooiiiii i 5-2
Principle of the data transfer ... 5-3
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Fast introduction

General

Protocols

Switch of RS485

for ptp operation

Parameterization

Communication

Overview SFCs
for serial
communication

Via a hardware configuration you may de-activate the PROFIBUS part
integrated to the SPEED7 CPU and thus release the RS485 interface for
PtP (point-to-point) communication.

The RS485 interface supports in PtP operation the serial process
connection to different source res. destination systems.

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus
are supported.

Per default, every CPU uses the RS485 interface for PROFIBUS
communication. A hardware configuration allows you to switch the RS485
interface to point-to-point operation using Object properties and the
parameter "Function RS485".

The parameterization of the serial interface happens during runtime using
the SFC 216 (SER_CFG). For this you have to store the parameters in a
DB for all protocols except ASCII.

The SFCs are controlling the communication. Send takes place via
SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).

The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus allow to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

The SFCs are included in the consignment of the CPU.

The following SFCs are used for the serial communication:

SFC Description
SFC 216 SER _CFG RS485 parameterize
SFC 217 SER_SND RS485 send
SFC 218 SER _RCV RS485 receive

5-2
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Principle of the data transfer

Overview

Principle

The data transfer is handled during runtime by using SFCs. The principle of
data transfer is the same for all protocols and is shortly illustrated in the
following.

Data, which are written into the according data channel by the PLC, is
stored in a FIFO send buffer (first in first out) with a size of 2x1024byte
and then put out via the interface.

When the interface receives data, this is stored in a FIFO receive buffer
with a size of 2x1024byte and can there be read by the PLC.

If the data is transferred via a protocol, the adoption of the data to the
according protocol happens automatically.

In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus
require the acknowledgement of the partner.

An additional call of the SFC 217 SER_SND causes a return value in
RetVal that includes among others recent information about the
acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement
telegram must be evaluated by call of the SFC 218 SER_RCV.

RS485 PtP communication

Program

SER_RCV
SFC 218

SER_CFG
SFC 216

SER_SND
SFC 217

Protocol FIFO Buffer Interface
IN RS485
< RECEIVE A 1024Byte
1024Byte 4———
CFG ouT A

A 1024Byte| —»

—»| | 1024Byte
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Deployment of RS485 interface for PtP

Switch to PtP
operation

Requirements

Installation of the
SPEEDBUS.GSD

Per default, the RS485 interface X3 of the CPU is used for the PROFIBUS
DP master. Via hardware configuration the RS485 interfaces may be
switched to point-to-point communication via the Parameter Function
RS485 X3 of the Properties.

For this a hardware configuration of the CPU is required, which is
described below.

Since the VIPA specific CPU parameters may be set, the installation of the
SPEEDBUS.GSD from VIPA in the hardware catalog is necessary.

The CPU may be configured in a PROFIBUS master system and the
appropriate parameters may be set after installation.

The GSD (Gerate-Stamm-Datei) is online available in the following
language versions. Further language versions are available on inquires.

Name Language
SPEEDBUS.GSD german (default)
SPEEDBUS.GSG german
SPEEDBUS.GSE english

The GSD files may be found at www.vipa.de at the "Service" part.

The integration of the SPEEDBUS.GSD takes place with the following
proceeding:

« Browse to www.vipa.de.
» Click to Service > Download > GSD- and EDS-Files > PROFIBUS.
» Download the file Cx000023_Vxxx.

» Extract the file to your work directory. The SPEEDBUS.GSD is stored in
the directory VIPA_System_300S.

+ Start the hardware configurator from Siemens.
» Close every project.
» Select Options > Install new GSD-file.

 Navigate to the directory VIPA_System_300S and select
SPEEDBUS.GSD.
The SPEED7 CPUs and modules of the System 300S from VIPA may now

be found in the hardware catalog at PROFIBUS-DP / Additional field
devices / /0 / VIPA_SPEEDBUS.
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The embedding of the CPU 315-4NE12 happens by means of a virtual

PROFIBUS master system with the following approach:

Proceeding
Slot | Module
1
2 CPU ...
X2
X1
3

Modules at the bus

343-1EX11
Ethernet-PG/OP

343-1EX11
(interner CP)

always as last module
342-5DA02 V5.0

virtual DP-Master for CPU

(100) VIPA | ~p| -

| fTETT“wE “Addr.:100
111

v
VIPA_SPEEDbus

[Slot  [Order No.

[0 [315-4NE12 315SN/NE

\

Object properties

* Perform a hardware configuration for the CPU (see
"Hardware configuration - CPU".

» Configure always as last module a Siemens DP master
CP 342-5 (342-5DA02 V5.0). Connect and parameterize
it at operation mode "DP-Master".

» Connect the slave system "VIPA_SPEEDbus". After
installing the SPEEDBUS.GSD this may be found in the
hardware catalog at PROFIBUS-DP / Additional field
devices / 1/0 / VIPA / VIPA_SPEEDBUS.

» For the slave system set the PROFIBUS address 100.

» Configure at slot 0 the VIPA CPU 315-4NE12 of the
hardware catalog from VIPA_SPEEDbus.

By double clicking the placed CPU 315-4NE12 the
properties dialog of the CPU may be opened.

As soon as the project is transferred together with the PLC
user program to the CPU, the parameters will be taken after
start-up.

Setting PtP » By double clicking the CPU 315-4NE12 placed in the slave system the

parameters

properties dialog of the CPU may be opened.

+ Switch the Parameter Function RS485 X3 to "PtP".
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Properties RS485

Connection

RS485

Connection

of a twisted pair cable
» Serial bus connection in two-wire technology using half duplex mode
» Data communications up to a max. distance of 500m
» Data communication rate up to 115.2kbaud

9polige SubD-Buchse

Logical states represented by voltage differences between the two cores

Pin | RS485
1 |n.c.
2 |M24V
3 |RxD/TxD-P (Line B)
4 |RTS
5 | M5V
6 |P5V
7 | P24V
8 |RxD/TxD-N (Line A)
9 |n.c.
CPU - RS485 Periphery
RxD/TxD-P (B) 3 RxD/TxD-P (B)
RxD/TxD-N (A) 8 RxD/TxD-N (A)
shield J_
) Periphery
J_ RxD/TxD-P (B)
RxD/TxD-N (A)
o l
. 1
Periphery
RxD/TxD-P (B)
RxD/TxD-N (A)

5-6
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Parameterization

SFC 216 The parameterization happens during runtime deploying the SFC 216
(SER_CFGQG) (SER_CFGQG). You have to store the parameters for STX/ETX, 3964R, USS
and Modbus in a DB.
Name Declaration | Type Comment
Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R
Parameter IN ANY Pointer to protocol parameters
Baudrate IN BYTE Velocity of data transfer
CharLen IN BYTE 0=5bit, 1=6bit, 2=7bit, 3=8bit
Parity IN BYTE 0=None, 1=0dd, 2=Even
StopBits IN BYTE 1=1bit, 2=1.5bit, 3=2bit
FlowControl |IN BYTE 1 (fix)
RetVal ouT WORD Error Code (0 = OK)
Parameter All time settings for timeouts must be set as hexadecimal value. Find the
description Hex value by multiply the wanted time in seconds with the baudrate.
Example: Wanted time 8ms at a baudrate of 19200baud
Calculation: 19200bit/s x 0.008s = 154bit — (9Ah)
Hex value is 9Ah.
Protocol Here you fix the protocol to be used. You may choose between:

1: ASCII

2: STX/ETX

3: 3964R

4: USS Master

5: Modbus RTU Master
6: Modbus ASCII Master
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Parameter (as DB)

Baud rate

CharlLen

At ASCII protocol, this parameter is ignored.

At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the
communication parameters and has the following structure for the
according protocols:

Data block at STX/ETX

DBB0: STX1 BYTE (1. Start-ID in hexadecimal)
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)
DBB3: ETX2 BYTE (2. End-ID in hexadecimal)

DBW4: TIMEOUT WORD (max. delay time between 2 telegrams)

Note!

The start res. end sign should always be a value <20, otherwise the sign is
ignored!

Data block at 3964R

DBBO0: Prio BYTE (The priority of both partners must be
different)

DBB1: ConnAttmptNr BYTE (Number of connection trials)
DBB2: SendAttmptNr BYTE (Number of telegram retries)
DBW4: CharTimeout WORD (Character delay time)
DBW6: ConfTimeout WORD (Acknowledgement delay time)

Data block at USS
DBWO: Timeout WORD (Delay time in)

Data block at Modbus-Master
DBWO: Timeout WORD (Respond delay time)

Velocity of data transfer in bit/s (baud).

04h: 1200baud  05h: 1800baud 06h: 2400baud 07h: 4800baud
08h: 7200baud  09h: 9600baud OAh: 14400baud OBh: 19200baud
0Ch: 38400baud 0Dh: 57600baud OEh: 115200baud

Number of data bits where a character is mapped to.
0: 5bit 1: 6bit  2: 7bit 3: 8bit

5-8
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Parity The parity is -depending on the value- even or odd. For parity control, the
information bits are extended with the parity bit that amends via its value
("0" or "1") the value of all bits to a defined status. If no parity is set, the
parity bit is set to "1", but not evaluated.

0: NONE 1:0DD 2: EVEN

StopBits The stop bits are set at the end of each transferred character and mark the
end of a character.

1: 1bit 2:1.5bit  3: 2bit

FlowControl The parameter FlowControl is ignored. When sending RTS=1, when
receiving RTS=0.

RetVval SFC 216 Return values sent by the block:
(Error message
SER_CFG) Error code | Description

0000h no error

809Ah Interface is not available or
interface is used for PROFIBUS

8x24h Error at SFC-Parameter x, with x:

Error at "Protocol"

Error at "Parameter”

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

. Error at "FlowControl"

809xh Error in SFC parameter value x, where x:
Error at "Protocol"

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

Error at "FlowControl"

8092h Access error in parameter DB (DB too short)
828xh Error in parameter x of DB parameter, where x:
1: Error 1. parameter

2: Error 2. parameter

Nk w2

N ahw
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Communication

Overview The communication happens via the send and receive blocks SFC 217
(SER_SND) and SFC 218 (SER_RCV).

The SFCs are included in the consignment of the CPU.

SFC 217 This block sends data via the serial interface.

(SER_SND) The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for sending data

DataLen ouT WORD Length of data sent

RetVal ouT WORD Error Code (0 =0K)

DataPtr Here you define a range of the type Pointer for the send buffer where the
data that has to be sent is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of

124byte.
DataPtr:=P#DB5.DBX0.0 BYTE 124

Datalen Word where the number of the sent bytes is stored.
At ASCII if data were sent by means of SFC 217 faster to the serial
interface than the interface sends, the length of data to send could differ
from the DatalLen due to a buffer overflow. This should be considered by
the user program.
With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr
is stored or O.
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RetVal SFC 217
(Error message
SER_SND)

Protocol specific
RetVal values

Return values of the block:

Error code | Description
0000h Send data - ready
1000h Nothing sent (data length 0)
20xxh Protocol executed error free with xx bit pattern for
diagnosis
7001h Data is stored in internal buffer - active (busy)
7002h Transfer - active
80xxh Protocol executed with errors with xx bit pattern for
diagnosis (no acknowledgement by partner)
90xxh Protocol not executed with xx bit pattern for diagnosis (no
acknowledgement by partner)
8x24h Error in SFC parameter x, where x:
1: Error in "DataPtr"
2: Error in "DataLen”
8122h Error in parameter "DataPtr" (e.g. DB too short)
807Fh Internal error
809Ah Interface not found or interface is used for PROFIBUS
809Bh Interface not configured
ASCII
Value Description
9000h Buffer overflow (no data send)
9002h Data too short (Obyte)
STX/ETX
Value Description
9000h Buffer overflow (no data send)
9001h Data too long (>1024byte)
9002h Data too short (Obyte)
9004h Character not allowed
3964R
Value Description
2000h Send ready without error
80FFh NAK received - error in communication
80FEh Data transfer without acknowledgement of partner or error
at acknowledgement
9000h Buffer overflow (no data send)
9001h Data too long (>1024byte)
9002h Data too short (Obyte)
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... Continue USS
RetVal SFC 217 Error code | Description
SER_SND 2000h Send ready without error

8080h Receive buffer overflow (no space for receipt)
8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FEh Wrong start sign in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024byte)

9002h Data too short (<2byte)

Modbus RTU/ASCII Master
Error code | Description
2000h Send ready without error
2001h Send ready with error
8080h Receive buffer overflow (no space for receipt)
8090h Acknowledgement delay time exceeded
80F0Oh Wrong checksum in respond
80FDh Length of respond too long
80FEh Wrong function code in respond
80FFh Wrong slave address in respond
9000h Buffer overflow (no data send)
9001h Data too long (>1024byte)
9002h Data too short (<2byte)
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Principles of The following text shortly illustrates the structure of programming a send
programming command for the different protocols.
3964R USS / Modbus

SFC 217
SER_SND

SFC 217
SER_SND

N

N

RetVal 8xah | etVal 8xxxh J
90xxh ? v 90xxh ?
N

N

SFC 218
SER_RCV

Error evaluation

Error evaluation

Retval 2001h ? >J—— RetVal 2001h ? >J
N N

SFC 218
RetVal 2000h 2> RetVal 2000h ? 2J SER_RCV
N l

N
Data evaluation Data evaluation

ASCII / STX/IETX

SFC 217
SER_SND

RetVal 900xh J
NL Error evaluation
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SFC 218 This block receives data via the serial interface.

(SER_RCV) Using the SFC 218 SER_RCYV after SER_SND with the protocols USS and
Modbus the acknowledgement telegram can be read.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for received data

DatalLen ouT WORD Length of received data

Error ouT WORD Error Number

RetVal ouT WORD Error Code (0 =0K)

DataPtr Here you set a range of the type Pointer for the receive buffer where the
reception data is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of 124byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

Datalen Word where the number of received Bytes is stored.
At STX/ETX and 3964R, the length of the received user data or O is
entered.
At ASCII, the number of read characters is entered. This value may be
different from the read telegram length.

Error This word gets an entry in case of an error. The following error messages

may be created depending on the protocol:

ASCII
Bit | Error Description
0 |overrun Overflow, a sign couldn’t be read fast enough from the

interface

1 |framing error |Error that shows that a defined bit frame is not
coincident, exceeds the allowed length or contains an
additional Bit sequence (Stopbit error)

2 | parity Parity error
3 |overflow Buffer is full
STX/ETX
Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
1 |char A sign outside the range 20h...7Fh has been received.
3 |overflow Buffer is full

3964R / Modbus RTU/ASCII Master

Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.

5-14
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RetVal SFC 218
(Error message

Return values of the block:

SER_RCV)

Error code | Description
0000h no error
1000h Receive buffer too small (data loss)
8x24h Error at SFC-Parameter x, with x:
1: Error at "DataPtr"
2: Error at "DatalLen"
3: Error at "Error"
8122h Error in parameter "DataPtr" (e.g. DB too short)
809Ah Serial interface not found res. interface is used by
PROFIBUS
809Bh Serial interface not configured

Principles of
programming

N

RetVal 8xo¢h ?

@

Data evaluation

Error evaluation

The following picture shows the basic structure for programming a receive
command. This structure can be used for all protocols.

SFC 218
SER_RCV

RetVal 0000h ?

HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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Protocols and procedures

Overview

ASCII

STX/ETX

The CPU supports the following protocols and procedures:
» ASCII communication

o STX/ETX

* 3964R

+ USS

* Modbus

ASCII data communication is one of the simple forms of data exchange.
Incoming characters are transferred 1 to 1.

At ASCII, with every cycle the read-SFC is used to store the data that is in
the buffer at request time in a parameterized receive data block. If a
telegram is spread over various cycles, the data is overwritten. There is no
reception acknowledgement. The communication procedure has to be
controlled by the concerning user application. An according Receive_ASCI|
FB may be found within the VIPA library in the service area of www.vipa.de.

STX/ETX is a simple protocol with start and end ID, where STX stands for
Start of Text and ETX for End of Text.

The STX/ETX procedure is suitable for the transfer of ASCII characters. It
does not use block checks (BCC). Any data transferred from the periphery
must be preceded by a Start followed by the data characters and the end
character.

Depending of the byte width the following ASCIl characters can be
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh.

The effective data, which includes all the characters between Start and End
are transferred to the PLC when the End has been received.

When data is send from the PLC to a peripheral device, any user data is
handed to the SFC 217 (SER_SND) and is transferred with added Start-
and End-ID to the communication partner.

Message structure:
STX1 — STX2 —1 Z21 — 2Z2 Zn — ETX1 — ETX2 —

—>ZVZ<—

You may define up to 2 Start- and End-IDs.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start-
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters
above 1Fh are ignored. In the user data, characters below 20h are not
allowed and may cause errors. The number of Start- and End-IDs may be
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not
used start and end characters you have to enter FFh in the hardware
configuration. If no End-ID is defined, all read characters are transferred to
the PLC after a parameterizable character delay time (Timeout).

5-16
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3964R

Procedure

The 3964R procedure controls the data transfer of a point-to-point link
between the CPU and a communication partner. The procedure adds
control characters to the message data during data transfer. These control
characters may be used by the communication partner to verify the
complete and error free receipt.

The procedure employs the following control characters:

« STX Start of Text

« DLE Data Link Escape

« ETX End of Text

« BCC Block Check Character
* NAK Negative Acknowledge

Active partner Passive partner

STX _>

Monitor delayed acknowledgment

<4—— DLE
Message-data —_—
DLE —mnonwp
ETX e

BCC

Monitor delayed acknowledgment

You may transfer a maximum of 255byte per message.

Note!

When a DLE is transferred as part of the information it is repeated to
distinguish between data characters and DLE control characters that are
used to establish and to terminate the connection (DLE duplication). The
DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the
communication partner. When communication partners issue simultaneous
send commands, the station with the lower priority will delay its send
command.
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USS

Broadcast with set bit 5

in ADR-Byte

7 6 5 4 3 2

1

0

The USS protocol (Universelle serielle Schnittstelle = universal serial
interface) is a serial transfer protocol defined by Siemens for the drive and
system components. This allows to build-up a serial bus connection
between a superordinated master and several slave systems.

The USS protocol enables a time cyclic telegram traffic by presetting a fix
telegram length.

The following features characterize the USS protocol:

* Multi point connection

» Master-Slave access procedure

» Single-Master-System

* Max. 32 participants

» Simple and secure telegram frame

You may connect 1 master and max. 31 slaves at the bus where the single
slaves are addressed by the master via an address sign in the telegram.
The communication happens exclusively in half-duplex operation.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

Master-Slave telegram

[ [1] |

[
Broadcast

STX|LGE | ADR PKE IND PWE STW HSW BCC
02h HIL[IH]JLIHJL][H]JLJIHI[L
Slave-Master telegram
STX|LGE | ADR PKE IND PWE ZSW HIW BCC
02h HIL[IH]JLIHJL][H]JLJIHI[L
where STX: Start sign STW: Control word
LGE: Telegram length ZSW: State word
ADR: Address HSW: Main set value
PKE: Parameter ID HIW: Main effective value
IND: Index BCC: Block Check Character
PWE: Parameter value

A request can be directed to a certain slave ore be send to all slaves as
broadcast message. For the identification of a broadcast message you
have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit O ... 4) is
ignored. In opposite to a "normal" send command, the broadcast does not
require a telegram evaluation via SFC 218 SER_RCV. Only write
commands may be sent as broadcast.

5-18
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Modbus

Broadcast with
slave address = 0

ASCIIl, RTU mode

Supported Modbus
protocols

The Modbus protocol is a communication protocol that fixes a hierarchic
structure with one master and several slaves.

Physically, Modbus works with a serial half-duplex connection.

There are no bus conflicts occurring, because the master can only
communicate with one slave at a time. After a request from the master, this
waits for a preset delay time for an answer of the slave. During the delay
time, communication with other slaves is not possible.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The request telegrams send by the master and the respond telegrams of a
slave have the following structure:

Start Slave Function Data Flow End
sign address |Code control |sign

A request can be directed to a special slave or at all slaves as broadcast
message. To mark a broadcast message, the slave address 0 is used.

In opposite to a "normal" send command, the broadcast does not require a
telegram evaluation via SFC 218 SER_RCV.

Only write commands may be sent as broadcast.

Modbus offers 2 different transfer modes:

» ASCIlI mode: Every byte is transferred in the 2 sign ASCII code. The
data are marked with a start and an end sign. This causes a transparent
but slow transfer.

* RTU mode: Every byte is transferred as one character. This enables a
higher data pass through as the ASCII mode. Instead of start and end
sign, a time control is used.

The mode selection happens during runtime by using the SFC 216 SER_CFG.

The following Modbus Protocols are supported by the RS485 interface
* Modbus RTU Master
* Modbus ASCII Master
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Modbus - Function codes

Naming
convention

Range definitions

Modbus has some naming conventions:

Bit = IN: "Input Status"
Coil OUT: "Coil Status"

Word = | IN: "Input Register"
Register | OUT: "Holding Register"

* Modbus differentiates between bit and word access;
Bits = "Coils" and Words = "Register".

» Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-
Status".

* Word inputs are referred to as "Input-Register" and Word outputs as
"Holding-Register".

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x
and 4x.

Ox and 1x gives you access to digital Bit areas and 3x and 4x to analog
word areas.

For the CPs from VIPA is not differentiating digital and analog data, the
following assignment is valid:

Ox: Bit area for master output data
Access via function code 01h, 05h, OFh

1x: Bit area for master input data
Access via function code 02h

3x:  Word area for master input data
Access via function code 04h

4x: Word area for master output data
Access via function code 03h, 06h, 10h

1x0001

1x0002 1x0022
1x0003
NN NN EEEEEEEREE EEEEEEEEEEEEEEEE
3x0001 3x0002 3x0003
0x0001
0x0002 0x0022
0x0003
OUT [T I T T E I I I
4x0001 4x0002 4x0003

A description of the function codes follows below.

5-20
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Overview

Point of View of
"Input" and
"Output" data

With the following Modbus function codes a Modbus master can access a
Modbus slave: With the following Modbus function codes a Modbus master
can access a Modbus slave. The description always takes place from the
point of view of the master:

Code |Command
01h Read n Bits
02h Read n Bits
03h Read n Words
04h Read n Words
05h Write 1 Bit
06h Write 1 Word
OFh Write n Bits
10h Write n Words

Description

Read n Bits of master output area 0x
Read n Bits of master input area 1x
Read n Words of master output area 4x
Read n Words master input area 3x
Write 1 Bit to master output area 0x
Write 1 Word to master output area 4x
Write n Bits to master output area 0x
Write n Words to master output area 4x

The description always takes place from the point of view of the master.
Here data, which were sent from master to slave, up to their target are
designated as "output" data (OUT) and contrary slave data received by the
master were designated as "input" data (IN).

System 200V - Slave Periphery
PtP ‘ CPU
System 300S - Master
CPU PtP ouT
write (05h,0F :bit, 06h10h:word) > Ox(bit) » RECEIVE FC1 ouT » ouT
ouT read (01h:bit, 03h:word) 4x(word)
IN
IN read (02h:bit, 04h:word) 1x(bit) < SEND FCO IN €—— IN
3x(wort)

Respond of the
slave

Byte sequence
in a Word

Check sum CRC,
RTU, LRC

If the slave announces an error, the function code is send back with an
"ORed" 80h. Without an error, the function code is sent back.

Function code OR 80h
Function code

— Error
- OK

Slave answer:

1 Word

High Low
Byte Byte

For the Byte sequence in a Word is always valid:

The shown check sums CRC at RTU and LRC at ASCIl mode are
automatically added to every telegram. They are not shown in the data
block.
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Read n Bits Code 01h: Read n Bits of master output area 0x
01h, 02h Code 02h: Read n Bits of master input area 1x

Command telegram

Slave address | Function code Address Number of Check sum
1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Respond telegram

Slave address | Function code Number of Data Data Check sum
read Bytes 1. Byte 2. Byte CRC/LRC
1Byte 1Byte 1Byte 1Byte 1Byte 1Word
max. 250Byte

Read n Words 03h: Read n Words of master output area 4x
03h, 04h 04h: Read n Words master input area 3x

Command telegram

Slave address | Function code Address Number of Check sum
1. Bit Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Respond telegram

Slave address | Function code Number of Data Data Check sum
read Bytes 1. Word 2. Word CRC/LRC
1Byte 1Byte 1Byte 1Word 1Word 1Word
max. 125 Words

Write 1 Bit Code 05h: Write 1 Bit to master output area Ox
05h A status change is via "Status Bit" with following values:

"Status Bit" = 0000h - Bit=0
"Status Bit" = FFOOh - Bit =1

Command telegram

Slave address Function Address Status Check sum
code Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Respond telegram

Slave address Function Address Status Check sum
code Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Write 1 Word
06h

Code 06h: Write 1 Word to master output area 4x

Command telegram

Write n Bits OFh

Command telegram

Code OFh: Write n Bits to master output area 0x
Please regard that the number of Bits has additionally to be set in Byte.

Slave address Function Address Value Check sum
code word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address Function Address Value Check sum
code word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Slave address | Function Address Number of Number of Data Data Check sum
code 1. Bit Bits Bytes 1.Byte | 2. Byte CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word
max. 250 Byte
Respond telegram
Slave address | Function Address Number of | Check sum
code 1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Write n Words 10h  Code 10h: Write n Words to master output area 4x
Command telegram
Slave address | Function Address Number of Number of Data Data Check sum
code 1. Word words Bytes 1. Word | 2. Word CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word
max. 125 Words
Respond telegram
Slave address | Function | Address Number of Check sum
code 1. Word Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Modbus - Example communication

Overview

Components

Approach

The example establishes a communication between a master and a slave
via Modbus. The following combination options are shown:

CPU 31xS

Modbus master (M) Modbus slave (S)

CPU 21xSER-1

The following components are required for this example:

CPU 31xS as Modbus RTU master

CPU 21xSER-1 as Modbus RTU slave

Siemens SIMATIC Manager and possibilities for the project transfer
Modbus cable connection

Assemble a Modbus system consisting of a CPU 31xS as Modbus
master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

Execute the project engineering of the master!
For this you create a PLC user application with the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU master) with
timeout setting and error evaluation.

Call SFC 217 (SER_SND) where the data is send with error
evaluation. Here you have to build up the telegram according
to the Modbus rules.

Call SFC 218 (SER_RECV) where the data is received with
error evaluation.

Execute the project engineering of the slave!
The PLC user application at the slave has the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU slave) with
timeout setting and Modbus address in the DB and error
evaluation.

Call SFC 217 (SER_SND) for data transport from the slave
CPU to the output buffer.

Call SFC 218 (SER_RECV) for the data transport from the
input buffer to the CPU. Allow an according error evaluation
for both directions.

The following page shows the structure for the according PLC programs for
master and slave.
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Master

CPU 31xS

Slave

CPU 21xSER-1
CPU

Slave ‘

— SER_RCV

L —» RetVal

<— SER_SND

CPU ‘ Master
| SER SND | code/data
|
| SERRCV < = T
]
:
\ code !
| SER_SND | '
]
| SER RCV @ —

0OB100:

SFC 216
SER_CFG
(DB: Timeout)

OB1: le

SFC 217
SER_SND

(mit Slave-Nr., Code,

Bereich)

RetVal 700xh?

N

;

N

RetVal 2001h ? >-J

N

RetVal 2000h 2 >J— SSEFRC 11 08v

etVal 8xxxh -

N
RetVal 0000h ? >J
J “
J
N
L

SER_SND
RetVal 2001h

N- Data evaluation

it

L]

L —» RetVal

SFC 216

SER_CFG

(DB: Timeout, slave address)

N

SFC 217
SER_SND

N

v

RetVal 0000h ? >J—

N

SFC 218
SER_RCV

RetVal 0000h ? >J Data evaluation

N

N

L
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Chapter 6 Deployment PROFIBUS communication

Overview Content of this chapter is the deployment of the CPU 315-4NE12 with
PROFIBUS. After a short overview the project engineering and parameteri-
zation of a CPU 315-4NE12 with integrated PROFIBUS-Part from VIPA is
shown.

Further you get information about usage as DP master and DP slave of the
PROFIBUS part.

The chapter is ending with notes to Commissioning and Start-up behavior.

Content Topic Page
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Overview

PROFIBUS DP

CPU with
DP master

Deployment of the
DP-Master with
CPU

DP slave operation

PROFIBUS is an international standard applicable to an open and serial
field bus for building, manufacturing and process automation that can be
used to create a low (sensor-/actuator level) or medium (process level)
performance network of programmable logic controllers.

PROFIBUS comprises an assortment of compatible versions. The following
details refer to PROFIBUS DP.

PROFIBUS DP is a special protocol intended mainly for automation tasks
in a manufacturing environment. DP is very fast, offers Plug'n'Play facilities
and provides a cost-effective alternative to parallel cabling between PLC
and remote I/0. PROFIBUS DP was designed for high-speed data commu-
nication on the sensor-actuator level.

The data transfer referred to as "Data Exchange" is cyclical. During one
bus cycle, the master reads input values from the slaves and writes output
information to the slaves.

The PROFIBUS DP master is to be configured in the hardware configurator
from Siemens. Therefore the configuration happens by the sub module X1
(MPI/DP) of the Siemens CPU.

After the transmission of the data to the CPU, the configuration data are
internally passed on to the PROFIBUS master part.

During the start-up the DP master automatically includes his data areas
into the address range of the CPU. Project engineering in the CPU is not
required.

Via the PROFIBUS DP master PROFIBUS DP slaves may be coupled to
the CPU. The DP master communicates with the DP slaves and links up its
data areas with the address area of the CPU.

At every POWER ON res. overall reset the CPU fetches the I/O mapping
data from the master. At DP slave failure, the ER-LED is on and the OB 86
is requested. If this is not available, the CPU switches to STOP and BASP
is set. As soon as the BASP signal comes from the CPU, the DP master is
setting the outputs of the connected periphery to zero. The DP master
remains in the operating mode RUN independent from the CPU.

For the deployment in a super-ordinated master system you first have to
project your slave system as Siemens CPU in slave operation mode with
configured in-/output areas. Afterwards you configure your master system.
Couple your slave system to your master system by dragging the CPU 31x
from the hardware catalog at Configured stations onto the master system,
choose your slave system and connect it.

6-2
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Fast introduction

Overview The PROFIBUS DP master is to be configured in the hardware
configurator. Here the configuration happens by means of the sub module
X2 (DP) of the Siemens CPU.

Steps of For the configuration of the PROFIBUS DP master please follow the
configuration following approach:

» Hardware configuration - CPU
* Deployment as DP master or Deployment as DP slave
» Transfer of the complete project to CPU

Information about transferring a project may be found at chapter
"Deployment CPU ..." at "Project transfer".

Note

To be compatible to the Siemens SIMATIC manager, the CPU 315-4NE12 from VIPA is
to be configured as

CPU 318-2 (318-2AJ00-0AB00 V3.0)

The integrated PROFIBUS DP master (X3) is to be configured and connected via the
sub module X2 (DP).

In the operation mode PROFIBUS the CPU may further more be accessed via the MPI
interface (X2) with address 2 und 187.5kbit/s.

The Ethernet PG/OP channel of the CPU 315-4NE12 is always to be configured as 1.
module after the really plugged modules at the standard bus as CP343-1 (343-1EX11)
from Siemens.
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Hardware configuration - CPU

Requirements

The hardware configuration of the VIPA CPU takes place at the Siemens
hardware configurator.

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules, which may be configured
here are listed in the hardware catalog. If necessary you have to update
the hardware catalog with Options > Update Catalog.

For project engineering a thorough knowledge of the Siemens SIMATIC
manager and the Siemens hardware configurator are required!

Note!

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic
operation (+l, -1, *I, /l, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2.

This may cause conflicts in applications that presume an unmodified
ACCU2.

For more information may be found in the manual "VIPA Operation list
SPEED7" at "Differences between SPEED7 and 300V programming".

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

» Start the Siemens hardware configurator with a new project.

« Insert a profile rail from the hardware catalog.

* Place at slot 2 the following CPU from Siemens:

CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0).

Proceeding
Slot | Module
1
2 CPU 318-2
X2 | DP
X1 | MPI/DP
3

« The integrated PROFIBUS DP master (X3) is to be configured and

connected via the sub module X2 (DP). In the operation mode
PROFIBUS the CPU may further more be accessed via the MPI
interface (X2) with address 2 und 187.5kbit/s.

6-4
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Deployment as PROFIBUS DP master

Precondition .

Proceeding .

The hardware configuration described before was established.

Open the properties dialog of the DP interface of the CPU by means of
a double-click at DP.

Set Interface type to "PROFIBUS"

Connect to PROFIBUS and preset an address (preferably 2) and
confirm with [OK].

Switch at Operating mode to "DP master" and confirm the dialog with
[OK]. A PROFIBUS DP master system is inserted.

Slot | Module
1
2 CPU ...
X2 DP PROFIBUS DP master system
X1 MPI/DP
3

Now the project engineering of your PROFIBUS DP master is finished.
Please link up now your DP slaves with periphery to your DP master.

For the project engineering of PROFIBUS DP slaves you search the
concerning PROFIBUS DP slave in the hardware catalog and
drag&drop it in the subnet of your master.

Assign a valid PROFIBUS address to the DP slave.

Link up the modules of your DP slave system in the plugged sequence
and add the addresses that should be used by the modules.

If needed, parameterize the modules.

Save, compile and transfer your project. More detailed information about
project transfer may be found at chapter "Deployment CPU ...".

Slot | Module
1
)2<2 SEU PROFIBUS DP master system
X1 MPI/DP
3
Slot | Module Order number
1
2 Module
3
4
5

HB140E - CPU - RE_315-4NE12 - Rev. 12/06 6-5



Chapter 6 Deployment PROFIBUS communication Manual VIPA System 300S SPEED7

Deployment as PROFIBUS DP slave

Fast introduction

Project
engineering of the
slave section

In the following the deployment of the PROFIBUS section as "intelligent"
DP slave on master system is described, which exclusively may be
configured in the Siemens SIMATIC manager.

The following steps are required:

Configure a station with a CPU with operating mode DP slave.

Connect to PROFIBUS and configure the in-/output area for the slave
section.

Save and compile your project.

Configure another station with another CPU with operating mode DP
master.

Connect to PROFIBUS and configure the in-/output ranges for the
master section

Save, compile and transfer your project to your CPU.

Start the Siemens SIMATIC manager and configure a CPU as described
at "Hardware configuration - CPU".

Designate the station as "...DP slave"
Add your modules according to the real hardware assembly.

Open the properties dialog of the DP interface of the CPU by means of
a double-click at DP.

Set Interface type to "PROFIBUS"

Connect to PROFIBUS and preset an address (preferably 3) and
confirm with [OK].

Switch at Operating mode to "DP slave"

Via Configuration you define the in-/output address area of the slave
CPU, which are to be assigned to the DP slave.

Save, compile and transfer your project to your CPU.

Slave section

Standard kIJVIus I Object properties
SI10t odule Operating mode: DP slave
2 CPU Connect: PROFIBUS
x2 [ DP - PROFIBUS address: > 1
X1 MPI/DP \ _ _
3 Configuration:
4 Input area
5 Modules Output area
6
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Project

engineering of the
master section

Master section

Insert another station and configure a CPU.
Designate the station as "...DP master".
Add your modules according to the real hardware assembly.

Open the properties dialog of the DP interface of the CPU by means of
a double-click at DP.

Set Interface: type to "PROFIBUS".

Connect to PROFIBUS and preset an address (preferably 2) and
confirm with [OK].

Switch at Operating mode to "DP master" and confirm the dialog with
[OK].

Connect your slave system to this master system by dragging the
"CPU 31x" from the hardware catalog at Configured stations onto the
master system and select your slave system to be coupled.

Open the Configuration at Object properties of your slave system.

Via double click to the according configuration line you assign the
according input address area on the master CPU to the slave output
data and the output address area to the slave input data.

Save, compile and transfer your project to your CPU.

Standard bus

DP master system

T

§7-300 @

Slot Module
1
2 CPU ...
X2 =DP
X1 MPI/DP
3
@ Modules

Hardware catalog: CPU 31x
oo | <

Object properties

from configured stations

Object properties

Operating mode: DP master Configuration:
Connect: PROFIBUS Input area slave CPU = Output area master-CPU
PROFIBUS address: > 1 Output area slave CPU = Input area Master-CPU
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PROFIBUS installation guidelines

PROFIBUS in
general

Transfer medium

* A PROFIBUS DP network may only be built up in linear structure.

« PROFIBUS DP consists of minimum one segment with at least one
master and one slave.

» A master has always been deployed together with a CPU.
» PROFIBUS supports max. 126 participants.

» Per segment a max. of 32 participants is permitted.

* The max. segment length depends on the baud rate:

9.6 ... 187.5kbaud - 1000m
500kbaud - 400m
1.5Mbaud - 200m
3 ... 12Mbaud - 100m

* Max. 10 segments may be built up. The segments are connected via
repeaters. Every repeater counts for one participant.

» The bus respectively a segment is to be terminated at both ends.

» All participants are communicating with the same baud rate. The slaves
adjust themselves automatically on the baud rate.

As transfer medium PROFIBUS uses an isolated twisted-pair cable based
upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less
irritable from influences than a voltage or a current interface. You are able
to configure the network as well linear as in a tree structure.

Max. 32 participants per segment are permitted. Within a segment the
members are linear connected. The segments are connected via
repeaters. The maximum segment length depends on the transfer rate.

PROFIBUS DP uses a transfer rate between 9.6kbaud and 12Mbaud, the
slaves are following automatically. All participants are communicating with
the same transfer rate.

The bus structure under RS485 allows an easy connection res.
disconnection of stations as well as starting the system step by step. Later
expansions don’'t have any influence on stations that are already
integrated. The system realizes automatically if one partner had a fail down
or is new in the network.
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Bus connection

Master

The following picture illustrates the terminating resistors of the respective
start and end station.

Slave Slave
6 N N 6
P5V - |- -, [ [ - ¢ - P5V

o P b T

(I ! \ o

1330 / 1 \ 330,

L‘,‘ (v \ 'v \ L\"
RDMxD-PE) 3| | | ! 3 RxD/TxD-P(B) 3 | ! 1 |3 RxD/TXD-P(B)

A T T A

_ | \ | \ i

L L L o

1220 | | | . o220,

| | | |
RXD/TXD-N(A) 8] —1— | ‘ 8 RxD/TxD-N(A) 8 | ‘ ~1” |8 RxD/TXD-N(A)

v \ \ v

o | ! | ! o

| 1330 ! ! ! 330,

o 1 J 1 J (.

5 T | | | | T 5
M5V — @ — \ I \ | ‘-¢ - M5V
\ i |
\ I

Shield \\.4/ Shield \\'// Shield

EasyConn
bus connector

Note!

The PROFIBUS line has to be terminated with its ripple resistor. Please
make sure to terminate the last participants on the bus at both ends by

activating the terminating resistor.

In PROFIBUS all participants are wired parallel. For that purpose, the bus
cable must be feed-through.

Via the order number VIPA 972-0DP10 you may order the bus connector

and integrated bus diagnostic.
0° 45° 90°
[ |
| O
é H
N o
A A Al
E 0 0 ¢
B B C
0° 45° 90°
A 64 61 66
B 34 53 40
C 15.8 15.8 15.8
all in mm

"EasyConn". This is a bus connector with switchable terminating resistor
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Termination with
"EasyConn"

Wiring
1./last
bus participant

Assembly

Please note:

Note!

To connect this EasyConn plug, please use the standard PROFIBUS cable
type A (EN50170). Starting with release 5 you also can use highly flexible
bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322.

With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool
that makes the connection of the EasyConn much easier.

Dimensions in mm

The "EasyConn" bus connector is provided with a switch that is used to
activate a terminating resistor.

further Attention!

participants The terminating resistor is only
effective, if the connector is installed at
a bus participant and the bus participant
is connected to a power supply.

Note!

A complete description of installation
and deployment of the terminating
resistors is delivered with the connector.

* Loosen the screw.

» Lift contact-cover.

* Insert both wires into the ducts
provided (watch for the correct
line color as below!)

* Please take care not to cause a
short circuit between screen and
data lines!

» Close the contact cover.

» Tighten screw
(max. tightening torque 4Nm).

The green line must be connected to A, the red line to B!

6-10
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Commissioning and Start-up behavior

Start-up on
delivery

Online with bus
parameter without
slave project

Slave
configuration

CPU state controls
DP master

Master behavior at
CPU STOP

Master behavior at
CPU RUN

In delivery the CPU is overall reset. The PROFIBUS part is deactivated and
its LEDs are off after Power ON.

The DP master can be served with bus parameters by means of a
hardware configuration. As soon as these are transferred the DP master
goes online with his bus parameter. This is shown by the RUN LED. Now
the DP master can be contacted via PROFIBUS by means of his
PROFIBUS address. In this state the CPU can be accessed via
PROFIBUS to get configuration and DP slave project.

If the master has received valid configuration data, he switches to Data
Exchange with the DP Slaves. This is indicated by the DE-LED.

After PowerON respectively a receipt of a new hardware configuration the
configuration data and bus parameter were transferred to the DP master.

Dependent on the CPU state the following behavior is shown by the DP
master:

» The global control command "Clear" is sent to the slaves by the master.
Here the DE-LED is blinking.

» DP slaves with fail safe mode were provided with output telegram length
"0".

» DP slaves without fail safe mode were provided with the whole output
telegram but with output data = 0.

» The input data of the DP slaves were further cyclically transferred to the
input area of the CPU.

* The global control command "Operate" is sent to the slaves by the
master. Here the DE-LED is on.

» Every connected DP slave is cyclically attended with an output telegram
containing recent output data.

» The input data of the DP slaves were cyclically transferred to the input
area of the CPU.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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LEDs
PROFIBUS/PtP
interface X3

Master operation

Dependent on the mode of operation the LEDs show information about the
state of operation of the PROFIBUS part according to the following pattern:

RUN |ERR | DE IF | Meaning
green | red | green | red
Master has no project, this means the interface is deactivated respectively PtP
@) @) O o |. -
is active.
(] @) @) O | Master has bus parameters and is in RUN without slaves.
° o o Master is in "clear" state (safety state). The inputs of the slaves may be read.
{:2 The outputs are disabled.
° o ® o Master is in "operate" state, this means data exchange between master and
slaves. The outputs may be accessed.
® ® ® O |CPUis in RUN, at least 1 slave is missing.
° ® | It | O [CPUisinSTOP, atleast 1 slave is missing.
e) e) @) ® | Initialization error at faulty parameterization.
©) [ ) @) ® | Waiting state for start command from CPU.
Slave operation
RUN |ERR| DE IF | Meaning
green | red | green | red
O @) @) O | Slave has no project respectively PtP is active.
It | o O O |Slave is without master.
I$*| o | f* | O |*Alternate flashing at configuration faults.
) @) () O | Slave exchanges data between master.

on: @ off: O

blinking (2Hz): i:l} not relevant: X
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Chapter 7

Overview

Content

Deployment Ethernet communication

In this chapter the communication via Ethernet is described. Please regard
the chapter "Fast introduction" where you will find every information
compressed required for the project engineering of the CPU 315-4NE12
with CP 343. After the fast introduction, the mentioned steps are described
in detail.

Topic Page
Chapter 7  Deployment Ethernet communication...............ccceeueen. 7-1
Basics - Industrial Ethernet in automation ..............cccoooiiiinn. 7-2
Basics - ISO/OSI reference model ... 7-3
BaSICS - TEIMIS .o e e s 7-6
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Configure Open CommuNIiCatioN .........c.uuviiiiiiiiiiiieee e 7-36
NCM diagnostic - Help for error diagnostic............cccovvveiiiiieniieennnnnnnn. 7-39
Coupling to other Systems ... 7-42
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Basics - Industrial Ethernet in automation

Overview

Industrial Ethernet

The flow of information in a company presents a vast spectrum of
requirements that must be met by the communication systems. Depending
on the area of business the bus system or LAN must support a different
number of users, different volumes of data must be transferred and the
intervals between transfers may vary, etc.

It is for this reason that different bus systems are employed depending on
the respective task. These may be subdivided into different classes. The
following model depicts the relationship between the different bus systems
and the hierarchical structures of a company:

Industrial
Operational layer Ethernet
Plant-oriented

control computer
Management layer manufacturing, stock, —

production data H 1

PPS CAD
Machine and control
SyStem Iayer computer
Peripheral systems. machines, CNC, NC, .
Prozess Iayer controllers (PLC), measuring systems Field bus
Sensor / actuator Peripheral components
Iayer sensor, actuator, regulator, multiplexer, operating consoles Sensor / actuator
Bus

Industrial Ethernet is an electrical net based on shielded twisted pair
cabling or optical net based on optical fiber.

Industrial Ethernet is defined by the international standard IEEE 802.3. The
net access of Industrial Ethernet corresponds to IEEE 802.3 - CSMA/CD
(Carrier Sense Multiple Access/Collision Detection) scheme: every station
"listens” on the bus cable and receives communication messages that are
addressed to it.

Stations will only initiate a transmission when the line is unoccupied. In the
event that two participants should start transmitting simultaneously, they
will detect this and stop transmitting to restart after a random delay time
has expired.

Using switches there is the possibility for communication without collisions.
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Basics - ISO/OSI reference model

Overview

The ISO/OSI reference model is based on a proposal that was developed
by the International Standards Organization (ISO). This represents the first
step towards an international standard for the different protocols. It is
referred to as the ISO-OSI layer model. OSI is the abbreviation for Open
System Interconnection, the communication between open systems. The
ISO/OSI reference model does not represent a network architecture as it
does not define the services and protocols used by the different layers. The
model simply specifies the tasks that the different layers must perform.

All current communication systems are based on the 1SO/OSI reference
model, which is defined by the ISO 7498 standard. The reference model
structures communication systems into 7 layers that cover different
communication tasks. In this manner the complexity of the communication
between different systems is divided amongst different layers to simplify
the task.

The following layers have been defined:

Layer Function

Layer 7 Application Layer
Layer 6 Presentation Layer
Layer 5 |Session Layer
Layer 4 Transport Layer
Layer 3 Network Layer
Layer 2 Data Link Layer
Layer 1 Physical Layer

Depending on the complexity and the requirements of the communication
mechanisms a communication system may use a subset of these layers.
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Layers

Layer 1 Bit communication layer (physical layer)

The bit communication layer (physical layer) is concerned with the transfer
of data bits via the communication channel. This layer is therefore
responsible for the mechanical, electrical and the procedural interfaces and
the physical communication medium located below the bit communication
layer:

»  Which voltage represents a logical 0 or a 1?
» The minimum time the voltage is present to be recognized as a bit.
» The pin assignment of the respective interface.

Layer 2 Security layer (data link layer)

This layer performs error-checking functions for bit strings transferred
between two communicating partners. This includes the recognition and
correction or flagging of communication errors and flow control functions.

The security layer (data link layer) converts raw communication data into a
sequence of frames. This is where frame limits are inserted on the
transmitting side and where the receiving side detects them. These limits
consist of special bit patterns that are inserted at the beginning and at the
end of every frame. The security layer often also incorporates flow control
and error detection functions.

The data security layer is divided into two sub-levels, the LLC and the MAC
level.

The MAC (Media Access Control) is the lower level and controls how
senders are sharing a single transmit channel.

The LLC (Logical Link Control) is the upper level that establishes the
connection for transferring the data frames from one device into the other.

Layer 3 Network layer

The network layer is an agency layer.

Business of this layer is to control the exchange of binary data between
stations that are not directly connected. It is responsible for the logical
connections of layer 2 communications. Layer 3 supports the identification
of the single network addresses and the establishing and disconnecting of
logical communication channels.

Additionally, layer 3 manages the prior transfer of data and the error
processing of data packets. IP (Internet Protocol) is based on Layer 3.

Layer 4 Transport layer

Layer 4 connects the network structures with the structures of the higher
levels by dividing the messages of higher layers into segments and passes
them on to the network layer. Hereby, the transport layer converts the
transport addresses into network addresses.

Common transport protocols are: TCP, SPX, NWLink and NetBEUI.
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Layers
continued...

Layer 5 Session layer

The session layer is also called the communication control layer. It relieves
the communication between service deliverer and the requestor by
establishing and holding the connection if the transport system has a short
time fail out.

At this layer, logical users may communicate via several connections at the
same time. If the transport system fails, a new connection is established if
needed.

Additionally this layer provides methods for control and synchronization
tasks.

Layer 6 Presentation layer

This layer manages the presentation of the messages, when different
network systems are using different representations of data.

Layer 6 converts the data into a format that is acceptable for both
communication partners.

Here compression/decompression and encrypting/decrypting tasks are
processed.

This layer is also called interpreter. A typical use of this layer is the terminal
emulation.

Layer 7 Application layer

The application layer is the link between the user application and the
network. The tasks of the application layer include the network services like
file, print, message, data base and application services as well as the
according rules.

This layer is composed from a series of protocols that are permanently
expanded following the increasing needs of the user.
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Basics - Terms

Network (LAN) A network res. LAN (Local Area Network) provides a link between different
stations that enables them to communicate with each other.

Network stations consist of PCs, IPCs, TCP/IP adapters, etc.

Network stations are separated by a minimum distance and connected by
means of a network cable. The combination of network stations and the
network cable represent a complete segment.

All the segments of a network form the Ethernet (physics of a network).

Twisted Pair In the early days of networking the Triaxial- (yellow cable) or thin Ethernet
cable (Cheapernet) was used as communication medium. This has been
superseded by the twisted-pair network cable due to its immunity to
interference. The CPU has a twisted-pair connector.

The twisted-pair cable consists of 8 cores that are twisted together in pairs.
Due to these twists this system is provides an increased level of immunity
to electrical interference. For linking please use twisted pair cable which at
least corresponds to the category 5.

Where the coaxial Ethernet networks are based on a bus topology the
twisted-pair network is based on a point-to-point scheme.

The network that may be established by means of this cable has a star
topology. Every station is connected to the star coupler (hub/switch) by
means of a separate cable. The hub/switch provides the interface to the
Ethernet.

Hub (repeater) The hub is the central element that is required to implement a twisted-pair
Ethernet network.

It is the job of the hub to regenerate and to amplify the signals in both
directions. At the same time it must have the facility to detect and process
segment wide collisions and to relay this information. The hub is not
accessible by means of a separate network address since it is not visible to
the stations on the network.

A hub has provisions to interface to Ethernet or to another hub res. switch.

Switch A switch also is a central element for realizing Ethernet on Twisted Pair.
Several stations res. hubs are connected via a switch. Afterwards they are
able to communicate with each other via the switch without interfering the
network. An intelligent hardware analyzes the incoming telegrams of every
port of the switch and passes them collision free on to the destination
stations of the switch. A switch optimizes the bandwidth in every connected
segment of a network. Switches enable exclusive connections between the
segments of a network changing at request.
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Basics - Protocols

Overview

Communication
connections

Siemens S7
connections

Properties

Protocols define a set of instructions or standards that enable computer to
establish communication connections and exchange information as error
free as possible. A commonly established protocol for the standardization
of the complete computer communication is the so called ISO/OSI layer
model, a model based upon seven layers with rules for the usage of
hardware and software (see ISO/OSI reference model above).

The CP controller uses the following protocols:
» Communication connections
- Siemens S7 connections
- TCP/IP
- UDP
- RFC1006 (ISO on TCP)
- ISO transport (once H1)
* Open communication
- TCP native according to RFC 793
- 1SO on TCP according to RFC 1006
- UDP according to RFC 768
The protocols are described in the following:

With the Siemens S7 connection large data sets may be transferred
between PLC systems based on Siemens STEP®7. Here the stations are
connected via Ethernet.

Precondition for the Siemens S7 communication is a configured connection
table, which contains the defined connections for communication.

Here NetPro from Siemens may be used.

» A communication connection is specified by a connection ID for each
connection partner.

* The acknowledgement of the data transfer is established from the
partner station at level 7 of the ISO/OSI reference model.

» At the PLC side FB/SFB VIPA handling blocks are necessary for data
transfer for the Siemens S7 connections.

Note!

More about the usage of the handling blocks may be found in the manual
Operation list HBOO_OPL_SP7 in chapter "VIPA specific blocks".
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TCP/IP

TCP

TCP/IP protocols are available on all major systems. At the bottom end this
applies to simple PCs, through to the typical mini-computer up to
mainframes.

For the wide spread of Internet accesses and connections, TCP/IP is often
used to assemble heterogeneous system pools.

TCP/IP, standing for Transmission Control Protocol and Internet Protocol,
collects a various range of protocols and functions.

TCP and IP are only two of the protocols required for the assembly of a
complete architecture. The application layer provides programs like "FTP"
and "Telnet" for the PC.

The application layer of the Ethernet CP is defined with the user application
using the standard handling blocks.

These user applications use the transport layer with the protocols TCP and
UDP for the data transfer which themselves communicate via the IP
protocol with the Internet layer.

The Internet protocol covers the network layer (Layer 3) of the ISO/OSI
layer model.

The purpose of IP is to send data packages from on PC to another passing
several other PCs. These data packages are referred to as datagrams.
The IP doesn't neither guarantee the correct sequence of the datagrams
nor the delivery at the receiver.

For the unambiguous identification between sender and receiver 32Bit
addresses (IP addresses) are used that are normally written as four octets
(exactly 8bit), e.g. 172.16.192.11.

These Internet addresses are defined and assigned worldwide from the
DDN network (Defense Department Network), thus every user may
communicate with all other TCP/IP users.

One part of the address specifies the network; the rest serves the
identification of the participants inside the network. The boarder between
the network and the host part is variable and depends on the size of the
network.

To save IP addresses, so called NAT router are used that have one official
IP address and cover the network. Then the network can use any IP
address.

The TCP (Transmission Control Protocol) bases directly on the IP and
thus covers the transport layer (layer 4) of the ISO/OSI layer model. TCP is
a connection orientated end-to-end protocol and serves the logic
connection between two partners.

TCP guarantees the correct sequence and reliability of the data transfer.
Therefore you need a relatively large protocol overhead that slows down
the transfer speed.

Every datagram gets a header of at least 20Byte. This header also
contains a sequence number identifying the series. This has the
consequence that the single datagrams may reach the destination on
different ways through the network.

Using TCP connections, the telegram length is not transmitted. This means
that the recipient has to know how many bytes belong to a message. To
transfer data with variable length you may begin the user data with the
length information and evaluate this at the counter station.
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Properties
TCP/IP

UDP

ISO-on-TCP
RFC1006

Properties

» Besides of the IP address ports are used for the addressing. A port
address should be within the range of 2000...65535. Partner and local
ports may only be identical at one connection.

* Not depending on the used protocol, the PLC needs the VIPA handling
blocks AG_SEND (FC 5) and AG_RECYV (FC 6) for data transfer.

The UDP (User Datagram Protocol) is a connection free transport protocol.
It has been defined in the RFC768 (Request for Comment). Compared to
TCP, it has much fewer characteristics.

The addressing happens via port numbers.

UDP is a fast unsafe protocol for it doesn't neither care about missing data
packages nor about their sequence.

The TCP transport service works stream orientated. This means that data
packages assembled by the user not necessarily have to receive the
partner in the same packaging. Depending on the data amount, packages
may though come in the correct sequence but differently packed. This
causes that the recipient may not recognize the package borders anymore.
For example you may send 2x 10Byte packages but the counter station
receives them as 20Byte package. But for most of the applications the
correct packaging is important.

Due to this you need another protocol above TCP. This purpose is defined
in the protocol RFC1006. The protocol definition describes the function of
an ISO transport interface (ISO 8072) basing upon the transport interface
TCP (RFC793).

The basic protocol of RFC1006 is nearly identical to TPO (Transport
Protocol, Class 0) in ISO 8073.

For RFC1006 is run as protocol for TCP, the decoding takes place in the
data section of the TCP package.

» The receipt of data is confirmed by a TCP layer.

* Instead of ports TSAPs are used for the addressing besides of the IP
address. The TSAP length may be 1 ... 16 characters. The entry may
happen in ASCII or Hex format. Remote and local TSAPs may only be
identical at 1 connection.

» Not depending on the used protocol, the PLC needs the VIPA handling
blocks AG_SEND (FC 5) and AG_RECYV (FC 6) for data transfer.

* Contrary to TCP different telegram lengths can be received using
RFC1006.
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ISO transport
(once H1)

Properties

Deployment of ISO

The ISO transport service (ISO 8073 class 4) corresponds to the transport
layer (Layer 4) of the ISO/OSI reference model. With ISO transport
connections there is the possibility for program and event controlled
communication via Industrial Ethernet. Here data blocks may be
exchanged bi-directional.

The ISO transport connection offers services for a safety transfer of data
by means of configured connections. Large data blocks may be transferred
by means of blocking.

The transmission reliability is very high by the automatic repetition, by
additional block test mechanisms and by the receipt acknowledgement at
the receiver side. ISO transport connections are exclusively transferred via
Industrial Ethernet and they are optimized for the deployment in a closed
manufacturing area.

» IS0 transport connections are only suited for Industrial Ethernet

* The receipt of data is acknowledged by the partner station. Here
different telegram lengths may be processed.

 The addressing happens by MAC address (Ethernet address) and
TSAPs (Transport Service Access Point).

» The data transfer is made by the services SEND/RECEIVE and
FETCH/WRITE.

» Independent on the used protocol, the PLC needs the VIPA handling
blocks AG_SEND (FC 5) and AG_RECYV (FC 6) for data transfer.

For deployment of the ISO transport connections they must be enabled in

transport the Ethernet properties of the CP at the project above.

connections Here there is the possibility to assign the CP to a MAC address. With each
start-up of the CPU the new MAC address is transferred to the CP.
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Open
communication

Connection-
oriented protocols

TCP native accord.
to RFC 793

ISO on TCP accord.

to RFC 1006

Connection-less
protocol

UDP accord. to
RFC 768

In the open communication the communication takes place via the user
program by means of handling blocks. These blocks are part of the
Siemens SIMATIC Manager. You will find these in the "Standard Library" at
"Communication Blocks".

Connection-oriented protocols establish a (logical) connection to the
communication partner before data transmission is started. And if
necessary they terminate the connection after the data transfer was
finished.

Connection-oriented protocols are used for data transmission when
reliable, guaranteed delivery is of particular importance. In general, many
logical connections can exist on one physical line.

The following connection-oriented protocols are supported with FBs for
open communication via Industrial Ethernet:

During data transmission, no information about the length or about the start
and end of a message is transmitted. However, the receiver has no means
of detecting where one message ends in the data stream and the next one
begins. The transfer is stream-oriented.

For this reason, it is recommended that the data length of the FBs is
identical for the sending and receiving station. If the number of received
data does not fit to the preset length you either will get not the whole data,
or you will get data of the following job.

During data transmission, information on the length and the end of the
message is also transmitted.

If you have specified the length of the data to be received greater than the
length of the data to be sent, the receive block will copy the received data
completely into the receive range.

There is thus no establishment and termination of a connection with a
remote partner. Connection-less protocols transmit data with no
acknowledge and with no reliable guaranteed delivery to the remote
partner.

In this case, when calling the sending block you have to specify the address
parameters of the receiver (IP address and port number). During data
transmission, information on the length and the end of the message is also
transmitted.

In order to be able to use the sending and receiving blocks first you have to
configure the local communications access point at both sides.

With each new call of the sending block, you re-reference the remote
partner by specifying its IP address and its port number.
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Basics - IP address and subnet

IP address
structure

Net-ID
Host-ID

Subnet mask

Subnet

Address at first
start-up

Industrial Ethernet exclusively supports IPv4. At IPv4 the IP address is a
32Bit address that must be unique within the network and consists of 4
numbers that are separated by a dot.

Every IP address is a combination of a Net-ID and a Host-ID and its
structure is as follows: XXX XXX XXX XXX

Range: 000.000.000.000 to 255.255.255.255
The network administrator also defines IP addresses.

The Network-ID identifies a network res. a network controller that
administrates the network.

The Host-ID marks the network connections of a participant (host) to this
network.

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by
using a bit for bit AND assignment with the Subnet mask.

The area of the original Host-ID that is overwritten by 1 of the Subnet mask
becomes the Subnet-ID, the rest is the new Host-ID.

Subnet mask binary all "1" ‘ binary all "0"
IPv4 address Net-ID Host-1D
Subnet mask and IPv4 address | Net-ID Subnet-ID ‘ new Host-ID

A TCP-based communication via point-to-point, hub or switch connection is
only possible between stations with identical Network-ID and Subnet-ID!
Different area must be connected with a router.

The subnet mask allows you to sort the resources following your needs.
This means e.g. that every department gets an own subnet and thus does
not interfere another department.

At the first start-up of the CPU, the Ethernet PG/OP channel and the CP
343 of the CPU do not have an IP address.

Information about the assignment of IP address data to the Ethernet
PG/OP channel may be found in chapter "Deployment CPU .." at
"Initialization Ethernet PG/OP channel".

Information about the assignment of IP address data to the CP 343 may be
found in this chapter below.
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Address classes For IPv4 addresses there are five address formats (class A to class E) that
are all of a length of 4byte = 32bit.

Class A |0 | Network-ID Host-ID (24bit)
(1+7bit)
Class B |10 |Network-ID (2+14bit) | Host-1D (16bit)
Class C [110 |Network-ID (3+21bit) | Host-1D (8bit)
Class D [1110 |Multicast group
ClassE [11110 |Reserved

The classes A, B and C are used for individual addresses, class D for
multicast addresses and class E is reserved for special purposes.

The address formats of the 3 classes A, B, C are only differing in the length
of Network-ID and Host-ID.

Private IP networks  To build up private IP-Networks within the Internet, RFC1597/1918
reserves the following address areas:

Network Start IP End IP Standard subnet mask
class

A 10.0.0.0 10.255.255.255 255.0.0.0

B 172.16.0.0 |172.31.255.255 255.255.0.0

C 192.168.0.0 |192.168.255.255 |255.255.255.0

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without
causing conflicts, for these IP addresses are neither assigned in the
Internet nor are routed in the Internet.

Reserved Some Host-IDs are reserved for special purposes.
Host-Ids

Host-ID = "0" Identifier of this network, reserved!

Host-ID = maximum (binary complete "1") | Broadcast address of this network

Note!
Never choose an IP address with Host-ID=0 or Host-ID=maximum!

(e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is
reserved and the "172.16.255.255" is occupied as local broadcast address
for this network.)
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Basics - MAC address and TSAP

MAC address

Broadcast address

Address at first
start-up

There is a unique MAC address (Media Access Control) necessary for
each CP. Usually a module is labeled with its MAC address by the
manufacturer. This address should be used for project engineering of the
CP. The MAC address has a length of 6bytes.

On delivery the first three bytes specify the manufacturer. These bytes are
assigned by the IEEE committee. The last three bytes may be assigned by
the manufacturer.

In a network several stations with the same MAC address may not exist.
The MAC address may be changed at any time. You will get a valid MAC
address from your network administrator.

The MAC address, with which all bits are set to 1, is:

FF-FF-FF-FF-FF-FF

This address is used as Broadcast address and addresses all participants
in the net.

At the first-start-up the CP 343 of the CPU has an unique MAC address.
This may be found on a label beneath the front flap.

Note!

Please regard for the configuration of the network in the Siemens SIMATIC
manager that it is necessary to activate the 1ISO protocol and to preset a
valid MAC address within the properties dialog of the Ethernet interface of
the CP!

TSAP TSAP means Transport Service Access Point. ISO transport connections
support TSAP length of 1...16byte. TSAPs may be entered in ASCII format
or hexadecimal.

Address An |ISO transport connection is specified by a local and a remote

parameters connection endpoint.

Station A Station B
remote TSAP = ISO transport- = local TSAP
local TSAP = connection = remote TSAP
MAC address A MAC address B

The TSAPs of an ISO transport connection must match as follows:

Remote TSAP (in CP) = local TSAP (in destination station)

Local TSAP (in CP) = remote TSAP (in destination station)
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Fast introduction

Overview At the first start-up respectively at an over all reset with an PowerON again,
the Ethernet PG/OP channel and CP 343 of the CPU do not have any IP
address. These may only be reached via its MAC address.

IP address parameters may be assigned to the corresponding component
by means of the MAC addresses, which may be found on labels beneath
the front flap with the sequence 1. address PG/OP channel and beneath
address of the CP 343. The assignment takes place directly via the
hardware configuration of the Siemens SIMATIC manager.

Steps of For the configuration of the CP 343 for productive connections please
configuration follow the following approach:

 Commissioning and initialization
(Assignment of IP address data)

» Hardware configuration - CPU
» Configure connections

- Communication connections
(Configuration via Siemens NetPro, communication via VIPA
handling blocks)

- Open communication
(Configuration and communication happens by standard handling
blocks)

» Transfer of the complete project to CPU
Information about transferring a project may be found at chapter
"Deployment CPU ..." at "Project transfer".

Note

To be compatible to the Siemens SIMATIC manager, the CPU 315-4NE12 from VIPA is
to be configured as

CPU 318-2 (6ES7 318-2AJ00-0ABO)!

The integrated PROFIBUS DP master (X3) is to be configured and connected via the
sub module X2 (DP).

In the operation mode PROFIBUS the CPU may further more be accessed via the MPI
interface (X2) with address 2 und 187.5kbit/s.

The Ethernet PG/OP channel of the CPU 315-4NE12 is always to be configured as 1.
module after the really plugged modules at the standard bus as CP343-1 (343-1EX11)
from Siemens. The CP 343 of the CPU is always to be configured below the before
configured PG/OP channel also as CP343-1 (343-1EX11).
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Commissioning and Initialization

Assembly and
commissioning

Assign IP address
parameters

Install your System 300S with your CPU.
» Wire the system by connecting cables for voltage supply and signals
» Connect your CP 343 with Ethernet.

» Switch on the power supply.
- After a short boot time, the CP is in idle.
At the first commissioning res. after an overall reset of the CPU, the
CP 343 has no IP address.

Please regard this functionality is available with CP firmware version 1.7.4
and up.

You get valid IP address parameters from your system administrator. The
assignment of the IP address data happens online in the Siemens
SIMATIC manager starting with version V 5.3 & SP3 with the following
proceeding:

» Start the Siemens SIMATIC manager.

» Switch to "TCP/IP -> Network card .... " using Options > Set PG/PC
interface.

» The dialog for initialization of a station opens by PLC > Edit Ethernet
Node.

» To get the stations and their MAC address, use the [Browse] button or
type in the MAC Address. The Mac address may be found at the 2. label
beneath the front flap of the CPU.

» Choose if necessary the known MAC address of the list of found
stations.

» Either type in the IP configuration like IP address, subnet mask and
gateway. Or your station is automatically provided with IP parameters by
means of a DHCP server. Depending of the chosen option the DHCP
server is to be supplied with MAC address, equipment name or client ID.
The client ID is a numerical order of max. 63 characters. The following
characters are allowed: "hyphen", 0-9, a-z, A-Z

» Confirm with [Assign IP configuration].

Directly after the assignment the CP 343 is online reachable using the set
IP address data.

Note!

Since the IP address data, which were assigned here, are deleted at
PowerOFF, you have to take them to a project by means of the hardware
configuration, which is described on the next page.

Information about the initialization of the Ethernet-PG/OP channel may be
found in chapter "Deployment CPU..." at "Initialization Ethernet PG/OP
channel".
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Hardware configuration - CPU

Requirements

The hardware configuration of the VIPA CPU takes place at the Siemens
hardware configurator.

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules, which may be configured
here are listed in the hardware catalog. If necessary you have to update
the hardware catalog with Options > Update Catalog.

For project engineering a thorough knowledge of the Siemens SIMATIC
manager and the Siemens hardware configurator are required!

Note!

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic
operation (+1, -, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2.

This may cause conflicts in applications that presume an unmodified
ACCU2.

For more information may be found in the manual "VIPA Operation list
SPEED7" at "Differences between SPEED7 and 300V programming".

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

« Start the Siemens hardware configurator with a new project.

» Insert a profile rail from the hardware catalog.

« Place at slot 2 the following CPU from Siemens:

CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0).

Proceeding
Slot | Module
1
2 | CPU318-2
X2 | DP
X1 | MPI/DP
3

» The integrated PROFIBUS DP master (X3) is to be configured and

connected via the sub module X2 (DP). In the operation mode
PROFIBUS the CPU may further more be accessed via the MPI
interface (X2) with address 2 und 187.5kbit/s.
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Project engineering
Ethernet PG/OP
channel and CP 343

Parameterization of
the IP address data

For the internal Ethernet PG/OP channel you have to configure a Siemens
CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7
343-1EX11 0XEO) always as 1. module below the really plugged modules.

The integrated CP 343 of the CPU is also configured as CP 343-1 (343-
1EX11) but always below the before configured CP 343-1.

Standard bus (serial) —»

o
g Standard bus
a Slot | Module
i 1
L < L] £ | 2 CPU ...
o2 X...
& || @
CPU 31xSN/NET 3
4
5
6 Modules
7
8
Ethernet PG/OP channel 9 343-1EX11
CP 343 1(1) 343-1EX11

Open the property window of the CP via double-click on the CP.

» At general enter a device name. The device name on the Ethernet
subnet must be unique.

* On [Properties] for the CP enter the IP address, subnet mask and
gateway and select the wanted subnet.
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Configure connections

Overview

Properties
communication
connection

Requirements

The project engineering of connections i.e. the "link-up" between stations
happens in NetPro from Siemens. NetPro is a graphical user interface for
the link-up of stations.

A communication connection enables the program controlled communi-
cation between two participants at the Industrial Ethernet. The communi-
cation partners may here be part of the same project or - at multi projects -
separated within related part projects.

Communication connections to partners outside of a project are configured
via the object "In unknown project" or via deputy objects like "Other
stations" or Siemens "SIMATIC S5 Station".

The communication is controlled by the user program with VIPA handling
blocks. To use this blocks, configured communication connections are
always necessary in the active station.

The following properties are characterizing a communication connection:
» One station always executes an active connection establishment.
» Bi-directional data transfer (Send and receive on one connection)

» Both participant have equal rights, i.e. every participant may initialize the
send res. receive process event controlled.

» Except of the UDP connection, at a communication connection the
address of the communication partner is set via the project engineering.
Here the connection is active established by one station.

CP Ethernet partner

send

—>
Communication
link
<4—

—> receive
<4

receive send

Ethernet partner

send receive

—>
link
receive ‘ <4+ send

—
Communication
<«

» Siemens SIMATIC manager V.5.1 or higher and SIMATIC NET are
installed.

» With the hardware configuration the CP was assigned with IP address
data by the properties.
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Work environment
of NetPro

Note!

Every station outside of the recent project must be configured as
replacement objects like e.g. Siemens "SIMATIC S5" or "other station" or
with the object "In unknown project".

When creating a connection you may also choose the partner type
"unspecified" and set the required remote parameter directly in the
connection dialog.

For the project engineering of connections, a thorough knowledge with
NetPro from Siemens is required! The following passage only describes the
basic usage of NetPro. More detailed information about NetPro is to be
found in the according online manual res. documentation.

Start NetPro by clicking on a "net" in the Siemens SIMATIC manager or on
"connections" within the CPU.

The environment of NetPro has the following structure:
1

Graphic net view

All stations and networks are displayed in a graphic view. By clicking
on the according component you may access and alter the
concerning properties.

2 Net objects
This area displays all available net objects in a directory view. By
dragging a wanted object to the net view you may include further net
objects and open them in the hardware configurator.
3 Connection table
The connection table lists all connections in a table. This list is only
shown when you highlighted a connectable module like e.g. a CPU.
You may insert new connections into this table with the according
command.
1 2
Profibus
MPI = Profibus-DP
B Profibus-PA
Ethernet - Stationes
- Subnet
Station 1 Station 2
CPU |DP |MPI |CP |CP CPU |DP |MPI |{CP |CP
318-2 343-1343-1 3182 | 343-1 3431
| |
| |
3
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PLC stations

-

You receive the following graphical display for every PLC station and their
component. By selecting the single components, the context menu offers
you several functions:

Link up stations

Station 1

CPU[DP [MPI [CP [CP

318-2 ‘ 343-1 | 343-1
B

BLE L]
e

2 3 4 5

Station

This includes a PLC station with rack, CPU and communication
components. Via the context menu you may configure a station
added from the net objects and its concerning components in
the hardware configurator. After returning to NetPro, the new
configured components are shown.

CPU

A click onto the CPU shows the connection table. The
connection table shows all connections that are configured for
the CPU.

Internal communication components

This displays the communication components that are available
in your CPU. For the NET-CPU is configured as CPU 318-2 the
internal components do not show the CP.

Due to this, the CPs that are included in the NET-CPU must be
configured as external CPs behind the really plugged modules.
The CPs are then also shown in NetPro as external CPs (4, 5)
in the station.

Ethernet PG/OP channel

The internal Ethernet PG/OP channel must always be
configured as external 1. CP in the hardware configuration.
This CP only serves the PG/OP communication. You may not
configure connections.

CP 343
The internal CP 343 must always be configured as external 2.

CP in the hardware configuration after the Ethernet PG/OP
channel.

NetPro offers you the option to link-up the communicating stations. You
may link-up the stations via the properties in the hardware configuration or
graphically via NetPro. For this you point the mouse on the colored net
mark of the according CP and drag and drop it to the net you want to link.
Now the CP is linked up to the wanted net by means of a line.

Industrial Ethernet

Industrial Ethernet

| A

Station 1 . Station 1 ‘
DP [MPI [CP |Gi | DP [MPI [CP [CP
| 343-134. | - 343-1343-1
|
= LB BLAL = LEBLBLEC
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Projecting
connections

Connection partner
(partner station)

Specified
connection partner

Unspecified
connection partner

All broadcast
stations

All multicast
stations

For the project engineering of connections, open the connection list by
selecting the according CPU. Choose Insert new connection in the context
menu:

Station 1
DP |MPI [CP [CP
i 343-1/343-1

insert new connection [:

A dialog window opens where you may choose the connection partner and
the connection type.

Each station configured in the Siemens SIMATIC manager is listed in the
table of connection partner. These stations are unique specified by an IP
address and a subnet mask.

Here the connection partner may exist in the current project or in an
unknown project. Connection jobs to an unknown project must be defined
by an unique connection name, which is to be used in the projects of both
stations. Due to this allocation the connection remains unspecified.

Exclusive at UDP connections you may send to every reachable
participant. The receipt of user data is not possible. The broadcast
participants are specified by one port and one broadcast address at sender
and receiver.

Per default, broadcasts that are only serving the Ethernet communication,
like e.g. ARP-Requests (Search MAC <> |IP address), are received and
accordingly processed. For the identification of the broadcast participants
within the net, you have to define a valid broadcast address as partner IP
during project engineering of a broadcast connection. Additionally to the
broadcast address you have to set a common port for sender and receiver.

By selecting All Multicast stations you define that UDP telegrams have to
be sent res. received by all participants of a multicast group. In opposite to
broadcast here a reception is possible. For the identification of the
multicast participants within the net, you have to define one valid multicast
group address and one port for sender and receiver.

The maximum number of multicast circles, which are supported by the CP,
is identical to the maximum number of connections.
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Connection types

Open the
properties dialog

Save and compile
connections

The following connection types are available for communication:

» Siemens S7 connections, Send/Receive connections (TCP, 1SO-on-
TCP and ISO transport) for secured data transfer of data blocks
between two Ethernet stations

» UDP for not secured data transfer of data blocks between two stations.

Choose the connection partner and the type of connection and confirm with
[OK].

If activated, a properties dialog for the according connection opens as link
to your PLC user program.

At the following pages the relevant parameters of the different connection
types are shortly described. More information about this may be found in
the online help of Siemens NetPro.

Insert new connection

Connection partner

I__\l In Project
@ Connections

%SIMATIC%O
CPU ...

Project: Connections
Sation: SIMATIC 300
Module: CPU ...
Connection
Type: [ S7 connection V|
‘ OK ‘ ‘ Apply ‘ ‘ Cancel

After every connection was configured by this way, you may save and
compile your project and exit NetPro.

To store the CP project engineering data in the system data, you have to
activate the option "Store project data in the CPU" (default setting) at
object properties area Options in the hardware configuration of the CP.

HB140E - CPU - RE_315-4NE12 - Rev. 12/06
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Siemens S7
connection

Possibilities of
combination

For data transfer with Siemens S7 connections the FB/SFB VIPA handling
blocks are necessary; the deployment is described in the manual
"Operation list" of your CPU.

At Siemens S7 connections the communication connections are specified
by a connection ID for each communication partner.

A connection is specified by the local and partner connection end point. A
link. At Siemens S7 connections the TSAPs must be congruent crosswise.

The following parameters define a connection end point:

Station A Station B
remote TSAP = Siemens = local TSAP
local TSAP = S7 connection = remote TSAP
IDA IDB

The following table shows the combination options with Siemens S7
connections with deployment of the FB/SFB VIPA handling blocks.

The handling blocks are more described in the manual "Operation list" of
the CPU.

Connection partner Connection establishing Connection
_specified in NetPro active/passive specified
(in the current project)
T i
unspecified in NetPro active specified
(in the current project) passive unspecified
unspecified in NetPro active/passive specified (connection name in an

(in the unknown project)

other project)

Local connection
end point

Establish an active
connection

One-way

In the following every relevant parameter of a Siemens S7 connection is
described:

Here you may define how the connection is to be established. Since the
Siemens SIMATIC manager can identify the communication options by
means of the end points, some options are already preset and may not be
changed.

An established connection is precondition for data transfer. By activating
the option Establish an active connection the local station establishes the
connection.

Please regard not every station is able to establish a connection. Here the
job is to be made by the partner station.

If activated only one-way communication blocks like PUT and GET may be
used for communication in the user program. Here the partner station acts
as server, which neither may send active nor receive active

7-24

HB140E - CPU - RE_315-4NE12 - Rev. 12/06



Manual VIPA System 300S SPEED7 Chapter 7 Deployment Ethernet communication

Block parameters

Local ID

[Default]

Connection path

[Address details]

TSAP

Connection
resource

The ID is the link to your PLC program. The ID must be identical to the ID
of the call interface of the FB/SFB VIPA handling block.

As soon as you click at [Default], the ID is reset to system generated ID.

In this part of the dialog window the connection path between the local and
the partner station may be set. Depending on the linking of the modules the
possible interfaces for communication are listed in a selection field.

With this button a dialog window is opened, which shows address
information about the local and partner station. The parameters may also
be changed.

With Siemens S7 connections a TSAP is automatically generated of the
connection resource (one-way/two-way) and state of place (rack/slot
respectively system internal ID at PC stations).

The connection resource is part of the TSAP of the local station
respectively of the partner. Not every connection resource may be used for
every connection type. Depending on the connection partner and the
connection type the range of values is limited respectively the connection
resource is fix specified.
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User program at
Siemens S7
connections

Communication
functions

Configuring

For the execution of connection commands at the PLC, your CPU requires
an user application. For this, exclusively the VIPA handling blocks are to be
used, which you may get as library from VIPA.

Larger data sets may be transferred between PLC systems based on
Siemens STEP®7 by means of Siemens S7 connections. Here the stations
are to be linked by Ethernet.

The communication connections are static, this means they are to be
configured by a connection table.

With the SPEED7 CPUs of VIPA there are two possibilities for the
deployment of the communication functions:

* Siemens S7-300 communication functions

By integration of the function blocks FB 8 ... FB 55 from VIPA you may
access the Siemens S7-300 communication functions.

* Siemens S7-400 communication functions

For the Siemens S7-400 communication functions the SFB 8 ... SFB 15
are to be used, which were integrated to the operating system of the
CPU. Here copy the interface description of the SFBs from the standard
library at system function block to the directory container, generate an
instance data block for each call and call the SFB with the associated
instance data block.

Precondition for Siemens S7 communication is a configured connection
table in which the communication links are defined. For this e.g. WinPLC7
from VIPA or NetPro from Siemens can be used. A communication link is
specified by a connection ID for each communication partner. Use the local
ID to initialize the FB/SFB in the PLC from which the connection is
regarded and the partner ID to configure the FB/SFB in the partner PLC.
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Function blocks

The following function blocks may be used for Siemens S7 commu-

nications. More information about the deployment of the blocks may be
found in the manual "Operation list" of the CPU.

More about the usage of the handling blocks may be found in the manual
Operation list HBOO_OPL_SP7 in chapter "VIPA specific blocks".

FB/SFB

Label

Description

FB/SFB 8

USEND

Uncoordinated data transmission

FB/SFB 8 USEND may be used to transmit data to a remote partner
FB/SFB of the type URCV (FB/SFB 9). You must ensure that
parameter R_ID of both FB/SFBs is identical. The transmission is
started by a positive edge at control input REQ and proceeds without
coordination with the partner FB/SFB.

FB/SFB 9

URCV

Uncoordinated data reception

FB/SFB 9 URCV can be used to receive data asynchronously from a
remote partner FB/SFB of the type USEND (FB/SFB 8). You must
ensure that parameter R_ID of both FB/SFBs is identical.

The block is ready to receive then there is a logical 1 at the EN_R
input. An active job can be cancelled with EN_R=0.

FB/SFB 12

BSEND

Sending data in blocks

FB/SFB 12 BSEND sends data to a remote partner FB/SFB of the
type BRCV (FB/SFB 13). The data area to be transmitted is
segmented. Each segment is sent individually to the partner. The last
segment is acknowledged by the partner as it is received,
independently of the calling up of the corresponding FB/SFB/FB
BRCV. With this type of data transfer, more data can be transported
between the communications partners than is possible with all other
communication FBs/SFBs for configured S7 connections, namely
65534bytes.

FB/SFB 13

BRCV

Receiving data in blocks

The FB/SFB 13 BRCV can receive data from a remote partner
FB/SFB of the type BSEND (FB/SFB 12). The parameter R_ID of both
FB/SFBs must be identical.

After each received data segment an acknowledgement is sent to the
partner FB/SFB and the LEN parameter is updated.

FB/SFB 14

GET

Remote CPU read
The FB/SFB 14 GET can be used to read data from a remote CPU.
The respective CPU must be in RUN mode or in STOP mode.

FB/SFB 15

PUT

Remote CPU write
The FB/SFB 15 PUT can be used to write data to a remote CPU. The
respective CPU may be in RUN mode or in STOP mode.

FB 55

IP_CONFIG

Programmed Communication Connections
With this block you may flexible transfer data blocks with configuration
data to the CP within the user program.
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Send/Receive
connections

Possibilities of
combination

At the PLC side for data transfer with these connections the VIPA handling
blocks AG_SEND (FC 5) and AG_RECYV (FC 6) are to be used.

The following connections are Send/Receive connections:

 TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)
* |SO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)

* |ISO transport (SEND-RECEIVE, FETCH-WRITE PASSIVE)
+ UDP (SEND-RECEIVE)
Here the following parameters define a connection end point:

remote port
local port
IP address A

remote TSAP
local TSAP
IP address A

remote TSAP
local TSAP
MAC address A

remote port
local port
IP address A

TCP = local port
connection - remote port
IP address B
ISO-on-TCP s local TSAP
connection - remote TSAP
IP address B
ISO transport s local TSAP
connection - remote TSAP
MAC address B
UDP- = local port
connection - remote port
IP address B

The following table shows the combination options

operating modes:

with the different

Connection partner Connection type Conn. establ. Connection Operating mode
Specified in NetPro TCP / 1ISO-on-TCP / . .
(in recent project) ISO transport active/passive specified SEND/RECEIVE
UDP -
Unspecified in NetPro active specified SEND/RECEIVE
(in recent project) TCP /1SO-0on-TCP / part specified SEND/RECEIVE
ISO transport passive (PorTSAP) | FETCH PASSIV
unspecified WRITE PASSIV
UDP - specified SEND/RECEIVE
Unspecified in NetPro .
(in unknown project) active ified SEND/RECEIVE
TCP /1SO-on-TCP / (Csopnencéé‘t"ion
ISO transport : SEND/RECEIVE
: name in an other
passive project) FETCH PASSIV
WRITE PASSIV
UDP - SEND/RECEIVE
All Broadcast stations UDP i specified (Port, SEND
Broadcast addr.)
All Multicast stations UDP i specified (Port, - | geNp/RECEIVE

Multicast group)

In the following each relevant parameters of the different connection types

are described.
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General information

Name

Via CP
[Route]

Active connection
establishment

Block parameters

Addresses

Ports

TSAP

In this tab the general connection parameters are listed, which identify the
local connection end point.

This entry is identical to the entry of the connection table. The value may
always be changed. Please also regard to adjust the ID parameter of the
call interface of the FC.

Note!

If a CP is exchanged by another one, this must at least provide the same
services and must at least have the same version level. Only this can
guarantee the connections configured via the CP to remain consistent and
useable.

This field contains the name of the connection. The name is generated by
the system and may be changed on every time.

Here is the CP listed, which should be used for connection. With the button
[Route] the appropriate CP may be selected for communication.

Do not select the 1. CP of the route for communication connections. The 1.
CP is always the Ethernet-PG/OP channel, which does not support
configurable connections.

If activated the connection to the partner is active established by the local
station. Here the partner is to be specified in the tab "Addresses".
At an unspecified connection the connection is passive established.

Here the parameters ID and LADDR for your user program are shown.
Both are parameters, which are to be preset if you use the FC 5 and FC 6
(AG_SEND, AG_RECEIVE). Please always use the VIPA FCs, which you
may receive from VIPA.

The Addresses tab displays the relevant local and remote address
information as proposed values. Depending on the kind of communication
the address information may remain unspecified.

Ports res. port addresses are defining the access point to the user
application within the station/CPU. These must be unambiguous. A port
address should be within the range of 2000...65535. Remote and local
ports may only be identical with one connection.

ISO-on-TCP and ISO transport support TSAP lengths (Transport Service
Access Point) of 1..16 byte. You may enter the TSAP in ASCII or
hexadecimal format. The calculation of the length happens automatically.
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Options

Mode

Overview

Dependent on the specification of the connecting partner the operating
mode may be set respectively displayed.

SEND/RECEIVE

The SEND/RECEIVE interface allows the program-controlled com-
munication to any partner station via a configured connection. Here the
data transfer happens by a call from your user application. The FC5 and
FC6 that are part of the VIPA block library are serving as interface.

This enables your control to send messages depending on process events.

FETCH/WRITE PASSIVE

With the help of FETCH/WRITE services partner systems have the direct
access to memory areas of the CPU. These are "passive" communication
connections that have to be configured. The connections are "actively"
established by the connection partner (e.g. Siemens-S5).

FETCH PASSIVE (request data)
FETCH allows a partner system to request data.

WRITE PASSIVE (write data)
This allows a partner system to write data in the data area of the CPU.

Here every configured connections of this station and its partner are
displayed. These data are information and may not be changed.

Note!

By appropriate shift respectively delete activities in the Siemens SIMATIC
manager connections may lose the allocation to the CP.
These connections are marked with "!" at ID of the overview.
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User program at
Send/Receive
connections

Status displays

Deployment at
high communi-
cation load

The following connections are Send/Receive connections:

» TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)

* ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE)

* ISO Transport (SEND-RECEIVE, FETCH-WRITE PASSIVE)
+ UDP (SEND-RECEIVE)

For the communication between CPU and CP, the following FCs are
available:

AG_SEND (FC 5)

This block transfers the user data from the data area given in SEND to the
CP specified via ID and LADDR. As data area you may set a PA, bit
memory or data block area. When the data area has been transferred
without errors, "order ready without error” is returned.

AG_RECV (FC 6)

The block transfers the user data from the CP into a data area defined via
RECV. As data area you may set a PA, bit memory or data block area.
When the data area has been transferred without errors, "order ready
without error” is returned.

Note!

Please regard that you may only use the SEND/RECV-FCs from VIPA in
your user application for the communication with VIPA-CPs. At a change to
VIPA-CPs in an already existing project, the present AG_SEND/ AG_LSEND
res. AG_RECV/AG_LRECV may be replaced by AG_SEND res. AG_RECV
from VIPA without adjustment. Due to the fact that the CP automatically
adjusts itself to the length of the data to transfer, the L variant of SEND res.
RECV is not required for VIPA CPs.

The CP processes send and receive commands independently from the
CPU cycle and needs for this transfer time. The interface with the FC
blocks to the user application is here synchronized by means of
acknowledgements/receipts.

For status evaluation the communication blocks return parameters that
may be evaluated directly in the user application.

These status displays are updated at every block call.

Do not use cyclic calls of the communication blocks in OB 1. This causes a
permanent communication between CPU and CP. Program instead the
communication blocks within a time OB where the cycle time is higher res.
event controlled.
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FC call is faster
than CP transfer
time

AG_SEND,
AG_RECV in the
user application

If a block is called a second time in the user application before the data of
the last time is already completely send res. received, the FC block
interface reacts like this:

AG_SEND
No command is accepted until the data transfer has been acknowledged
from the partner via the connection. Until this you receive the message
"Order running" before the CP is able to receive a new command for this
connection.
AG_RECV

The order is acknowledged with the message "No data available yet" as
long as the CP has not received the receive data completely.

The following illustration shows a possible sequence for the FC blocks
together with the organizations and program blocks in the CPU cycle:

CPU cycle +
Pll read
|
OB User program
AG_RECV — |
Communication
AG_RECV < connection
AG_SEND |
AG_SEND —>
Communication
connection
AG_RECV 4+
1
l Communication
connection
AG_SEND
PIQ write

v

The FC blocks with concerning communication connection are summed up
by color. Here you may also see that your user application may consist of
any number of blocks. This allows you to send or receive data (with
AG_SEND res. AG_RECV) event or program driven at any wanted point
within the CPU cycle.

You may also call the blocks for one communication connection several
times within one cycle.
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AG_SEND (FC 5)

By means of AG_SEND the data to send are transferred to the CP.

Parameter
Parameter |Declaration |Type Description
ACT Input BOOL Activation of the sender
0: Updates DONE, ERROR and STATUS
1: The data area defined in SEND with the length LEN
is send
ID Input INT Connection number 1 ... 16 (identical with ID of NetPro)
LADDR Input WORD Logical basic address of the CP
(identical with LADDR of NetPro)
SEND Input ANY Data area
LEN Input INT Number of bytes from data area to transfer
DONE Output BOOL Status parameter for the order
0: Order running
1: Order ready without error
ERROR Output BOOL Error message
0: Order running (at DONE = 0)
0: Order ready without error (at DONE = 1)
1: Order ready with error
STATUS Output WORD Status message returned with DONE and ERROR. More

details are to be found in the following table.

AG_RECYV (FC 6)

By means of AG_RECYV the data received from the CP are transferred to

the CPU.
Parameter
Parameter |Declaration |Type Description
ID Input INT Connection number 1 ... 16 (identical with ID of NetPro)
LADDR Input WORD Logical basic address of the CP
(identical with LADDR of NetPro)
RECV Input ANY Data area for the received data
NDR Output BOOL Status parameter for the order
0: Order running
1: Order ready data received without error
ERROR Output BOOL Error message
0: Order running (at NDR = 0)
0: Order ready without error (at NDR = 1)
1: Order ready with error
STATUS Output WORD Status message returned with NDR and ERROR. More
details are to be found in the following table.
LEN Output INT Number of bytes that have been received
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DONE, ERROR, The following table shows all messages that can be returned by the CP
STATUS after a SEND res. RECV command.
A "-" means that this message is not available for the concerning SEND
res. RECV command.
DONE NDR | ERROR | STATUS | Description
(SEND) | (RECV)

1 - 0 0000h | Order ready without error

- 1 0 0000h | New data received without error

0 - 0 0000h | No order present

- 0 0 8180h | No data available yet

0 0 0 8181h | Order running

0 0 1 8183h | No CP project engineering for this order

0 - 1 8184h | System error

- 0 1 8184h | System error (destination data area failure)

0 - 1 8185h | Parameter LEN exceeds source area SEND

0 1 8185h | Destination buffer (RECV) too small

0 0 1 8186h | Parameter ID invalid (not within 1 ...16)

0 - 1 8302h | No receive resources at destination station, receive
station is not able to process received data fast enough
res. has no receive resources reserved.

0 - 1 8304h | The connection is not established.

The send command shouldn’t be send again before a
delay time of >100ms.

- 0 1 8304h | The connection is not established.

The receive command shouldn’t be send again after a
delay time of >100ms.

0 - 1 8311h | Destination station not available under the defined
Ethernet address.

0 - 1 8312h | Ethernet error in the CP

0 1 8F22h | Source area invalid, e.g. when area in DB not present
Parameter LEN <0

- 0 1 8F23h | Source area invalid, e.g. when area in DB not present
Parameter LEN <0

0 - 1 8F24h |Range error at reading a parameter.

- 0 1 8F25h | Range error at writing a parameter.

0 - 1 8F28h | Orientation error at reading a parameter.

- 0 1 8F29h | Orientation error at writing a parameter.

- 0 1 8F30h | Parameter is within write protected 1. recent data block

- 0 1 8F31h | Parameter is within write protected 2. recent data block

0 0 1 8F32h | Parameter contains oversized DB number.

0 0 1 8F33h | DB number error

0 0 1 8F3Ah | Area not loaded (DB)

continued...

7-34

HB140E - CPU - RE_315-4NE12 - Rev. 12/06




Manual VIPA System 300S SPEED7

Chapter 7 Deployment Ethernet communication

... continue
DONE NDR | ERROR | STATUS | Description
(SEND) | (RECV)

0 - 1 8F42h | Acknowledgement delay at reading a parameter from
peripheral area.

- 0 1 8F43h | Acknowledgement delay at writing a parameter from
peripheral area.

0 - 1 8F44h | Address of the parameter to read locked in access
track

- 0 1 8F45h | Address of the parameter to write locked in access
track

0 0 1 8F7Fh |Internal error e.g. invalid ANY reference e.g. parameter
LEN=0.

0 0 1 8090h | Module with this module start address not present or
CPU in STOP.

0 0 1 8091h | Module start address not within double word grid.

0 0 1 8092h | ANY reference contains type setting unequal BYTE.

- 0 1 80AOh | Negative acknowledgement at reading the module

0 0 1 80A4h |reserved

0 0 1 80B0Oh | Module doesn’t recognize record set.

0 0 1 80B1h | The length setting (in parameter LEN) is invalid.

0 0 1 80B2h |reserved

0 0 1 80COh |Record set not readable.

0 0 1 80C1h | The set record set is still in process.

0 0 1 80C2h | Order accumulation.

0 0 1 80C3h | The operating sources (memory) of the CPU are
temporarily occupied.

0 0 1 80C4h | Communication error (occurs temporarily; a repetition in
the user application is reasonable.)

0 0 1 80D2h | Module start address is wrong.

Status parameter at

reboot

Project transfer

At a reboot of the CP, the output parameters are reset as follows:

« DONE=0
« NDR=0

. ERROR = 8180h (at AG_RECV)
ERROR = 8181h (at AG_SEND)

Information about transferring a project may be found at chapter

"Deployment CPU

..." at "Project transfer".
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Configure Open Communication

Connection-
oriented
protocols

TCP native
according to
RFC 793

ISO on TCP
according to
RFC 1006

Connection-oriented protocols establish a (logical) connection to the
communication partner before data transmission is started. And if
necessary they terminate the connection after the data transfer was
finished.

Connection-oriented protocols are used for data transmission when
reliable, guaranteed delivery is of particular importance. In general, many
logical connections can exist on one physical line.

The following connection-oriented protocols are supported with FBs for
open communication via Industrial Ethernet:

» TCP/IP native according to RFC 793 (connection types 01h and 11h)
* 1SO on TCP according to RFC 1006 (connection type 12h)

During data transmission, no information about the length or about the start
and end of a message is transmitted. However, the receiver has no means
of detecting where one message ends in the data stream and the next one
begins. The transfer is stream-oriented.

For this reason, it is recommended that the data length of the FBs is
identical for the sending and receiving station. If the number of received
data does not fit to the preset length you either will get not the whole data,
or you will get data of the following job.

The receive block copies as many bytes into the receive area as you have
specified as length. After this, it will set NDR to TRUE and write
RCVD_LEN with the value of LEN. With each additional call, you will thus
receive another block of sent data.

During data transmission, information on the length and the end of the
message is also transmitted.

If you have specified the length of the data to be received greater than the
length of the data to be sent, the receive block will copy the received data
completely into the receive range. After this, it will set NDR to TRUE and
write RCVD_LEN with the length of the sent data.

If you have specified the length of the data to be received less than the
length of the sent data, the receive block will not copy any data into the
receive range but instead will supply the following error information:
ERROR =1, STATUS = 8088h.
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Connection-less  There is thus no establishment and termination of a connection with a

protocol remote partner. Connection-less protocols transmit data with no
acknowledge and with no reliable guaranteed delivery to the remote
partner.

The following connection-oriented protocol is supported with FBs for open
communication via Industrial Ethernet:

» UDP according to RFC 768 (with connection type 13h)

UDP according to In this case, when calling the sending block you have to specify the address

RFC 768 parameters of the receiver (IP address and port number). During data
transmission, information on the length and the end of the message is also
transmitted.

In order to be able to use the sending and receiving blocks first you have to
configure the local communications access point at both sides.

With each new call of the sending block, you re-reference the remote
partner by specifying its IP address and its port number.

If you have specified the length of the data to be received greater than the
length of the data to be sent, the receive block will copy the received data
completely into the receive range. After this, it will set NDR to TRUE and
write RCVD_LEN with the length of the sent data.

If you have specified the length of the data to be received less than the
length of the sent data, the receive block will not copy any data into the
receive range but instead will supply the following error information:
ERROR =1, STATUS = 8088h.
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Handling blocks

Those in

the following

listed UTDs and FBs serve for

"open

communication" with other Ethernet capable communication partners via
your user program.

These blocks are part of the Siemens SIMATIC Manager. You will find
these in the "Standard Library" at "Communication Blocks".

Please consider when using the blocks for open communication that the
partner station does not have to be configured with these blocks.

This can be configured with AG_SEND / AG_RECEIVE or IP_CONFIG.

UDTs
FB Label Connection-oriented protocols: Connectionless protocol:
TCP native as per RFC 793, UDP as per RFC 768
ISO on TCP as per RFC 1006
UDT 65 TCON_PAR |Data structure for assigning Data structure for assigning
connection parameters parameters for the local
communications access point
UDT 66 TCON_ADR Data structure for assigning
addressing parameters for the
remote partner
FBs
FB Label Connection-oriented protocols: Connectionless protocol:
TCP native as per RFC 793, UDP as per RFC 768
ISO on TCP as per RFC 1006
FB 63 TSEND Sending data
FB 64 TRCV Receiving data
FB 65 TCON Establishing a connection Configuring the local
communications access point
FB 66 TDISCON | Terminating a connection Closing the local communications
access point
FB 67 TUSEND Sending data
FB 68 TURCV Receiving data

7-38
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NCM diagnostic - Help for error diagnostic

Check list for
error search

This page shall help you with the error diagnostic. The following page lists
a number of typical problems and their probable causes:

Question Solution with "no"

CPU in Run? Control DC 24V voltage supply.
Set the operating mode switch to position RUN.
Check PLC program and transfer it again.

AG_SEND, AG_RECV |These 2 blocks are required in the user

in user application? application for the data transfer between CP and
CPU. Both blocks must also be called with a
passive connection.

Is CP able to connect? | Check Ethernet cable (at a point-to-point
connection a crossed Ethernet cable is to be

used).

Check IP address.
Can data be Check Port no. for read and write.
transferred? Check source and destination areas.

Check if the 2. CP is selected in the route.
Enlarge the receive res. send buffer defined via

the ANY pointer.
Is the complete data Check the LEN parameter at AG_SEND.
block sent at ISO-on- | get the receive res. send buffer defined via the
TCP? ANY pointer to the required size.

Siemens NCM
S7 diagnostic

The CP supports the Siemens NCM diagnostic tool. The NCM diagnostic
tool is part of the Siemens SIMATIC manager. This tool delivers
information about the operating state of the communication functions of the
online CPs dynamically.

The following diagnostic functions are available:
» Check operating state at Ethernet

* Read the diagnostic buffer of the CP

» Diagnostic of connections

The following pages contain a short description of the NCM diagnostic.
More details about the function range and for the deployment of the
Siemens NCM diagnostic tool is to be found in the according online help
res. the manual from Siemens.
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Start NCM
diagnostic

Structure

No diagnostic
without
connection

The diagnostic tool is started by Windows-START menu > SIMATIC ...
NCM S7 > Diagnostic.

The working surface of the diagnostic tool has the following structure:

The navigation area at the left side contains the hierarchical listed
diagnostic objects. Depending on CP type and configured connections
there is an adjusted object structure in the navigation area.

The information area at the right side always shows the result of the
navigation function you chose in the navigation area.

NCM-Diagnostics

=1l 2 langlar

Module
Industrial Ethernet
Time of day
Operating mode
Diagnostic buffer
Connections

C Navigation area ) C Information area )

A diagnostic always requires an online connection to the CP you want to

control. For this click at
appears:

NCM S7-Diagnostics: Online Path

at the symbol bar. The following dialog window

Gateway

Destination station

Attachment ... :
Ind. Ethernet TCP/IP

<

Node address:
Rack/Slot: (oW /[12s ¥

| Set PG/PC Interface |

Set the following parameters at destination station:
Connection...: Ind. Ethernet TCP/IP

Station addr.: Enter the IP address of the CP
Module rack/slot:

Enter the module rack and slot of the CP 343 that you've placed at the
2. slot.

Set your PG/PC interface to "TCP/IP -> Network card .... ". Via [OK] you
start the online diagnostic.
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Read diagnostic
buffer

Approach for
diagnostic

The CP has a diagnostic buffer. This has the architecture of a ring memory
and may store up to 100 diagnostic messages. The NCM diagnostic allows
you to monitor and evaluate the CP diagnostic messages via the diagnostic
object Diagnostic buffer.

Via a double click on a diagnostic message the NCM diagnostic shows
further information.

You execute a diagnostic by clicking on a diagnostic object in the
navigation area. More functions are available via the menu and the symbol
bar.

Note!

Please always control the preconditions for an operative communication
using the check at the beginning of this chapter.

For the aimed diagnostic deployment the following approach is convenient:

» Start diagnostic.

* Open the dialog for the online connection with , enter connection
parameters and establish the online connection with [OK].

 |dentify the CP and check the recent state of the CP via module status.
» Check the connections for particularities like:

- Connection status

- Receive status

- Send status

» Control and evaluate the diagnostic buffer of the CP via diagnostic
buffer.

* As needed, alter project engineering res. programming and restart
diagnostic.
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Coupling to other systems

Overview

ORG format

The operating mode FETCH/WRITE supported at TCP res. 1ISO-on-TCP
can be used for accesses of partner devices to the PLC system memory.
To be able to use this access also for example for implementation in PC
applications you have to know the telegram structure for orders. The
specific headers for request and acknowledgement telegrams have per
default a length of 16Byte and are described at the following pages.

The organization format is the abbreviated description of a data source or a
data destination in a PLC environment. The available ORG formats are
listed in the following table.

The ERW-identifier is used for the addressing of data blocks. In this case
the data block number is entered into this identifier. The start address and
quantity provide the address for the memory area and they are stored in
HIGH-/LOW- format (Motorola-formatted addresses)

Description Type Range
ORG identifier |BYTE 1..X
ERW identifier |BYTE 1...255
Start address HILOWORD |0...y
Length HILOWORD |[1...z

The following table contains a list of available ORG-formats. The "length"
must not be entered as -1 (FFFFh).

ORG identifier 01h-04h

CPU area DB MB EB AB
ORG identifier 01h 02h 03h 04h
Description Source/destination Source/destination Source/destination Source/destination

data from/into data
Block in main
memory.

data from/into flag
memory area

data from/into process
image of the inputs
(P1).

data from/into process
image of the outputs
(P1Q).

ERW identifier

DB, from where the

irrelevant

irrelevant

irrelevant

(DBNO) source data is
retrieved or to where
the destination data is
transferred.
Start address DBB-No., from where | MB-No., from where IB-No., from where the | QB-No., from where
significance the data is retrieved or | the data is retrieved or | data is retrieved or the data is retrieved or
where the data is where the data is where the data is where the data is
saved. saved. saved. saved.
Length Length of the Length of the Length of the Length of the
significance source/destination source/destination source/destination source/destination
data block in words data block in bytes data block in bytes data block in bytes
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Note!

Information about the valid range can be found at Chapter "Hardware
description of the CPU".

ORG identifier 05h-0Ah

CPU area PB ZB TB

ORG identifier 05h 06h 07h

Description source/destination data source/destination data Source/destination data
from/into peripheral from/into counter cells. from/into timer cells.

modules. Input module for
source data, output module
for destination data.

ERW identifier irrelevant irrelevant irrelevant

(DBNO)

Start address PB-No., from where the data | ZB-No., from where the data | TB-No., from where the data

Significance can be retrieved or where it | can be retrieved or where it | can be retrieved or where it
is saved. is saved. is saved.

Length Length of the Length of the Length of the

Significance source/destination data source/destination data source/destination data
block in bytes. block in words block in words

(counter cell = 1 word). (counter cell = 1 word).

Transfer of blocks
with numbers
>255

ORG identifier 81h-FFh

To transfer data blocks of the number range 256 ... 32768 you may use the
ORG identifier 81h-FFh.

For the setting of a DB No. >255 needs a length of one word, the DBNO, e,
is assembled from the content of the ORG identifier and the DBNO.

DBNO,.. is created as word as follows:

DBNOpew
High-Byte Low-Byte
1 X XXX XXX XXX X][X]X]X]X

ORG identifier (OXXXXXXX DBNO (XXXXXXXX

If the highest bit of the ORG identifier is set, the Low-Byte of DBNO,,, is
defined via DBNO and the High-Byte of DBNO,,, via ORG identifier, where
the highest bit of the ORG identifier is eliminated.

The following formula illustrates this:

DBNOyew =256 x (ORG-identifier AND 7Fh) + DBNO
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Structure of PLC-

Header

WRITE

FETCH

Messages of

For every FETCH and WRITE the CP generates PLC header for request
and acknowledgment messages. Normally the length of these headers is
16Bytes and have the following structure:

Request telegram Acknowledgement telegram CP
Remote Station
System ID ="S5" System ID ="S5"

(Word) (Word)
Length Header =10h (Byte) Length Header =10h (Byte)
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte)
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte)
OP-Code =03h (Byte) OP-Code =04h (Byte)
ORG block =03h (Byte) Ackn. block =0Fh (Byte)
Length ORG block =08h (Byte) Length Ack. block  =03h (Byte)
ORG identifier* (Byte) Error no. (Byte)
ERW identifier (Byte) Empty block =FFh (Byte)
S ordy Length empty block =07h (Byte)
Len(gvt\%r d) 5 empty bytes attached
Empty block =FFh (Byte)
Length empty block =02h (Byte)
Data up to 64kByte (only if error no.=0)
Request telegram Acknowledgement telegram CP
Remote Station
System ID ="85" System ID ="85"

(Word) (Word)
Length Header =10h (Byte) Length Header =10h (Byte)
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte)
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte)
OP-Code =05h (Byte) OP-Code =06h (Byte)
ORG block =03h (Byte) Ackn. block =0Fh (Byte)
Length ORG block =08h (Byte) Length Ackn. block =03h (Byte)
ORG identifier* (Byte) Error no. (Byte)
ERW identifier (Byte) Empty block =FFh (Byte)
Star(wggjr)e ss Length empty block =07h (Byte)
Len(gvt\;lor d) 5 empty bytes attached
Egr];?; t:cr:::ty block ;EZF: gzg Data up to 64kByte (only if error no.=0)

*) More details to the data area is to be found at "ORG-Format" above.

Note!

Please regard that in opposite to Siemens-S5 systems, the block
addressing of these CPUs takes the start address as byte number and the
length as number of words.

The following messages can be returned via error no.:

error no. Error no. | Message
00h No error occurred
01h The defined area cannot be read res. written
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Chapter 8 WinPLC7

Overview In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

Content Topic Page
Chapter 8  WINPLCT ..o 8-1

System presentation...........oo i 8-2

INSEAIALION ... 8-3

Example project engineering ............oooooiiiiiiiiiiiiii e 8-4
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System presentation

General

Alternatives

System
requirements

Source

Online

CD

WiInPLC7 is a programming and simulation software from VIPA for every
PLC programmable with Siemens STEP®7.

This tool allows you to create user applications in FBD, LAD and STL.
Besides of a comfortable programming environment, WinPLC7 has an

integrated simulator that enables the simulation of your user application at
the PC without additional hardware.

This “Soft-PLC” is handled like a real PLC and offers the same error
behavior and diagnosis options via diagnosis buffer, USTACK and
BSTACK.

Note!

Detailed information and programming samples may be found at the online
help respectively in the online documentation of WinPLC?7.

There is also the possibility to use the Siemens SIMATIC manager instead
of WinPLC7 from VIPA. Here the proceeding is part of this manual.

* Pentium with 233MHz and 64Mbyte work space
e Graphics card with at least 16bit color - we recommend a screen
resolution of at least 1024x768 pixel.

» Windows 98SE/ME, Windows 2000,
Windows XP (Home and Professional), Windows Vista

You may receive a demo version from VIPA. Without any activation with
the demo version the CPUs 11x of the System 100V from VIPA may be
configured.

To configure the SPEED7 CPUs a license for the "profi" version is
necessary. This may be online received and activated.

There are the following sources to get WinPLC7:

At www.vipa.de in the service area at Downloads a link to the current demo
version and the updates of WinPLC7 may be found.

Order no. Description

SW211C1DD |WinPLC7 Single license, CD, with documentation in german

SW211C1ED |WinPLC?7 Single license, CD, with documentation in english

SW900TOLA | ToolDemo
VIPA software library free of charge respectively demo
versions, which may be activated

8-2
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Installation

Preconditions

Installation
WinPLC7
Demo

Activation of the
"Profi" version

Installation of
WinPCAP for
station search via
Ethernet

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is
only possible using an activated "Profi" version of WinPLC7.

The installation and the registration of WinPLC7 has the following
approach:

For installation of WinPLC7 start the setup program of the
corresponding CD respectively execute the online received exe file.

Choose the according language.
Agree to the software license contract.

Set an installation directory and a group assignment and start the
installation.

Start WinPLC7. A "Demo" dialog is shown.
Click at [Activate Software]. The following dialog for activation is shown:

Serial number (34-digit). |
System number: 5YS-1888PLETVS

Activating key:

Get acivation key online (via intemet)

Install dhive=C:\PROGRAMME \MHJ-SOF TWARENWNSPS-S 745,

Fill in the following fields:
Email-Addr., Your Name und Serial number. The serial number may be
found on a label at the CD case.

If your computer is connected to Internet you may online request the
Activation Key by [Get activation key via Internet]. Otherwise click at
[This PC has no access to the internet] and follow the instructions.

With successful registration the activation key is listed in the dialog
window respectively is sent by email.

Enter the activation key and click to [OK]. Now, WinPLC?7 is activated as
"Profi" version.

To find a station via Ethernet (accessible nodes) you have to install the
WiInPCAP driver. This driver may be found on your PC in the installation
directory at WinSPS-S7-V5/WinPcap_... .exe.

Execute this file and follow the instructions.
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Example project engineering

Job definition In the example a FC 1 is programmed, which is cyclically called by the
OB 1. By setting of 2 comparison values (valuel and value2) during the FC
call, an output of the PLC-System should be activated depending on the
comparison result.

Here it should if valuel = value2 activate output Q 124.0
apply: if valuel > value2 activate output Q 124.1
if valuel < value2 activate output Q 124.2

Precondition * You have administrator rights for your PC.
* WinPLC7 is installed and activated as "Profi" version.
* One CPU and one digital output module are installed and cabled.

» The Ethernet PG/OP channel of the CPU is connected to your Ethernet
network. Your CPU may be connected to your PC with an Ethernet
cable either directly or via hub/switch.

» WinPCap for station search via Ethernet is installed.

» The power supply of the CPU and the I/O periphery are activated and
the CPU is in STOP state.

Project o Start WinPLC7 ("Profi" version)

engineering e Create and open a new project with [Create a new solution].

Hardware » For the call of the hardware configurator it is necessary to set WinPLC7
configuration from the Simulator-Mode to the Offline-Mode. For this and the communi-

cation via Ethernet set "Target: TCP/IP Direct".
File Edit Block PLC  Wiew Extras Help

SAHEANAS & HADAEE L 5L

: [ - pml;‘;-ZZﬂ?ZOl1-164430-ENG.W51 (Snllj.?l é

EEEEEE

151

mlu]=] |

RIS -

* Enter a station name. Please consider that the name does not contain
any spaces.

» After the load animation choose in the register Select PLC-System the
system "VIPA SPEED7" and click to [Create]. A new station is created.

» Save the empty station.

» By double click or drag&drop the according VIPA CPU in the hardware
catalog at CPU SPEED?7 the CPU is inserted to your configuration.

» For output place a digital output module and assign the start address 124.
» Save the hardware configuration.
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Online access via
Ethernet PG/OP
channel

Transfer hardware
configuration

Open the CPU-Properties, by double clicking to the CPU at slot 2 in the
hardware configurator.

Click to the button [Ethernet CP-Properties (PG/OP-channel)]. The
Properties CP343 is opened.

Chose the register Common Options.
Click to [Properties Ethernet].
Choose the subnet "PG_OP_Ethernet".

Enter a valid IP address-and a subnet mask. You may get this from your
system administrator.

Close every dialog window with [OK].
Select, if not already done, "Target: External TCP/IP direct".

Open with Online > Send configuration to the CPU a dialog with the
same name.

Click to [Accessible nodes]. Please regard to use this function it is
necessary to install WinPCap before!

Choose your network card and click to [Determining accessible nodes].
After a waiting time every accessible station is listed. Here your CPU
with IP 0.0.0.0 is listed, too. To check this the according MAC address is
also listed. This MAC address may be found at a label beneath the front
flap of the CPU.

For the temporary setting of an IP address select you CPU and click to
[Temporary setting of the IP parameters]. Please enter the same IP
parameters, you configured in the CPU properties and click to [Write
Parameters].

Confirm the message concerning the overall reset of the CPU. The IP
parameters are transferred to the CPU and the list of accessible stations
is refreshed.

Select you CPU and click to [Confirm]. Now you are back in the dialog
"Send configuration".

Choose your network card and click to [Send configuration]. After a
short time a message is displayed concerning the transfer of the
configuration is finished.

Note!

Usually the online transfer of the hardware configuration happens within
the hardware configurator.

With File > Save active station in the WIinPL7 sub project there is also the
possibility to store the hardware configuration as a system file in WinPLC7
to transfer it from WinPLC7 to the CPU.

The hardware configuration is finished, now and the CPU may always be
accessed by the IP parameters as well by means of WinPLC?7.
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Programming of The PLC programming happens by WinPLC7. Close the hardware
the FC 1 configurator and return to your project in WinPLC7.

The PLC program is to be created in the FC 1.

Creating block FC 1« In "Project content" choose New > FC.

Ei < Extras Help
SHAEANRMS § BAAEEE 6w & FART
o B I

£ prcgect £ Prommt conbent
G221

¥t Babona +00 1 sndactnd ocks ko the P
o ce

» Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is

called.
Creating In the upper part of the editor there is the parameter table. In this example
parameters the 2 integer values valuel und value2 are to be compared together. Since

both values are read only by the function, these are to be defined as "in".

* Select the "in -->" row at the parameter table and enter at the field
Name "value1". Press the [Return] key. The cursor jumps to the column
with the data type.

» The data type may either directly be entered or be selected from a list of
available data types by pressing the [Return] key. Set the data type to
INT and press the [Return] key. Now the cursor jumps to the Comment
column.

» Here enter "1. compare value" and press the [Return] key. A new "in -->"
row is created and the cursor jumps to Name.

* Proceed for value2 in the same way as described for valuel.

» Save the block. A note that the interface of the block was changed may
be acknowledged with [Yes].

The parameter table shows the following entries, now:
-+~ |

= i @ @ 3% ‘B = 8 Load FCl into the PLC ¥ Synchronize 69" Monitoring On/off M etwark 1
bll == ¢ Addiess | Declaration Mame Tupe Initial value Comment
0.0 _ waluel INT 1. compare value
20 walue? INT 2. compare value
out <=

30-ENGFRI 5 B

in_out &=
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Enter the program

As requested in the job definition, the corresponding output is activated
depending on the comparison of valuel and value2. For each comparison
operation a separate network is to be created.

The program is to be created as FBD (function block diagram). Here
change to the FBD view by clicking at FBD.

LAD By |[Fetwork 1 ¥ Network ticle=

Network comment=

<empty

Click to the input field designated as "<empty>".

The available operations may be added to your project by drag&drop
from the hardware catalog or by double click at them in the hardware
catalog.

Open in the catalog the category "Comparator" and add the operation
"CMP==I" to your network.

File Edit Black PLC Wiew Extras Help
Sanfdaand S EA-FEEE s = &eno 0 FMRER T Towet S
o SR
2 it logic £
% 5 E?% am, I A 5B g4 T oL =[] 2 {8] @ = 58 LoadFctintathe PLC T Synchronize &
-E >] CMP ==l il == = pddress Declaration MName Type Initial va
g >] P ol b 0.0 R valel INT
5 7] EMP o 20 value2 INT
& g 3] oMP £ — =
% Bl CHP >4 & In_out &=
5 >] oM<l & — =
— g
e e
‘% ] CHP 2D & Block coument=
[ >] CMP<D i
s 3] CMP2=D g
I3 >] CMP <=D 8
= »] CMP ==R & STL LAD 8y |Network 1 ¥ MHerwork titles
& >] CMP o | - e
= >] CMP 3R . o e e
>| CMP <R R
1 CMP <R | B R e e e
>] CMP <=R Ciiarayrwry — R llioiiiiiiiiiiiiiiiiiiiiiiin
B | & L] Conveter o [
8 -[+1] Counter 3::3??(INTJ_' o sy e oy i s e i
- [08] DB-Cal ;
w2l domns o

Click to the input left above and insert valuel. Since these are block
parameters a selection list of block parameters may be viewed by
entering "#".

Type in "#" and press the [Return] key.

Choose the corresponding parameter and confirm it with the [Return]
key.

Proceed in the same way with the parameter value2.
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Adding a new
network

The allocation to the corresponding output, here Q 124.0, takes place with
the following proceeding:

» Click to the output at the right side of the operator.

» Open in the catalog the category "Bit logic" and select the function
"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7].

* Insert the output Q 124.0 by clicking to the operand.

Network1 is finished, now.

For further comparisons the operations "CMP>I" at Q 124.1 and "CMP<|"
at Q 124.2 are necessary. Create a network for both operations with the
following proceeding:

* Move your mouse at an arbitrary position on the editor window and
press the right mouse key.

» Select at the context menu "Insert new network". A dialog field is
opened to enter the position and number of the networks. Or click at
[Add a network at the end of the block].

* Proceed as described for "Network 1".

» Save the FC 1 with File > Save content of focused window respectively
press [Strg]+[S].

8-8
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FC1 After you have programmed the still missing networks, the FC 1 has the
following structure:

m=  s7n [FED] i B By B 0

Network comment=

CHFP

$raluel — "L

0lz4._0
Frale? e ot p— e

m= 7L [FBD]  LaD By B

Network comment=

CHFP

fraluel —— =T

Qlz4.1

Frralie? e e

m= 7L [FED]  LaD By B0

Network comment=

CHFP

fralual — =I

Qlz4 2
Fralue?l e . =
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Creating the block  The FC 1 is to be called from the cycle OB 1.
OB 1 + Go to OB 1, which was automatically created with starting the project.

» Go to "Project content" or to "Solution" and open the OB 1 by a double
click.

» Change to the STL view.

» Type in "Call FC 1" and press the [Return] key. The FC parameters are
automatically displayed and the following parameters are assigned:

"Cyoclic main program"

EBlock comment=

== [STL] FED L&D 3y |Network 1 X ome

Network comments=

o CALL FC 1-
1 valuel:=10

Z valuez:=10

3

» Save the OB 1 with H or [Strg]+[S].

Test the PLC With WinPLC7 there is the possibility to test your project in a simulator.
program in the « Here select "Target: Simulator".
Simulator Fie Edt Bock PLC view Extras Help

LahBHdane & E-8EEFE -k
 Edit project: i . '-E__Pm]e:t content

c [PROG-22072011-164430-ENG.WST (Solut 5
S |57-PROG-22072011-164430-ENG

Lo open ¥ hew... Refresh [l Load selected blocks into the PLC all blacks inta the PLC

AanAastEy alendue]

:;‘ -l Blocks o

=it OB = oG
Gl TR e I o are |
B o1 = O st STLFBD-LAD  nb 2 108 - nb
e | o FE % Ot fFot STLFED-LAD  mh 16 106 - b
N | ® e o 0@ svMBOLTABLE 5EQ Symbolic table

» Transfer the blocks to the simulator with [Load all blocks into the PLC].

1B E D X e G s F M [E] T Tawet Simulaior v

- EEPruiect conkent

3 Open ¥ Hew... Refresh [l Load selected blocks intothe PLC £T¥ Synchranize CTRLHY ¥ Load all blacks inta the PLC  Reset filter

O ost ] - -l b 1725132445056 20117-25 | 13.24.45(56)
[ 1.0 STLFBDLAD mh 16 108 < onb N\ nb 2011722|17:49:29(32) 2011722 |18:16:55(32)
&  SYMBOLTABLE.SEQ 5 ymbolic: table -

[0 H#  VARISBLETABELLEVAR StatusVariable

» Switch the CPU to RUN, by clicking at RUN in the "CPU Control Center"
of "Edit project". The displayed state changes from STOP to RUN.

» To view the process image select View > Display process image
window or click at '=!=l. The various areas are displayed.

» Double click to the process image and enter at "Line 2" the address
PQB 124. Confirm with [OK]. A value marked by red color corresponds
to a logical "1".

* Openthe OB 1.

» Change the value of one variable, save the OB 1 and transfer it to the
simulator. According to your settings the process image changes
immediately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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Visualization via
PLC mask

Transfer PLC
program to CPU
and its execution

A further component of the simulator is the PLC mask. Here a CPU is
graphically displayed, which may be expanded by digital and analog
peripheral modules.

As soon as the CPU of the simulator is switched to RUN state, inputs may
be activated by mouse and outputs may be displayed.

Open the PLC mask with view > PLC mask. A CPU is graphically
displayed.

Double-click to the output module, open its properties dialog and enter
the Module address 124.

Switch the operating mode switch to RUN by means of the mouse. Your
program is executed and displayed in the simulator, now.

AL e PP

LR Ty
ERBAAARS S FoH-AHEE N S E T T e e .=
[ U T—
1 081 it . O Schvenin. R Wskinng CoCIT
Tor LT

[T -
_— I AT TABE
~ Irkusral ueftvrars PLC. i
= i m &
F 1w '
4 a0 ir
b 1 pos
nc i
HE 3 -
g 2 -
. '

For transfer to the CPU set the transfer mode to "Target: TCP/IP-
Direct".

If there are more network adapters in your PC, the network adapter may
be selected via Extras > Select network adapter.

For presetting the Ethernet data click to [...] and click to
[Accessible nodes].

memary
- nb nb 2011-7-25 | 13:24:45(5E) 2011-7-25 |12
STLFEDLAD  mh 16 106 - nb nb 20011-7-22 | 17:49:29(32) 2011-7-22 | 1%

430-ENGPR) £ T

(@  SMBOLTABLESEQ Symblic table

Click at [Determining accessible nodes]. After a waiting time every
accessible station is listed.

Choose your CPU, which was provided with TCP/IP address parameters
during the hardware configuration and click to [Confirm].

Close the "Ethernet properties" dialog with [OK].

Transfer your project to your CPU with PLC > Send all blocks.
Switch your CPU to RUN state.

Open the OB 1 by double click.

Change the value of one variable, save the OB 1 and transfer it to the
CPU. According to your settings the process image changes imme-
diately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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